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1  INTRODUCTION TO 
HOLTER LX PRO

Welcome to NorthEast Monitoring’s Holter LX Pro Software. Used in conjunction with a North-
East Monitoring Digital Holter Recorder (either the DR180+ or the SD360), LX Pro allows you to 
fully review all of the ECG recorded during the Holter test, including all normal, ventricular, 
supraventricular, and paced beats. You can quickly review and edit morphology types, significant 
arrhythmic events, strips saved for the printed report, data trends, and tables. You can also review 
and edit all report information before it’s printed, then print whatever pages are required to docu-
ment each patient’s Holter test. In addition, LX Pro automatically reads patient data from the 
recorder - including entries made using the Event button - and saves sample strips of event mark-
ers and diary entries. Backup features, remote reporting, and spectral analysis are also included. 
Optional oximetry and 12-lead data from the DR180+ can also be analyzed, edited, and presented.
Guide to Holter
CAUTION: Federal law restricts this device to sale by or on the 
order of a physician.

Note: This product, like all Holter monitoring products, should be used 
only under the direct supervision of a licensed physician.

NorthEast Monitoring is an FDA Registered Facility (1224919) that 
follows all FDA CGMP Manufacturing Practices. The DR180+ 
Digital Recorder with oximetry and the Holter LX oximetry soft-
ware has FDA 510K Approved Product Certification (K004007). 
The Holter LX software has FDA 510K Approved Product Certifi-
cation (K930564). 
 LX Pro     1
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Package contents
Your Holter LX Pro package includes:

• NorthEast Monitoring Holter LX 
software CD

• NorthEast Monitoring Holter LX 
Pro software Operator’s Manual

• NorthEast Monitoring Software 
Protection Key

• NorthEast Monitoring Registration 
Number

• Installation instructions

System requirements
This software can only be used in con-
junction with a NorthEast Monitoring 
digital recorder - either the DR180+ or 
the SD360. It is not compatible with 
the Holter monitor of any other manu-
facturer. To run the Holter LX Pro soft-
ware, your personal computer must 
include:

• Microsoft Windows XP

• a processor with a speed of 1 GHz 
or faster

• at least 256 MB of memory; 512 
MB is recommended

• a disk drive of at least 10 GB

• a monitor with a resolution of at 
least 1024 by 768

• a USB compact flashcard/SD card 
reader or a laptop PC card slot

• a laser printer is recommended

Operator knowledge
To use NorthEast Monitoring Holter 
LX Pro Software, you must have 
extensive Holter knowledge that 
allows you to properly identify sinus 
and paced rhythms, abnormal rhythms, 
supraventricular and ventricular 
arrhythmias, artifact, ST segment 
changes, and pacemaker failures. In 
addition, all instructions assume a 
working knowledge of computers and, 
specifically, Windows XP software.

Installation instructions
To run, Holter LX Pro software must 
be installed on your hard disk. We rec-
ommend that no other Windows pro-
grams be running when you install the 
Holter LX Pro software. To install the 
Holter LX Pro software:

1. Insert the NorthEast Holter LX 
Software CD into your computer’s 
CD drive. A window opens on your 
monitor acknowledging the CD and 
displaying icons indicating what is 
present on the CD. They include one 
for Adobe Acrobat Reader (its label 
starts “Adbe”), one for Java 2 
Runtime Environment (its label 
starts “j2re”), one for the Rainbow 
key that is specific to your system 
(its label starts “rainbow”), and one 
for NorthEast Holter LX (its label 
starts “nem”). In addition, there are 
document files containing a copy of 
this and other NorthEast product 
operator’s manuals, and a “readme” 
                                                                                           Guide to Holter LX Pro
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Installation instructions
text file. (We recommend that you 
print and read the readme file as 
soon as installation is complete.)

2. Double click on the Adobe Acrobat 
Reader icon and follow the instal-
lation instructions as they appear on 
the screen, pressing the Enter key 
whenever prompted to go to the 
Next window. When completed, the 
CD window re-appears.

3. If your NorthEast software key 
(a.k.a. dongle) is already plugged 
into one of the ports on your 
computer, remove it. A software key 
for a parallel port is putty-colored, 
and one for a USB port is purple. 

With the software key removed, 
double click on the Rainbow icon 
and follow the installation instruc-
tions as they appear on the screen, 
pressing the Enter key whenever 
prompted to go to the Next window. 
When completed, the CD window 
re-appears. Plug the software key 
into the appropriate port.

Note: If you are asked to reboot after 
Rainbow installation, please reboot and 
then continue with step 4.

4. Double click on the Java icon and 

follow the installation instructions as 
they appear on the screen, pressing 
the Enter key whenever prompted to 
go to the Next window. When 
completed, the CD window re-
appears.

Note: If you are asked to reboot after 
Java installation, please reboot and 
continue with step 5.

5. Double click on the NorthEast icon 
and follow the installations instruc-
tions as they appear on the screen. 

Each time you are prompted to go to 
the Next instruction window, press 
the Enter key to do so.When you are 
prompted to select Finish, press the 
Enter key to do so. After a short 

Acrobat Reader icon

Rainbow icon

Java icon

NorthEast Monitoring icon
o Holter LX Pro                         3
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delay, the Setup window opens.

6. Type appropriate information in 
each of the fields, including your 
name and the name of your facility. 
In the five fields for the Report 
Heading, type the five lines you 
want to appear at the top of the front 
page of each Holter report. Leave 
the Number of patients set to 30. 
Click on the radio button next to 
“Digital recorder with a software 
key,” then carefully type your regis-
tration number in the Registration 
field. When the information is 
complete, click OK to close the 

Setup window.

7. Close the CD window. The Holter 
LX Pro software launches and is 
ready to be used. To exit the LX Pro 
software, select Patient > Exit or 
click the red Close button in the 
upper right corner.

Launching LX Pro
Once the programs are installed, you 
start the Holter LX Pro software by 
selecting Programs > Holter 5 > Holter 
5 from the Start menu. 

If you use the LX Pro software often 
enough, Windows XP may add Holter 
5 to the Start menu, and you can then 
start the Holter LX Pro software by 
selecting Start > Holter 5.

Online help
In addition to the information in this 
manual and the on-screen help mes-
sages that appear within the LX Pro 
software, help is also available online 
at our web site at www.nemon.com.

Setup window
                                                                                           Guide to Holter LX Pro
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Inserting a compact flashcard
Inserting a compact 
flashcard
All ECG recorded during the Holter 
period is saved on a removable mem-
ory card. The DR180+ recorder uses a 
compact flashcard, while the SD360 
recorder uses an SD memory card. To 
input the data from the card to the com-
puter system, first remove the card 
from the recorder, and then insert it 
into your computer system’s card 
reader.

Into a USB SD memory card 
reader
To insert an SD memory card into the 
drive, hold the card right-side up, with 
the missing corner away from you and 
to the right. Insert the opposite edge 
into the opening of the SD card reader. 
Push the card in gently until it is fully 
plugged in. Some card readers have a 
light indicating when a flashcard is 
properly inserted; if yours does, make 
sure the light comes on.

Depending on your computer and your 
card reader, a window may appear 
acknowledging that a card has been 
newly inserted and listing what files 
are present on the card. A recording 
saved by an SD360 Digital Recorder is 
named “flash.dat.” If the window 
appears, close it.

Into a USB compact flashcard 
reader
To insert the compact flashcard into the 
flashcard drive, hold onto the card by 
the edge with the ridge and insert the 
opposite edge into the opening of the 
flashcard reader. Push the card in gen-
tly until it is fully plugged in. Some 
card readers have a light indicating 
when a flashcard is properly inserted; if 
yours does, make sure the light comes 
on.

Depending on your computer and your 
card reader, a window may appear 
acknowledging that a card has been 
newly inserted and listing what files 
are present on the card. A recording 
saved by a DR180+ Digital Recorder is 
named “flash.dat.” If the window 
appears, close it.

Into a laptop PC card slot
First insert the compact flashcard into a 
compact flashcard adaptor; to do so, 
hold onto the card by the edge with the 
ridge and insert the opposite edge into 
the adapter. Then insert the adaptor, 
right side up into the laptop’s card slot. 
If a window appears listing what files 
are on the flashcard, close it.
o Holter LX Pro                         5
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Setup S
Formatting an SD 
memory card 
To use an SD memory card with North-
East Monitoring’s SD360 recorder, it 
must be initialized using the LX Holter 
software. To do so, insert the SD card 
into the card reader, close the Windows 
Explorer window that opens, and using 
the Holter software, select Patient > 
Flashcard > Initialize. The Setup 
SD360 window opens. It displays 
every drive that holds a memory card 
and a list of configurations (SD360 set-
tings).

Note: If your system allows both SD360 
and DR180+ recorders, and the Initialize 
DR180+ window opens, click the 
Initialize SD360 button to switch to the 
Setup SD360 window.
Select the appropriate configu-
ration corresponding to the 
patient to be hooked up (in the 
SD360 settings field at the 
right), then click Patient setup. 
The Patient setup window 
allows you to enter clerical 
information about the patient 
to be saved on the SD card 
before the Holter test begins. 

See Chapter 2: Patient Information for 
details about data entry in this window.

Once the window contains the correct 
patient information, click the Copy to 
SD360 button. The card will be initial-
ized and the patient data will be copied 
onto it.

For details about the settings available 
using the SD360 settings button, please 
refer to your SD360 Holter Recorder 
Operator’s Manual.

Formatting a compact 
flashcard
To use a compact flashcard with 
NorthEast Monitoring’s DR180+ 
recorder, it must be formatted prop-
erly before recording patient data. 
Flashcards that come with the 
DR180+ Digital Holter Recorder are 
already formatted properly and need 
only to be erased/initialized before re-

use. A flashcard from a different 
source, though, must first be formatted 
using the FAT file system (not FAT 32) 
and then erased/initialized using 
NorthEast’s software.

D360 window
                                                                                           Guide to Holter LX Pro
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Erasing/Initializing a compact flashcard
To format a compact flashcard, insert 
the card into your computer’s card 
reader, then select My Computer. In 
the My Computer window, click on the 
icon designating your compact flash-
card reader, then select File > Format. 
When the window opens, set the File 
system to FAT, then click Start. Click 
Close when formatting is complete.

Erasing/Initializing a 
compact flashcard
To erase and initialize a compact flash-
card for re-use in the DR180+, insert 
the flashcard in your computer’s flash-
card reader and launch the Holter LX 
Pro software. Then select Patient > 
Flashcard > Initialize. 

Note: If your system allows both SD360 
and DR180+ recorders, and the Setup 
SD360 window opens, click the Initialize 
DR180+ button to switch to the Initialize 
DR180+ window instead.
In the Initialize DR180+ window, 
highlight the Standard selection and 
then click the Erase button. When the 
erase is completed, the flashcard will 
contain a blank flash.dat file that will 
allow it to be used in the DR180+.

Note: If you insert a flashcard into the 
recorder and get a message that the 
“Memory card is missing,” the flashcard 
is not formatted or erased properly.

NorthEast Monitoring Holter LX Pro 
software is used in conjunction with 
data from the NorthEast Monitoring 
DR180+ and/or SD360 Digital 
Recorders. After a patient has worn the 
recorder, you take the compact flash-
card or SD card from it and insert the 
card in your computer system’s com-
pact card reader and the Holter signal 
is loaded onto your system. While the 
signal is being transferred, the LX Pro 
software processes it, then you review 
the results, edit as needed, and print the 
report.

An overview of the process is covered 
in this chapter, and details are covered 
in subsequent chapters.

The Holter procedure
The Holter procedure typically 
includes the following steps:

• Holter the patient using a DR180+ 
or an SD360 Digital Recorder.

• Remove the recorder from the 
patient and remove the compact 
flashcard or the SD card from the 
recorder.

• Insert the card into the computer’s 
card reader.

• Start the Holter LX Pro software.

• Enter/review information about the 
patient and the recording.
o Holter LX Pro                         7
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• Let the software analyze the Holter 
data.

• Review the templates in the Bin 
display to ensure that each type of 
beat is identified properly. Edit bins, 
templates, or beats as necessary. 
Make measurements as necessary.

• Review what Critical Events were 
found throughout the recording. 
Save strips to document additional 
significant events for the final 
report.

• Review the Saved Strips, making 
sure that all significant events are 
documented and labeled properly.

• Type your comments about the 
Holter test in the Report Summary.

• Print the final report to be reviewed 
by a physician.

Detailed information about the steps 
outlined above appears in subsequent 
chapters in this manual. 
                                                                                           Guide to Holter LX Pro



2  PATIENT 
INFORMATION

The Patient Information window contains important information about the patient who wore the 
DR180+ or SD360 recorder. The software automatically retrieves patient data from the recorder’s 
memory card, along with the Holter signal, but you are responsible for entering the remaining 
data. The data saved by the DR180+ recorder includes an identification number, the recorder 
number, the date, the start time, and whenever the patient pressed the Event button. The SD360 
saves all that information plus whatever clerical information was entered when the SD card was 
initialized for the recording. All entries in the Patient Information can be edited.
Guide to Holter

Holter toolbars
While running the LX Pro Holter software, you have the choice of 
opening the Patient Information window for (1) the last patient 
whose Holter test was accessed (that is, the “current” patient), (2) a 
previous patient whose Holter test has already been analyzed, or (3) 
a new patient whose Holter test has not yet been analyzed. In the 
first two cases, a patient record has already been created for the 
patient and the Holter data for the patient has already been down-
loaded from the memory card of the recorder onto the hard disk of 
your computer. In the case of a new patient, a new record must be 
created and the Holter information downloaded from the memory 
card. This chapter covers creating a new patient record first.

Entering information for a new patient
To enter information about a new patient’s Holter recording, the LX 
software must be 
running. When the 
program appears, it 
displays a blank 
screen with the stan-
dard toolbars. To 
start a new patient, first insert the patient’s compact flashcard/SD 
card into the card reader and then select Patient > New.

Note: If you select Patient > New before inserting the card, you 
will see a Confirm window that explains that there is no flashcard 
in the drive. If this happens, insert the correct card into the drive 
and click Retry.

Standard 
 LX Pro                9
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New P

New P
After you select 
Patient > New, a 
New Patient 
window opens, 
with a Type of 
analysis/report 
field. Select 
Standard from 
the list and click 
OK. 

Note: For more 
information 
about types of 
analysis/report, 
see Chapter 10: 
Configurations.

Note: If you see a message that says, 
“There are no empty patient...” 
instead of the New Patient window, 
see “Making room for new patients” 
in Chapter 9: Managing Patient 
Reports.

When the Patient Information window 
opens for a new patient, the data on the 
flashcard is immediately read from the 

card reader. As the Holter data from the 
card loads onto your computer hard 
drive, you can start entering or editing 
patient information.

Note: Once the flash.dat has loaded, 
the “Copy flashcard” button in the 
Patient Information window changes 
to “Copy different flashcard.” If the 
patient information displayed does not 
match the correct patient, remove the 
card, insert the correct one and click 
“Copy different flashcard.”

1. Type the patient name using the Last 
name, First name, and Middle initial 
(MI) fields appropriately. Use your 
pointing device (mouse) to click on 
the next field you want to fill in, or 
press the Tab key to move to the 
next field. The name in the printed 
report appears as entered in this 
window.

2. Fill in any of the remaining data 
fields. There are six 
types of data fields:

• Freeform: These allow 
you to type alphanu-
meric characters, limited 
by the space constraints 
displayed, e.g., patient 
name.

• Radio buttons: The Sex 
entry appears as this 
type. Circles represent 
the two choices. Click 
on a 

circle to select it. 
Only one choice 
can be selected. Example of radio button

atient Information window

atient window
                                                                                             Guide to Holter LX Pro
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Entering information for a new patient
• Formatted: The entry must be in a 
specific format. For example, the 
D.O.B. (date of birth) field must be 
entered as one of the valid formats; 
which one depends on the settings of 
your system. If the D.O.B. field 
reads MM/DD/YYYY, the entry 
must be typed with the first two 
digits representing the month, the 
second two digits representing the 
day, and the final four digits repre-
senting the year. If the D.O.B. field 
reads DD-MON-YYYY, the entry 
must be typed with two digits repre-
senting the day, three letters repre-
senting the abbreviation for the 
month, and four digits representing 
the year. (To change the D.O.B. 
format, see Chapter 8: Preferences.)

• Automatic: These are filled in 
automatically from the flashcard. 

• Check box: The fields with an 
empty square can be clicked on to 
display a check mark. Click again to 
remove the mark.

• Combination: In these, you can 
either type a freeform entry or make 
a selection from a predetermined list 
of choices. To display the list of 
choices, click on the scroll arrow to 
the right of the field. In the 
Indication and Medication fields, the 
scroll arrow does not appear until 
you click on the field itself. To 
select a choice from the list, click on 
it.
Some combination boxes have an 
auto-fill feature. When you start 

typing an entry, the software will 
automatically finish typing for you 
from its list of choices; if the word 
taken from its list is incorrect, sim-
ply keep typing until the correct one 
appears. If the correct one is not on 
the list, type the complete entry. 
These fields have the auto-fill fea-
ture: Indication, Medication, Physi-
cian, Interpreting physician, and 
Strip label.

Note: The D.O.B. and Age fields 
work together. If you know the 
patient’s date of birth, enter it, and the 
software automatically calculates the 
patient’s age based on the D.O.B. and 
the recording date. If you do not know 
the date of birth, but know the age, 
type a numeric entry in the Age field, 
and select the appropriate unit (e.g., 
years) in the Age Unit field. If you 
know neither, leave the fields blank. 
The software does not allow an incon-
sistent D.O.B. and age; if you enter 
inconsistent data, it will leave the age 
and remove the D.O.B.

Note: The Notes field allows an 
alphanumeric entry that can be used 
to record information that might be 
helpful about the Holter test or the 
patient. It is not printed in the final 
report. To enter notes to be printed in 
the final report, use the Comments 
section of the Report summary.
o Holter LX Pro  11
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Dairy 
Entering diary 
information
While wearing the DR 180+ or SD360, 
the patient can identify symptoms and 
activities in two ways:

(1) by pressing the Event button on the 
recorder and, possibly, entering a pre-
coded symptom or activity (DR180+ 
only), or 

(2) by keeping a written record of times 
and symptoms or activities. 

The software reads the Event button 
information directly from the flash-
card/SD card and enters it automati-
cally. You must type any significant 
information from the written record 
manually into the Diary Symptoms 
window.

To open the Diary Symptoms window, 
click the Diary button in the Patient 
Information window. The Diary Symp-
toms window contains two types of 
fields: time-of-day and symptom. Any 
entries that are already present when 
you first open a patient’s Diary Symp-
toms window were those automatically 
read from the flashcard/SD card.

Enter the time-of-day and symptom for 
each diary event recorded.

Note: Whether the software uses a 
12- or 24-hour clock is determined by 
your computer’s setting in the Control 
Panel.

Time-of-day
To enter the time-of-day of a written 
symptom or activity, click on the text 
in the time field. Type over the existing 
characters, using the format indicated, 
with either a 12- or 24-hour clock:

• HH stands for a two-digit hour.
• MM stands for a two-digit minute.
• 00 stands for a two-digit second; this 

is automatically filled in with 00 so 
that you do not have to type the 
seconds.

• using a 12-hour clock format, am 
stands for the morning and pm 
stands for the afternoon; change the 
“a” to “p” if necessary.

• 1, 2 or 3 at the end indicates Day 1, 
Day 2, or Day 3.

Symptom
To enter a symptom, first click on the 
Symptom field next to the appropriate 
time-of-day. Then enter the text either 
by typing a freeform entry or by click-
ing on the arrow to display a scrolling 
list of pre-typed entries. To enter a 
selection from the list, click on it; the 
list window closes and the entry 
appears in the Symptom field. You can 
                                                                                             Guide to Holter LX Pro
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Changing Settings

ow
also add freeform information after 
selecting a pre-typed entry. To do so, 
make your selection, then click at the 
end of the text and type the additional 
information, followed by the Enter key.

To delete a diary entry, click to high-
light the time-of-day of the entry and 
then click the Delete button. The time-
of-day will revert to HH:MM:00-1 or 
HH:MM:00am1and no entry will be 
saved. To select multiple entries to be 
deleted, select one and then hold the 
Shift key down while you select subse-
quent entries; when all entries that you 
want deleted are highlighted, click 
Delete.

When you have finished entering all 
written diary events, click the Done 
button to save your entries and return 
to the Patient Information window.

Changing Settings
During Holter analysis, the LX Pro 
software makes decisions about the 
Holter signal based on a variety of pre-
defined settings. You can change any 
of the analysis criteria in the Settings 
windows, which are accessible from 
the menu displayed by clicking the Set-
tings button in the Patient Information 
window or by clicking the Settings 
menu item in the main toolbar.

Adjustments that can be made in the 
Settings windows are detailed in 

“Changing Settings” section of Chapter 
3: Holter Analysis.

Starting Holter analysis
To start Holter analysis after entering 
patient data, click the Start button at the 
bottom of the Patient Information win-
dow. The Analysis window appears. 
When analysis is complete, the Analy-
sis window closes automatically. 

To interrupt analysis, click the Stop 
button. The analysis ends immediately, 
with data only for the portion that was 
complete. The unanalyzed ECG can be 
reviewed in Page and printed in full 
disclosure.

Details of the Holter analysis process 
are presented in Chapter 3: Holter 
Analysis.

Analysis wind
o Holter LX Pro  13
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Patient

w

Editing patient 
information for the 
“current” patient 
Once analysis is completed for a 
patient’s Holter data, you can re-open 
the Patient Information window and 
edit the information in it. To open the 
Patient Information window for the 
current patient, select Patient > Patient 
Information. 

While most of the Patient Information 
window is the same as that of a new 
patient, there are significant differ-
ences: 

• The addition of the Status button 
(see the “Status window” section 
below for details).

• The Re-analyze button replaces the 
Start button because the Holter sig-
nal has already been analyzed. (See 
Chapter 3: Holter Analysis for infor-

mation about using the Re-analyze 
button.)

• The absence of the Copy different 
flashcard button. To copy the Holter 
data from a flashcard, you must use 
Patient > New.

Status window
After a patient’s Holter signal has been 
analyzed, the Patient Information win-

dow also includes a Status but-
ton that opens the Status 
window. The Status window 
helps you keep track of the sta-
tus of each patient’s Holter test. 
As you complete each step, you 
can click on the check box next 
to each field in the Status win-

dow to indi-
cate that the 
step has been 
completed. 
The Status 
fields include:

• Edited indicates that the Holter 
signal was reviewed and edited as 
needed;

• Printed means the report was 
printed;

• Verified means the report was 
reviewed and approved by a 
qualified physician;

 Information window for analyzed (not new) patient

Status windo
                                                                                             Guide to Holter LX Pro
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Navigating the patient list
• Locked removes all editing capabil-
ities from the Patient Information 
and Review windows. No changes 
are allowed.

In addition, one other Status field 
appears - Backup. That field is filled in 
automatically when you use the 
Backup program to save a patient’s 
Holter information; it contains either 
“Full” to indicate that all Holter data is 
backed up with the patient report or 
“Report” to indicate that just the com-
piled report is backed up for this 
patient.

Navigating the patient 
list
You can keep multiple patient Holter 
recordings and reports on your com-
puter system. All of the patients cur-
rently saved in the software appear 
when you 
select Patient 
> Open from 
the toolbar. 
An example of 
the Open 
Patient win-
dow appears 
at right.

The list of 
patients in the 
Open Patient 
window 
includes infor-
mation regard-

ing each report. Although the particular 
fields are customizable in the Backup 
program, the fields included in the 
standard release of the LX Pro software 
are: the name of the directory in which 
the patient’s report is stored, the patient 
name, the I.D. number, the Scan #, and 
the analysis date. The Backup field dis-
plays the date that the report was 
backed up on your system; Type indi-
cates what is backed up - either the 
report, including strips (indicated by 
“Report”), or the full report (indicated 
by “Full”), consisting of the report plus 
the entire Holter recording.

At any one time, only one patient is the 
current patient - the patient whose 
information appears when you select 
Patient > Patient Information, the 
patient whose ECG appears in the 
screen displays, the patient whose 
report prints when you make the 
request. To change the current patient 
o Holter LX Pro  15
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to a different one, either click on the 
appropriate name on the list and click 
Open, or double-click on the appropri-
ate line.

Also, you can change the current 
patient using the << and >> buttons in 
the bottom of the Holter LX window. 
<< changes the current patient to the 
previous one on the patient list. >> 
changes the current patient to the next 
one on the patient list. Click each but-
ton repeatedly to move backward or 
forward through the list. To display a 
combo box listing all patients on the 
system, click the arrow to the left of the 
<< and >> buttons.

For more information about managing 
and backing up the patient records 
saved on the system, see Chapter 9: 
Managing Patient Reports.

Previewing the data on 
the compact flashcard/
SD card
If you would like to review the clerical 
information on a flashcard/SD card 
before creating a new patient record, 
you can insert the card into the drive 
and then select Patient > Preview from 
the main toolbar. This opens the Pre-
view window, which displays the iden-
tification and recorder numbers, along 
with the date recorded and the start 
time, directly off the card without load-
ing the information onto your com-
puter’s hard disk. Use this feature to 

verify which flashcard contains a par-
ticular patient’s Holter data. 

After verifying that the card is the cor-
rect one, click OK to close the window. 
If the information in the Preview win-
dow does not match the information 
you have, do not proceed without 
clearing up the discrepancy. 

After verifying that the card is from the 
correct patient, select Patient > New 
and follow the normal procedure 
described at the beginning of this chap-
ter.

Closing the Patient 
Information window
To save your data and close the Patient 
Information window without starting 
analysis, click OK. To close it without 
saving any changes, click Cancel.

Preview window
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3 HOLTER ANALYSIS
During analysis, the Holter LX Pro software detects each R-wave; determines the patient’s nor-
mal morphology; establishes normal, ventricular and paced templates; matches every beat to a 
template; counts normal, supraventricular, ventricular and paced beats, including any pairs and 
runs; measures RR intervals and calculates heart rates; does ST segment analysis; counts other 
abnormalities as defined in the Scanning Criteria; and saves sample strips for the final report. 
You can review and edit decisions made by the software; the information is then either re-ana-
lyzed or updated to include your changes. This chapter addresses the features that you have con-
trol over during analysis, re-analysis and updating.
Guide to Holter

indow
Starting Holter analysis

To start Holter analysis for a new patient, you must have the correct 
patient’s compact flashcard/SD card in the card reader before 
selecting Patient > New. After you have entered the patient infor-
mation (see Chapter 2: 
Patient Information for 
details about data entry), 
click the green Start but-
ton at the bottom of the 
Patient Information win-
dow to start Holter analy-
sis. The Analysis window 
appears. When analysis is 
complete, the Analysis 
window closes automati-
cally. 

To interrupt analysis, click the Stop button. The analysis ends 
immediately, with data only for the portion that was analyzed by the 
time of the interruption. The unanalyzed ECG can be reviewed in 
Page and printed in full disclosure.

Arrhythmia analysis
Certain analysis and related documentation criteria are already set 
when you click the Start button in the Patient Information window. 
They include all the settings that appear in the five windows that are 
accessible using the Settings button in either the Patient Informa-

Analysis w
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 menu
tion window or on the main Holter 
toolbar. Those windows are What 
Strips to Auto Save, How Often Strips 
Auto Save, Scanning Criteria, Spectral 
Analysis, and Oximetry.

What Strips to Auto Save
All the different types of labels the 
software uses appear in this window. 
The software uses these labels to iden-
tify one particular beat or event (for 
example, the “current” beat or the beat 
centered in a Saved Strip). Each label 
can be turned off or on to indicate 
whether sample strips of that type 
should be saved for the final report. A 
check mark indicates that sample strips 
with that label will be saved. 

Click on a label or its check box to turn 
it off or on. Click on the button Select/
Deselect All to turn all labels on or off. 
Click OK to save changes and close the 
window, and click Cancel to close the 
window without saving 
changes.

The labels in the What 
Strips to Auto Save win-
dow are defined as:

• VPB - a beat that 
matches a ventricular 
template, regardless of 
prematurity

• VPB pair - two VPBs 
in a row

• VTAC - three or more 
VPBs in a row, regard-
less of heart rate

• Early VPB - a VPB that is at least 
as early as the VPB prematurity set-
ting in the Scanning Criteria win-
dow

• R on T - a VPB that occurs early 
enough to perhaps fall on the T-
wave of the preceding beat; for 
details, see the algorithm explana-
tion in Appendix A

• Bigeminy - an alternating pattern of 
single VPBs and normal beats, with 
at least three VPBs in the series; that 
is - V, N, V, N, V, N

• Trigeminy - a pattern of single 
VPBs every third beat, with normals 
in between, with at least three VPBs 
in the series; that is - V, N, N, V, N, 
N, V, N

• Quadrigeminy - a pattern of single 
VPBs every fourth beat, with nor-
mals in between, with at least three 
VPBs in the series; that is - V, N, N, 
N, V, N, N, N, V, N

What Strips to Auto Save window in Settings
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• Longest VTAC - the longest run of 
three or more VPBs, regardless of 
rate

• Fastest VTAC - the run of three or 
more VPBs with the fastest heart 
rate

• Failure to capture - the presence of 
a pacemaker spike without a follow-
ing R-wave

• Failure to sense - the occurrence of 
a paced beat too soon following 
another beat; that is, too short an RR 
interval

• Inhibition - the absence of a paced 
beat when it should occur; that is, 
too long an RR interval

Note: Please refer to the section 
“Pacemaker analysis” in this chapter 
for more information about the 
pacemaker labels listed above.

• SVPB - a beat that matches a nor-
mal template, but occurs at least as 
early as the SVPB prematurity set-
ting in the Scanning Criteria win-
dow

• SVPB pair - two SVPBs in a row
• SVT - three or more SVPBs in a 

row, regardless of heart rate
• Longest SVT - the longest run of 

three or more SVPBs, regardless of 
rate

• Fastest SVT - the run of three or 
more SVPBs with the fastest heart 
rate

• Depression - at least a 1 millimeter 
depression in the ST segment com-
pared to the patient’s normal

• Elevation - at least a 1 millimeter 
elevation in the ST segment com-
pared to the patient’s normal

Note: The Depression and Elevation 
settings here are NOT strip labels. 
Instead, they determine whether strips 
of the following types are saved for 
each episode of ST Depression or 
Elevation detected by the software.

• Baseline - a sample of the patient’s 
normal ST segment preceding a 
detected event

• Onset - near the beginning of a 
detected event, at the time the 
change is 0.5 mm.

• Maximum HR - the ECG when the 
maximum heart rate occurred during 
the event

• Maximum deviation - the ECG at 
the point of maximum change from 
the normal

• End - the ECG after the patient has 
re-established normal

Note: Please refer to the section “ST 
Segment Analysis” in this chapter for 
more information about the ST labels 
listed above.
o Holter LX Pro                             19



Holter Analysis

20

 menu
• Pause - an RR interval at least as 
long as the Pause length in the Scan-
ning Criteria window

• Tachycardia - a heart rate at least as 
fast as the Tachycardia setting in the 
Scanning Criteria window

• Bradycardia - a heart rate at or 
below the Bradycardia setting in the 
Scanning Criteria window

• Irregular RR - a pattern of RR 
intervals (between normal beats) 
that falls outside the variation 
that is considered normal, but 
without RR intervals early 
enough to be called SVPBs

• Minimum HR - the minimum 
heart rate calculated using the 
heart rate algorithm described in 
Appendix A, generally a four-
beat running average

• Maximum HR - the maximum 
heart rate calculated using the 
heart rate algorithm described in 
Appendix A, generally a four-beat 
running average

• Shortest RR - the shortest RR inter-
val measured during the Holter 
period, excluding those before or 
after artifact

• Longest RR - the longest RR inter-
val measured during the Holter 
period, excluding those before or 
after artifact

• Diary or event - a strip at the time-
of-day when either (1) the event but-
ton was pushed or (2) an entry was 
manually typed into the Diary 
Symptoms window

• Save 1 strip/hour - a strip at the 
onset of each new hour

• Calibration strip - the calibration 
signal at the onset of the Holter 
recording

How Often Strips Auto Save
These settings control the distribution 
of strips that are saved for the report. 
They have the following uses:

• Maximum number of arrhythmia 
strips: Saved Strips fall into two 
types - arrhythmia and ST. You can 
limit how many arrhythmia strips 
are saved for the final report by 
adjusting this field.

• Maximum number of ST events 
documented: Each ST event, 
regardless of whether it is depres-
sion or elevation, can have five 
strips saved to document it. To 
reduce the number of events for 
which strips are saved, enter a 
smaller number in this field. To 
change how many strips are saved 
per ST event, make the change in 
the What Strips to Auto Save win-
dow.

How Often Strips Auto Save window in Settings
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Guide t

Arrhythmia analysis
• Maximum number of strips per 
interval: Interval length within the 
Holter period is defined in the Scan-
ning Criteria window, but here you 
can control the upper limit of how 
many arrhythmia strips are saved 
within each interval.

• Maximum strips per interval of 
the same name:  You can limit the 
number of arrhythmia strips of the 
same label that are saved within an 
interval.

• Maximum strips of the same 
name:  You can limit the number of 
arrhythmia strips of the same label 
that are saved during the entire 
Holter period.

• Minimum time (minutes) between 
strips of the same name: You can 
re-distribute the arrhythmia strips 
saved by requiring more or less time 
between those with the same label.

• Maximum number of alternative 
strips: Eight strip labels are associ-
ated with alternative strips in the 
Saved Strips window - Minimum 
HR, Maximum HR, Shortest RR, 
Longest RR, Longest VTAC, Fast-
est VTAC, Longest SVT and Fastest 
SVT. Here you can control how 
many alternative selections you 
have for those labels. 

To make changes, select the current 
entry and type over it. Click on OK to 
save changes and exit; click Cancel to 
close without saving.

Scanning Criteria
The Scanning Criteria are used during 
Holter analysis to define some of the 
arrhythmias labeled by the software, 
along with settings that control the 
amount of information processed. The 
Scanning Criteria window is shown on 
the following page. The adjustable cri-
teria include:

• Tachycardia defines at least how 
fast a heart rate must be for the 
Tachycardia label to appear. All 
beats that occur at that heart rate or 
above are included in the tachycar-
dia beat count in the Tachy/Brady 
table in the Tables window.

• Bradycardia defines how low the 
heart rate must be for the Bradycar-
dia label to appear. All beats that 
occur at that heart rate or below are 
included in the bradycardia beat 
count in the Tachy/Brady table in 
the Tables window.

• SVT defines the heart rate that sepa-
rates fast and slow runs of SVPBs 
that appear in the Supraventricular 
Runs table of the Tables window 
and in the Report Summary. In all 
other areas of the software, slow and 
fast supraventricular runs are com-
bined in the SVT counts.

• VTAC defines the heart rate that 
separates fast and slow runs of 
VPBs that appear in the Ventricular 
Runs table of the Tables window 
and in the Report Summary. In all 
other areas of the software, slow and 
fast ventricular runs are combined in 
the VTAC counts.
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• Pause length (sec.) defines how 
long an RR interval must be for the 
beat at its onset to be called a Pause 
and appear white on the colored dis-
play. This RR interval can be initi-
ated by any type of beat except 
artifact.

• Disable SVPB counts is a setting 
that allows you to turn off the identi-
fication and counting of SVPBs. Use 
it when the patient exhibits atrial 
fibrillation or any other time the 
SVPB count is not appropriate.

• Signal quality has three settings that 
control the amount of artifact that is 
tolerated before the signal is thrown 
out because of too much artifact: 

1. Research turns off the artifact detec-
tor so that none of the signal except 
the first minute and the last minute 
of the recording is called artifact. 
This results in the analysis of all the 
signal, including any artifact.

2. Excellent allows the software to 
detect and reject a moderate amount 
of artifact. Any signal that is deter-
mined to be contaminated with arti-
fact appears light blue and is not 
analyzed. Anything that occurs dur-
ing periods of artifact is not counted.

3. Normal allows the software to dis-
card any signal that it considers con-
taminated by artifact. Anything that 
occurs during periods of artifact is 
not counted.

• Number of channels processed 
determines whether the software 
uses one or two channels to deter-
mine the location of an R-wave and 
what template each matches. Single-
channel analysis uses just the chan-
nel set in the Primary channel field. 
Dual-channel analysis uses the Pri-
mary channel to locate R-waves 
first, then refers to the Alternate 
channel as a back-up channel to 

Scanning Criteria window in Settings menu
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locate R-waves, and both primary 
and alternate to do template-match-
ing.

• Primary channel determines which 
channel is used during analysis. For 
single-channel analysis, the primary 
one is the only one used to locate R-
waves and do template-matching. 
For dual-channel analysis, the pri-
mary channel is used first to locate 
R-waves, but if an R-wave cannot 
be located, the software refers to the 
alternate channel to locate the beat, 
if one is present.

• Alternate channel is used only in 
two-channel processing. It deter-
mines which channel is used in case 
an R-wave is not found in the pri-
mary channel, and it controls which 
channel is used as a second channel 
for template-matching.

• Automatic channel selection 
allows the software to switch pri-
mary and alternate channels if it 
determines that signal has been lost 
in the primary channel. Turn this off 
to force the software to use a partic-
ular primary or alternate channel. If 
you change the Number of channels 
processed field to 1, this setting is 
turned off automatically.

• Automatic ST Marker selection 
allows the software to detect the j-
point and set up the ST markers 
appropriately. If you manually 
change the ST marker locations in 
the Calibration window, this setting 
will turn off automatically.

• Process ST events lets you turn ST 
segment analysis on or off, depend-
ing on your preference.

• Narrow QRS permits the software 
to identify narrower-than-normal 
QRS complexes, like those seen in 
pediatric patients, as normal beats. 
Turn this on routinely for pediatric 
patients.

• Artifact filter works in conjunction 
with the Signal quality setting. If it 
is turned on and Signal quality is set 
to Normal, the filter limits the 
response to 20 Hz, instead of 70. If 
it is on and the Signal quality is set 
to Excellent or Research, the filter 
limits the response to 30 Hz instead 
of 70.

• Interval size (min.) determines how 
many minutes are including in each 
interval in the interval tables of the 
Tables window. 

• Analysis duration determines how 
many hours of data are analyzed. All 
the ECG loads in from the compact 
flashcard during analysis, but analy-
sis stops after the amount of time 
indicated here. It uses the HH:MM 
format, with the first two digits indi-
cating how many hours and the sec-
ond two indicating how many 
minutes.

• Extra dead-time controls the tail 
end of the dead-time period follow-
ing an R-wave during which another 
QRS complex cannot be detected, 
allowing for the presence of a T-
wave. Increase the time (in seconds) 
if large T-waves are being identified 
as R-waves, and decrease the time if 
early beats are being missed. See 
details in Appendix A.

• SVPB prematurity (percent) sets 
the requirement for how early a beat 
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that matches a normal (or aberrant) 
template must be for it to be identi-
fied as an SVPB. For example, at a 
heart rate of 60 beats per minute, a 
normal RR interval is 1 second long, 
and a beat that is 10 percent prema-
ture would fall at 0.9 seconds after 
the preceding beat. A properly 
timed beat would be 0 percent pre-
mature, that is, not early.

• VPB prematurity (percent) sets the 
requirement for how early a beat 
that matches a ventricular template 
must be for it to be identified as an 
early VPB. All matches to ventricu-
lar templates are identified as VPBs, 
but those that are especially early 
can be counted separately as early 
VPBs.

• Pacemaker type contains four set-
tings that allow the software to 
expect certain behavior:

1. Not paced means that the software 
will not identify any pacemaker 
spikes, beats or failures.

2. VVI means that each paced beat will 
be preceded by a single spike. All 
paced beats are counted as ventricu-
lar paced.

3. AV sequential means that paced 
beats will be preceded by two pace-
maker spikes, one atrial and one 
ventricular. All paced beats are 
counted as AV paced.

4. DDD means that paced beats can be 
preceded by either one or two pace-
maker spikes. Depending on the 
spike’s location relative to the fol-
lowing R-wave, a beat preceded by 
a single spike can be called either 
atrial paced or ventricular paced, 

while a beat preceded by two spikes 
can be counted as AV paced. 

• Minimum heart rate refers to the 
minimum rate allowed by the pace-
maker. If the pacemaker does not 
fire appropriately and there is an RR 
interval longer than the patient 
should experience, the Inhibition 
label appears.

• Maximum heart rate refers to the 
maximum rate initiated by the pace-
maker. If the pacemaker fires early, 
which would result in a faster rate, 
the Sense failure label appears.

• Maximum vent. spike to R inter-
val sets the maximum time between 
the firing of the second pacemaker 
spike and the following R-wave. If 
the second spike appears and is not 
followed by an R-wave in this 
amount of time, the Capture failure 
label appears.

• Maximum atrial spike to R inter-
val sets the limit for how long is 
allowed between a single spike and 
the subsequent R-wave. If a single 
spike occurs and the following R-
wave is not within this amount of 
time, the Capture failure label 
appears.

• Paced beat and the beat after can 
be called a SVPB is a setting that 
allows you to identify early beats 
following a paced beat as SVPBs 
because they are premature. 

Note: Please refer to the section 
“Pacemaker analysis” in this chapter 
for more information about the 
pacemaker settings listed above.
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Re-analysis
If you have already analyzed the 
patient’s Holter test, changes that you 
make to some of the settings may force 
the software to re-analyze the patient’s 
data, while others require an update to 
take effect. 

Because changes in some of the set-
tings have such a fundamental effect on 
the data, the analysis step is repeated 
using the new settings. That step is 
called re-analysis. Re-analysis is 
required after changing any of the set-
tings in the Processing criteria and 
Pacemaker criteria areas of the Scan-
ning Criteria window, along with 
changes to either of the two Processing 
modes, the Analysis duration, and the 
Extra dead-time. After making a 
change to any of these settings and 
clicking on OK to close the window, 
the software asks you to confirm that 
you want the data re-analyzed or not. If 
you want the change to take effect, 
click Yes. If not, click No.

Although re-analysis itself takes a brief 
amount of time (the same as analysis), 
the patient will be newly analyzed 
again and all editing changes you 
have made previously will be gone.

Note: Because re-analysis is required 
after a change in some Settings, be 
sure to make any changes to the 
Settings before you work on the final 
report. Any bin, template or beat 
editing, along with manually saved 
sample strips and typed comments will 
be lost after some changes in the 
Settings.

Update
Some changes in the Settings require 
an update afterward, just as beat, tem-
plate and bin editing require an update 
afterward. The update incorporates 
simple changes into all other aspects of 
the report. For example, a change in 
label of a template with 12 matches 
from ventricular to aberrant will affect 
other aspects of the report: the total 
count of VPBs will decrease by 12 and 
SVPBs will increase by 12 in Tables, 
Critical Events, Trends, and Report 
Summary. In addition, different Saved 
Strips will be selected.

Those changes in Settings that require 
an update are all those in the What 
Strips to Auto Save and How Often 
Strips Auto Save windows, along with 
these settings in the Scanning Criteria 
window - Tachycardia, Bradycardia, 
SVT and VTAC rates; Pause length; 
Disable SVPB counts; Interval size; 
and SVPB and VPB prematurity set-
tings.

Update w

firm window asking whether to re-analyze
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Note: Because update is required 
after a change in some Settings, be 
sure to make any changes to the 
Settings before you edit Saved Strips, 
Tables and Report Summary for the 
final report. Bin, template or beat 
editing done before the update will 
not be lost.
If an Update button does not appear in 
the Review toolbar, it means the Auto-
matically Update feature is turned on in 
the Preferences window. When you 
make a Settings change that requires an 
update, the update will occur automati-
cally when you close the window.

If an Update button appears in your 
Review toolbar, the Automatically 
Update feature is turned off in the Pref-
erences window. That means that after 
some editing changes, you must click 
the Update button to incorporate your 
changes. After you make changes that 
require an update, the Update button 
will blink red as a reminder that you 
must at some point click it.

Note: Whether the Update button 
appears in the Review toolbar depends 
on the “Automatically update tables” 
setting in the Preferences window. If 
the software is set to automatically 
update, the button does not appear; if 
you must update the data after 
making changes, the button appears.

Oximetry analysis
If you have oximetry hook-up equip-
ment for your DR180+ recorder, oxim-
etry analysis is done automatically 
when you start Holter analysis, using 
the patient’s data from the compact 
flashcard. The oximetry option is not 
available using the SD360 recorder.

The oximetry data appears in the chan-
nel 3 area of all ECG displays. This 
includes a color-coded (based on the 
beat label, so usually green) trend of 
the SpO2 data, with a vertical scale of 
60 to 100 percent saturation; artifact in 
that trend is indicated by vertical hash 
marks. Pulse oximetry data is dis-
played as the white trend above the 
SpO2 trend.

In addition, the ST trend in the Trends 
window shows the oximetry data in 
two areas - the heart rate data collected 
appears superimposed on the heart rate 
trend and the oximetry readings are 
plotted instead of the channel 3 ST 
data. Desaturation events are high-
lighted in red along the oximetry trend.

Desaturation events are defined by the 
settings in the Oximetry window in the 
Settings menu. 
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The adjustments you can make include:

• Desaturation threshold (percent) 
defines the oxygen level (SpO2 
value) that every reading during a 
desaturation event must be below. 
The duration of an event is defined 
as a time period during which no 
reading was above this level.

• Max. desaturation nadir defines 
the SpO2 level that must be met for 
an event to be identified as a desatu-
ration event. During the event, at 
least one reading must drop to this 
level.

• Min. overall desaturation length 
(in seconds) determines how long 
the readings must remain at or 
below the Desaturation threshold to 
be considered a desaturation event.

• Max. length of artifact in a desat-
uration (in seconds) defines the 
maximum amount of sequential arti-
fact that can occur during a desatu-
ration event and still have it reported 
as an event.

• Min. separation of artifact seg-
ments in desaturation (in seconds) 
defines how close periods of artifact 
can be within a desaturation event 
and still have it reported as an event.

ST segment analysis

ST segment analysis includes these 
steps (which are each explained in 
depth in the following pages):

1. Setting ST markers. This is done 
automatically by the software, but 

you can adjust the markers for any 
patient.

2. Measuring the ST segment on all 
three channels of every normal beat. 
This is done automatically. If you 
relabel normal beats to some other 
label, the ST segment analysis will 
be re-done automatically.

3. Plotting ST data in 30-second 
increments. All normal beats within 
each 30-second time period are 
averaged.

4. Establishing ST baseline for the 
patient throughout the Holter period. 
The software does this automati-
cally and plots it in blue on the ST 
trends in the Trends window.

5. Comparing the 30-second ST seg-
ment data measured with the base-
line at the same time. A difference 
of at least 1 millimeter in any chan-
nel is considered to be an event. 
Again, the software does this auto-
matically.

6. Identifying ST events. ST events 
are listed in the ST event table in the 
Tables window. This is automati-
cally compiled for you, but you can 
edit any of the fields within the 
table.

7. Documenting ST events. You 
determine which strips are saved to 
document each event, based on the 
settings in the What Strips to Auto 
Save window. How many ST events 
are documented in determined in the 
How Often to Auto Save window. 
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Note: The procedure does not include 
calibrating the signal because the 
data is recorded at 1 centimeter per 
millivolt, the standard for ST segment 
analysis.

Setting ST markers
To review the locations of the ST 
markers used during analysis:

1.  Select Review > Calibration. The 
Calibration window opens display-
ing the calibration pulse, a series of 
eight 1-millivolt square waves.

2. Click the radio button to the left of 
“ST Marker” to change the display 
to ECG and three colored, vertical 
markers, which include:

• the left-hand marker (cobalt blue) 
indicates where iso-electric is in the 

baseline preceding 
the QRS complex;

• the middle marker 
(yellow) is located 
at or just following 
the j-point (where 
the QRS ends and 
the ST segment 
begins); and

• the right-hand marker (light blue) is 
located during the ST segment.

Note: If the ECG displayed is not 
clean and representative of the 
patient’s normal, click the down 
arrow of the scroll bar to jump 
forward to different ECG.

3. If the markers are not located where 
you want them, drag them to move 
them to the appropriate locations. 
The ST segment measurement can 

be made at the location of either the 
j-point or the ST segment marker, 
while the other of the two is used to 
indicate the slope of the ST seg-
ment. The time between those two 
markers is listed in the field labeled 
“ST Segment (ms).” Be sure to 
locate each marker based on your 
facility’s protocol. 

Note: Each marker for each channel 
moves independently so that you can 
precisely position the markers based 
on each channel’s morphology.

4. Once each marker is in the appropri-
ate location, click the radio button 
next to Done. If you have made 
changes to either the Gain or the ST 
Marker window, a window opens to 
ask whether it’s okay to continue. 
Click on Yes to make the change 
and continue. Click No to cancel 
your changes and retain the previous 
information.

5. To exit from the ST Marker window 
without saving your changes, click 
the radio button next to Cancel.

Measuring the ST segment
This is performed automatically for all 
three channels of ECG. Whether the ST 
segment measurement is done at the 
position of the j-point or the ST seg-
ment marker is determined by the set-

Confirm windo

e three ST markers
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ting “ST measurement” in the 
Preferences window. See Chapter 8 for 
details of the Preferences settings and 
their use.

The ST segment measurement is aver-
aged in 30-second increments through-
out the Holter period. Only normals not 
contaminated by artifact are included 
in each average. At least eight valid 
measurements must be made within a 
30-second period for it to be included; 
if there are fewer than eight clean nor-
mal beats, the 30-second increment is 
considered artifact.

For any particular beat, you can mea-
sure the ST segment manually by going 
to the Page display and selecting the 
beat as the current beat. In the 
Expanded display, drag the left marker 
to define iso-electric and the right 
marker to the appropriate location of 
the ST segment. The vertical difference 
between where the two markers inter-
sect each channel of ECG is listed in 
the ST 1, 2 and 3 fields in the 
Expanded 
toolbar.

Plotting ST segment data
The data for all three channels is plot-
ted in the ST level display of the 
Trends window. To display it, select 
Trends from the Review toolbar and 
then select ST level in the Type field.

The top trend is minute-by-minute 
heart rate. Immediately below that is 
the ST trend for channel 1, then chan-
nel 2, with channel 3 on the bottom. 
Each trend shows the patient’s calcu-
lated baseline as a cobalt blue trend, 

with the patient’s ST measurement 
plotted in green and the slope of the ST 
segment indicated by a red vertical 
line.

The software calculates the patient’s 
ST baseline from the patient’s normal 
ST segment measurements as the Hol-
tered period progresses. ST segment 
changes that are caused by positional 
changes result in changes in the 
patient’s baseline, and are not usually 
considered ST events themselves. The 
patient’s baseline during what ends up 
being an ST event is interpolated from 
the baseline before and after the event. 

The significance of establishing a 
patient’s baseline is that it means that 
normal is not always defined as iso-
electric (that is, with no voltage) and 
that significant changes are relative to 
the patient’s baseline, not to iso-elec-
tric.

Identifying ST events
The ST analysis software looks 
through the ST level trends, comparing 
the ST trends to the patient’s baseline 
trends, to find episodes of significant 
ST segment changes.

For an incident to be called an ST 
event, at least one 30-second ST seg-
ment data point must be at least 1 milli-
meter different than the patient’s 
baseline for that channel at that time-
of-day. A depression is a change of at 
least 1 millimeter in the negative direc-
tion, while an elevation is a change of 
at least 1 millimeter in the positive 
direction.

ST 1, 2 and 3 fields
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In the ST level trends, incidents that 
are flagged as ST segment events are 
indicated by a light blue horizontal line 
above the appropriate channel and last-
ing as long as the event. 

The events are listed in the ST event 
table in the Tables window. To display 
it, click Tables in the Review toolbar, 
then click on ST event in the Tables list 
at the right of the Tables window. In 
that table, the description for each 
event includes:

• Channel - the channel in which the 
event was detected

• Onset - the time-of-day at the start 
of the event (defined as when the 
change in ST segment passes 
through the point 0.5-millimeter dif-
ferent from the patient’s baseline)

• End - the time-of-day at the end of 
the event (defined as when the 
change in ST segment returns to 
within 0.5-millimeters different 
from the patient’s baseline)

• Duration - the difference between 
the end and the onset times

• Max HR - the maximum heart rate 
calculated during the duration of the 
event

• Max ST deviation Time - the time-
of-day at the event’s maximum 
deviation from the patient’s baseline

• Max ST deviation HR - the heart 
rate during the event’s maximum 
deviation from the patient’s baseline

• Max ST deviation Baseline - the 
ST segment measurement’s devia-
tion from the patient’s baseline at 
the point of maximum deviation

• Max ST deviation Iso-electric - the 
ST segment measurement’s devia-
tion from iso-electric at the point of 
maximum deviation

• Max ST deviation Slope - the slope 
of the ST segment event at the point 
of maximum deviation (+ indicates 
upsloping; - indicates downsloping; 
0 indicates horizontal)

• Integral - the calculation that 
reflects the area under the slope 
between the ST trend and the 
patient’s baseline during the event

Note: If an event includes both a 
positive component and a negative 
one, the integral is actually less than 
the true area. Although we report the 
absolute value, the integral calcu-
lation can result in a “negative” area, 
which when added to a positive area 
can cancel some or all of it.

All of the information listed in the ST 
event table can be edited by clicking 
the Edit button to open the ST Event 
Edit window and 
making the 
changes you 
desire. To edit an 
entry, drag across 
the existing entry 
and type the infor-
mation to replace 
it. When finished, 
click OK to save 
your changes and 
exit. Click Cancel 
to close the win-
dow without sav-
ing the changes.

ST Event Edit win
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To add an ST event, click the Add but-
ton. The ST Event Edit window opens 
with blank fields. Type the appropriate 
information in each of the fields. Click 
OK to save the event and exit. Click 
Cancel to exit without saving the 
event.To delete an ST event from the 
table, click on the event to be deleted, 
then click the Delete button. The event 
disappears.

To print the table, click the Print but-
ton. To close the Tables window, click 
OK.

Documenting ST events
You control what strips are saved to 
document ST segment events using a 
combination of settings in the What 
Strips to Auto Save and How Often 
Strips Auto Save windows.

Pacemaker analysis
Pacemaker activity is recorded on 
NorthEast’s DR180+ and SD360 Digi-
tal Recorders without distorting the 
patient’s ECG, by removing the effects 
of the pacemaker spike and replacing it 
with a pacemaker marker. That marker, 

when re-introduced to the ECG when 
the compact flashcard is read by the 
analysis software, appears as a vertical 
spike in the precise location of the orig-
inal pacemaker spike.

For the software to do a proper analysis 
of the pacemaker activity during the 
Holter period, the pacemaker settings 
in the Scanning Criteria window must 
be set properly. They include:

• Pacemaker type, which contains 
four settings that allow the software 
to expect certain behavior:

1. Not paced means that the software 
will not identify any pacemaker 
spikes, beats or failures.

2. VVI means that each paced beat will 
be preceded by a single spike. All 
paced beats are counted as ventricu-
lar paced.

3. AV sequential means that paced 
beats should be preceded by two 
pacemaker spikes, one atrial and one 
ventricular. 

4. DDD means that paced beats can be 
preceded by either a one or two 
pacemaker spikes. Depending on the 
spike’s location relative to the fol-
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lowing R-wave, a beat preceded by 
a single spike will be called either 
atrial paced or ventricular paced, 
while a beat preceded by two spikes 
will be counted as AV paced. 

• Minimum heart rate refers to the 
minimum rate allowed by the pace-
maker. If the pacemaker does not 
fire appropriately and there is a RR 
interval longer than the patient 
should experience, the Inhibition 
label appears.

• Maximum heart rate refers to the 
maximum rate initiated by the pace-
maker. If the pacemaker fires early, 
which would result in a faster rate, 
the Sense failure label appears.

• Maximum vent. spike to R inter-
val sets the maximum time between 
the firing of the second pacemaker 
spike and the following R-wave. If 
the second spike appears and is not 
followed by an R-wave in this 
amount of time, the Capture failure 
label appears.

• Maximum atrial spike to R inter-
val sets the limit for how long is 
allowed between a single spike and 
the subsequent R-wave. If a single 
spike occurs and the following R-
wave is not within this amount of 
time, the Capture failure label 
appears.

• Paced beat and the beat after can 
be called a SVPB is a setting that 
allows you to identify early beats 
following a paced beat as SVPBs 
because they were premature, even 
if they themselves are paced beats. 
Click on the check box to turn it off 
and on.

Pacemaker labels
Beats can be identified and counted 
with the following labels (refer to the 
diagram on the previous page):

• A paced for a beat that is paced just 
in the atrium. The atrial spike is 
determined to be the one that occurs 
well before the QRS, falling before 
the “Maximum ventricular spike to 
R interval,” but within the “Maxi-
mum atrial spike to R interval.”

• V paced for a beat that is paced just 
in the ventricle. With pacemaker 
type set to DDD or AV Sequential, 
the ventricular spike is determined 
to be the one that occurs during the 
“Maximum ventricular spike to R 
interval.” This label also includes all 
paced beats with the pacemaker type 
set to VVI and all beats without 
pacemaker spikes that are manually 
labeled “Paced.”

• AV paced for a beat that is paced in 
both the atrium and the ventricle, 
with the atrial and ventricular spikes 
identified in the same way as 
described above.

• Sense failure means that the pace-
maker (1) did not sense a QRS that 
occurred and (2) fired, resulting in a 
shorter-than-programmed R-to-
spike interval. The label can happen 
under three scenarios:

1. Pacemaker type  is set to DDD and 
two pacemaker spikes occur, with 
less than the “Maximum atrial spike 
to R interval” between them, and 
with the second spike more than 20 
milliseconds after the QRS.

2. A single spike is more than 20 milli-
seconds after the QRS.
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3. The time between the preceding 
QRS and the next pacemaker spike 
is less than 60 divided by the “Maxi-
mum heart rate;” that is, the pace-
maker fired early.

• Inhibition refers to inappropriate 
inhibition of the pacemaker, result-
ing in a longer-than-programmed 
RR interval. This label appears if the 
time between the preceding QRS 
and the next pacemaker spike is 
greater than 60 divided by the “Min-
imum heart rate” setting; that is, the 
pacemaker fired late.

• Capture failure means that the 
pacemaker has fired, but there is no 
subsequent QRS within the allotted 
interval. The label, which falls on 
the detected QRS after the missing 
QRS, appears in four scenarios:

1. The pacemaker type is DDD or AV 
Sequential and there are two pace-
maker spikes, with the time between 
them less than “Maximum atrial 
spike to R interval” and the time 
between the second spike to the 
QRS greater than the “Maximum 
ventricular spike to R interval” set-
ting.

2. The pacemaker type is DDD or AV 
Sequential and there is only one 
pacemaker spike, with the time 
between the spike and the following 
QRS greater than the “Maximum 
atrial spike to R interval” setting.

3. The pacemaker type is VVI and the 
time between the pacemaker spike 
and the following QRS is greater 
than the “Maximum ventricular 
spike to R interval” setting.

4. There are two pacemaker spikes that 
are more than the “Maximum atrial 
spike to R interval” apart and the 

time from the first pacemaker spike 
to the following QRS is greater than 
the “Maximum ventricular spike to 
R interval” setting.

Pacemaker table
Pacemaker counts are itemized in the 
Paced table in the Tables window. To 
display it, click Tables in the Review 
toolbar, then click on Paced in the 
Tables list at the right of the Tables 
window. The Paced table is an interval 
table and the reported data includes:

• Time-of-day - the time-of-day at the 
start of the interval;

• Total Beats - the total number of 
beats identified and counted within 
the interval, not including artifact;

• Time Analyzed - the total amount 
of time analyzed during the interval; 
this does not including periods that 
are considered to be artifact;

• Total Paced - total of the following 
3 fields;

• Atrial Only - paced beats that were 
determined to be paced only in the 
atrium, not the ventricle;

• Vent(ricular) Only - paced beats 
that were determined to be paced 
only in the ventricle, not the atrium;

• AV - paced beats that were deter-
mined to be paced in both atrial and 
ventricular chambers;

• Sense Failure - the number of times 
sense failures occurred (these are 
defined in the previous section);

• Capture Failure - the number of 
times capture failures occurred 
(these are defined in the previous 
section);

• Inhibit(ion) - the number of times 
the pacemaker was inappropriately 
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inhibited from firing (this is defined 
in the previous section).

• Paced% - the percentage of paced 
beats out of all beats in that interval.

The fields in this table can be edited as 
described in the “Editing table entries” 
section of the following chapter.
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The Holter signal saved for a patient can be reviewed on the monitor of your computer in several 
ways. You can review and edit (1) the templates established during analysis, (2) the most signifi-
cant events identified during analysis, (3) on-screen full disclosure of all the ECG, (4) graphs 
showing the heart rate and RR interval data, (5) strips saved for the final report, (6) superimposi-
tion, and (7) tables compiled for the report.
Guide to Holter
Color coding
Throughout the LX Pro software, the ECG is color-coded based on 
what the system has labeled each beat: 

• Green: Beats the software has identified as normal.

• Yellow: Beats identified as supraventricular premature beats 
(SVPBs). They have a normal morphology, but fall early. 

• Red: Beats identified as ventricular premature beats (VPBs). 
They differ significantly from the normal; they are not neces-
sarily premature.

• White: Beats identified as pauses, based on the definition in the 
Scanning Criteria window. The white overrides any other color 
that the beat may also qualify for (e.g., red because it’s a VPB).

• Light blue (cyan): Signal that appears to be contaminated by 
artifact. 

• Cobalt blue: Beats identified as paced.

All data must be reviewed carefully to ensure that you agree with 
the beat labels the software has selected; if you do not agree, you 
can change them and their color will change appropriately.

In addition to the labels the software can provide for each beat, 
there are some labels only you can use to relabel beats. These are:

• Aberrant: Use this label to identify and counts beats as 
aberrantly conducted SVPBs. All matches to the template that 
meet the SVPB prematurity requirement will be counted as 
Aberrant SVPBs and colored yellow, like the other SVPBs. This 
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Ventri
can be used as either a template or a 
beat label.

• Questionable (Unknown): Use this 
label to separate out beats you 
cannot identify and keep them from 
being included in another category. 
They are colored green, like 
normals. This can be used as a 
template or a beat label.

• T-wave: Use this label if the 
software has identified a portion of 
the signal as a QRS, but it is not. 
This will remove the beat from the 
counts and will merge its RR 
interval with the preceding RR 
interval. The signal will take the 
color of whatever beat precedes it. 
This can only be a beat label.

Reviewing Bins 
During analysis, the LX software first 
determines what the patient’s normal 
QRS complex looks like and estab-
lishes a template called “normal.” Each 
beat after that is compared to the nor-
mal template; matches to that template 
are also called normal, while a similar 
but slightly different morphology will 
establish a new template, also called 
normal. A QRS complex that differs 
more significantly from the normal 
template will establish a template 
called “ventricular.” A new template is 
established for each different morphol-
ogy identified by the software. Subse-
quent matches to a template get labeled 
                                                                                           Guide to Holter LX Pro
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based on the template label, the timing 
of the beat, and other criteria.

After analysis, the templates that gen-
erally look alike are grouped together 
in “bins.” You can review these bins by 
morphology, that is, all normal bins or 
all ventricular bins. Within the Bin 
window, you can also review by tem-
plate, displaying all the templates 
within each bin, one bin after the other. 
You can also review all matches to 
each template, displaying them one 
template after another. 

Description of the Bin window
The Bin window opens with all bins of 
a particular morphology (normal, ven-
tricular, aberrant, paced, questionable 
or artifact) displayed, up to a maximum 
of 16 bins. The morphology type is 
indicated in the Morph(ology) field, 
along with an indication of how many 
templates of that type were established 
for this patient and how many total 
beats were counted as this type. For 
example, in the figure on the previous 
page, there are 9 ventricular bins made 
up of 12 templates, and a total of 7,855 
beats matched the templates in those 
bins.

To change the morphology displayed, 
click on the arrow in the Morph field to 
display your choices, then click on the 
type you want displayed.

In each bin display, the three channels 
of the center beat are surrounded by an 
outlined box. That beat is the one that 
is in the bin; the surrounding ECG is 

displayed to show how the beat 
occurred, but is not included in the bin. 
The number in the left corner of each 
bin indicates how many total beats 
matched the templates within that bin.

To select a particular bin, click on it. 
The time-of-day becomes outlined and 
the Bin # and Matches fields now dis-
play data for that particular bin.

Relabeling a bin
To relabel a bin and all of its contents 
(all templates and matches), click on 
the bin to select it, then click on one of 
the label buttons under the Morphology 
field. The relabel buttons are not active 
unless one or more bins are selected.

The relabel buttons include: 

• A for artifact

• V for ventricular

• N for normal

• B for aberrant 

• Q for questionable/unknown

Note: No S label buttons appears 
here because an SVPB matches a 
normal template, but is early.

To relabel multiple bins, click on each 
of the bins you want to relabel and then 
click on the appropriate relabel button. 
To relabel all of the displayed bins, 

Relabel buttons for bins and templates
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Rad
click the All button to select all the dis-
played bins and then click the appropri-
ate relabel button.

To undo a relabel, click on the Undo 
button. It will restore the bins to their 
state before the last relabel, regardless 
of whether it was a single bin, multiple 
bins, or all bins that were relabeled.

Changing levels in the Bin 
window
To display the templates within a par-
ticular bin, click on the bin and then 
click on the Templates radio button.

Note: Moving from one level of the 
Bin window to the next can also be 
done by double-clicking on the ECG 
in the bin, template, or beats display. 
Each double-click changes the radio 
button position one button to the 
right.

Note: When a scroll bar appears to 
the right of a field or window, you 
have the option of using it or using 
the scroll button on your mouse, if 
you have one.

Template display
The individual templates are presented 
with two additional pieces of informa-
tion just underneath each template - the 
number of matches to the template and 
the time-of-day the template was estab-
lished, that is, the first occurrence of 
that template.

When you click to highlight a particu-
lar template, the Strip # and Matches 
fields update to reflect information 
about the current template.

The template display contains up to 12 
templates that matched the current bin. 
If more than 12 templates fell into that 
bin, you can access additional pages of 
templates by using the PageDown key, 
the scroll bar or the Scan button. If you 
use the PageDown key, once you reach 
the last page of templates in the current 
bin, PageDown will display the tem-
plates that matched the next sequential 
bin of the same morphology type.

To display the templates in a different 
bin, click the up and down arrows of 
the Bin # field.

Relabeling a template
To relabel a template and all matches to 
it, click on the template to select it (the 
time-of-day of a selected template is 
surrounded by a yellow box), then click 
on a label button under the Morphol-
ogy field.

To relabel multiple templates, click on 
each of the templates you want to rela-
bel and then click on the appropriate 
relabel button. To relabel all of the dis-
played templates, click the All button 
to select all the displayed templates and 
then click the appropriate relabel but-
ton.

Note: If there are multiple pages of 
templates within a bin and you relabel 
one or more of them, blank spaces are 
temporarily left where the template(s) 
originally appeared. After paging up 
or down and returning, the blank 
spaces are gone.

io buttons in Bin window
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To undo a relabel, click on the Undo 
button. It will restore the templates to 
their state before the last relabel.

Beats display
Clicking the Beats radio button dis-
plays up to 24 of the beats that matched 
the current template. Use the Page-
Down, the Scan button, or the scroll 
bar to display additional matches to the 
template. The display includes the 
time-of-day each beat occurred, the 
template number the beats matched (in 
the Template field), and the total 
matches to the template (Strip #).

For the current beat, two blue vertical 
markers appear. The markers can be 
used to make measurements, which 
appear in the data fields below the 
large time-of-day field. 

Drag the blue markers to appropriate 
locations to have the data fields dis-
play:

• HR (2RR) field shows the heart rate 
calculation based on the blue 
markers being two RR intervals 
apart. 

• Time field indicates the time (in 
seconds) between the blue markers.

• ST 1 field displays the vertical 
difference between where the 
markers intersect channel 1. The left 
marker should define iso-electric 
and the right marker should be 
located where you want the ST 
measurement made.

• ST 2 field displays the vertical 
difference between where the 
markers intersect channel 2. They 
should be positioned as indicated for 
channel 1.

• ST 3 field displays the vertical 
difference between where the 
markers intersect channel 3. They 
should be positioned as indicated for 
channel 1.

Click the Both check box to drag the 
markers keeping them the same dis-
tance apart. Click the Both box again to 
move the markers separately.

To keep the calipers in the same loca-
tions as you move through different 
screens of ECG, click the check box 
next to Lock; the calipers will stay in 
the indicated locations unless you 

move them again. Click again to 
turn off.

Relabeling a beat
The Beats window in Bin allows only 
single-beat editing, which removes a 
beat from its template and relabels just 
that beat. To relabel a beat this way, 
click on the beat to select it, then click 
on one of the relabel buttons under the 
Morphology field. 

In addition to the relabel buttons 
defined in the “Relabeling a bin” sec-
tion earlier in this chapter, the relabel 
buttons for beats and strips include:

Relabel buttons for beats and strips

ata fields in Beats and Strips displays
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• S for supraventricular

• T for T-wave

To relabel multiple beats, click on each 
of them and then click on the correct 
relabel button.

To undo a relabel, click on the Undo 
button. It will restore the beats to their 
state before the last relabel.

Saving sample strips for the 
report
As you review the ECG, you can 
choose to manually save sample strips 
for the report. The 7.5-second sample 
strips are printed as full-sized, 25-mm/
second ECG on a background grid. To 
save a strip containing one of the dis-
played beats, click on the beat you 
want at the center of the strip to make it 
the current beat, and then click Keep; 
the Keep window opens. To label the 
strip, either type the label in the 
Description field or select a label from 
the scrolling list; then click OK to save 
the strip. To close the Keep window 
without saving the strip, click Cancel.

For more information about the Keep 
window, see “Saving sample strips for 
the report” in the Page window section 
of this chapter.

Printing the ECG now
To print a strip of ECG centered on a 
displayed beat, along with a page of 
full disclosure of the surrounding 
rhythm, use the Print button. When the 
Print window opens, click the left-hand 
button to print with the current beat 
centered on the page of full disclosure, 
or click the middle button to print with 

the current beat on the first line of the 
page. Click Cancel to close the window 
without printing.

Strips display
The Strips display provides a full-
screen display of the current beat. All 
buttons, fields, and markers work as 
described in the previous section, 
“Beats display,” with one addi-
tion - the Display field. This 
controls the amount of time 
that appears in the full-screen 
display. Click on the arrow in 
the field to show your choices, 
and click on your choice to 
change the amount of time.

Reviewing Critical 
Events
The most significant events that 
occurred during the Holter 
test appear in the Critical 
Events window. You can 
review and edit them as 
needed in the Critical 
Events window. 

Types of Critical 
Events
The categories that can be 
displayed appear in the fig-
ure to the right. Each type 
also has a number associ-
ated with it - the number of 
events of that type that 
were identified for this 
patient. Every event of 
each type can be displayed, 
either one at a time (full-
sized) or 12 at a time (min-
iature). 

Choices in Critical E

Display field ch
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Critica
To select a type to be displayed, use the 
scroll bar to scroll through the list and 
display your choice, and then click on 
your selection.

Note: A beat that appears in one 
category of Critical Events does not 
appear in all other applicable 
categories. For example, if a VPB 
appears in Bigeminy, it does not 
appear in VPB; if a paced beat 
appears in Sense Failure, it does not 
appear in any other paced category. 
Therefore, do not rely on the counts 
in Critical Events to provide compre-
hensive totals.

To move through the displayed epi-
sodes, use the PageUp and PageDown 
keys, the scroll bar, the scroll button on 
your mouse, or click Scan to automati-
cally move from one display to the 
next. Click the Scan button again to 
stop the display.

When a single episode is displayed, 
click the Multiple button to display 12 
at a time. When multiple episodes are 
displayed, the button label changes to 
“Single;” click that to display just one 
episode. You can also double-click on a 
strip to toggle back and forth between 
the single and multiple displays.
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Each event is labeled with time-of-day 
and RR interval. In addition, if the 
ECG appears in a strip saved for the 
printed report, the word “saved” 
appears to the right of the RR interval.

ST events
ST events are in the Critical Events list. 
If you click ST Events, the strips show-
ing the maximum ST deviation during 
each event are displayed. In addition, 
an ST event table button appears; that 
allows you to display a table listing the 
ST events that were found on this 
Holter test.

Heart rate strip (HR strips)
Critical Events includes this display of 
all the ECG recorded during the Holter 
period, in 7.5-second strips. While 
some beats may appear more than once 
in other categories (because they are 
adjacent to the current beat being dis-
played), this category displays each 
beat in one strip only. The heart rate 
listed is based on all beats present in 
the displayed strip.

Saved strips
Saved strips are in the Critical Events 
list so that you can review the strips 
saved for the final report without leav-
ing the Critical Events window.

Changing the amount of time 
displayed
The Display field controls the amount 
of time that appears in the single event 
display. Click on the arrow in the field 
to show your choices, and click on 

your choice to change the amount of 
time displayed.

Saving sample strips for the 
report
As you review the ECG, you can 
choose to manually save sample strips 
for the report. The 7.5-second sample 
strips are printed as full-sized, 25 mm/
second ECG on a background grid. 

To save a strip containing one of the 
displayed beats, click on the beat you 
want at the center of the strip to make it 
the current beat, and then click Keep; 
the Keep window opens. To keep it 
with the current label, click OK. To 
relabel the strip, type the label in the 
Description field or select a label from 
the scrolling list; then click OK to save 
the strip. 

To save multiple strips all with the 
same label, click on each one to be 
saved, then click the Keep button and 
click on the button that indicates multi-
ple strips - it will read “x strips,” with x 
equal to the number of strips you 
selected before clicking Keep.

Any strips you manually save are 
included in the Saved Strips window.

If you decide to close the Keep window 
without saving the strip, click Cancel.

For more information about the Keep 
window, see “Saving sample strips for 
the report” in the Page window section 
of this chapter.
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Sorting episodes within a type
The Sort field lets you change the order 
of the episodes within each type. You 
can choose “RR interval” to put them in 
order based on the RR interval, from 
shortest to longest, starting with the 
current beat. Unlike RR interval label-
ing elsewhere in the software, which 
labels the interval length from the cur-
rent beat to the following beat, sorting 
by RR interval in Critical Events sorts 
based on the RR interval preceding the 
current beat; in that way, you can 
review the most premature beats of a 
type or the latest beats of a type. 

The “Time” setting orders the episodes 
based on the time-of-day of the event, 
from earliest to latest.

The “24 hours” setting also orders them 
by time-of-day, but the histogram at the 
top of the window is divided into 
hourly intervals. See the “Histograms” 
section below for details.

To change the setting, use the scroll bar 
to display additional choices and then 
click on your choice.

Histograms
The top portion of the Critical Events 
window presents a histogram showing 
the distribution of the events within the 
type displayed - either an RR histogram 
or a 24-hour histogram. 

The RR histogram plots the length of 
the RR interval preceding each episode 
of the displayed type. The number of 
events is on the vertical axis (with a log 
scale) and RR interval (in milliseconds) 

is on the horizontal axis. The blue 
marker is located at the position of the 
current event. To display the event 
associated with an alternate RR inter-
val, click on the RR interval in the his-
togram; the appropriate event will 
appear as the active event in the bottom 
portion of the window.

The 24-hour histogram shows how 
many episodes of the displayed type 
occurred during each 10-minute inter-
val of the recording. The blue arrow is 
located at the position of the current 
event. To display the events associated 
with a different time-of-day, click on 
the histogram at that time; the appropri-
ate event will appear as the active event 
in the bottom portion of the window.

Which histogram displays is based on 
the setting in the Sort field. The settings 
“RR interval” and “Time” display the 
RR histogram; the setting “24 hours” 
displays the time-of-day histogram 
shown above.

24-hour histogram
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Data
Data fields
The data fields in this window are just 
like those in all other Review windows. 
Two blue vertical markers appear 
within the current episode. The mark-
ers can be used to make measurements, 
which appear in the data fields. 

Drag the blue markers to appropriate 
locations to have the data fields dis-
play:

• HR (2RR) field shows the heart rate 
calculation based on the blue 
markers being two RR intervals 
apart. 

• The Time field indicates the time (in 
seconds) between the blue markers.

• The ST 1 field displays the vertical 
difference between where the 
markers intersect channel 1. The left 
marker should define iso-electric 
and the right marker should be 
located where you want the ST 
measurement made.

• The ST 2 field displays the vertical 
difference between where the 
markers intersect channel 2. They 
should be positioned as indicated for 
channel 1.

• The ST 3 field displays the vertical 
difference between where the 
markers intersect channel 3. They 
should be positioned as indicated for 
channel 1.

Click the Both check box to drag the 
markers keeping them the same dis-
tance apart. Click the Both box again to 
move the markers separately.

To keep the calipers in the same loca-
tions as you move through different 
screens of ECG, click the check box 
next to Lock; the calipers will stay in 
the indicated locations unless you 
move them again. Click to turn off.

Printing the ECG now
To print a strip of ECG centered on a 

displayed beat, along with a page of 
full disclosure of the surrounding 
rhythm, use the Print button. When the 
Print window opens, click the left-hand 
button to print with the current beat 
centered on the page of full disclosure, 
or click the middle button to print with 
the current beat on the first line of the 
page. Click Cancel to close the window 
without printing.

Relabeling in Critical Events
All relabeling done in the Critical 
Events window is single-beat editing. 
Only the current beat within the 
selected event is relabeled when you 
use these relabel buttons:

• A for artifact

• V for ventricular

• N for normal 

• S for supraventricular

• P for paced (appears only if Pacemaker 
mode is on in Scanning Criteria)

• B for aberrant

• Q for questionable/unknown

• T for T-wave

Print window

 fields
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Reviewing Saved Strips
To relabel a beat within the Critical 
Events window, click on the event to 
select it; this turns the relabel buttons 
from dim to colored. Click one of the 
colored relabel buttons to relabel the 
selected beat.

To relabel multiple beats, click on sev-
eral, then click the relabel button.

To relabel all displayed beats, click the 
All button, then the relabel button. 

In addition, these relabel buttons 
appear whenever the type displayed is 
an ectopic event of either ventricular or 
supraventricular origin:

• Single - This will change all beat 
labels to normal except for the 
current beat, which will be called a 
single SVPB or VPB, depending on 
its present label. If the present type 
is SVT, this button will remove the 
run that was counted and replace it 
with an SVPB. If the present type is 
VPB Pair, this button will subtract 
the pair and replace it with a VPB.

• Pair - This will change beat labels 
so that two sequential beats are 
called a pair, either an SVPB Pair or 
a VPB Pair, depending on its present 
label. If the present type is VPB, this 
button will change the selected event 
to be labeled and counted as a VPB 
Pair. If the present type is SVT, the 
selected run will be relabeled and 
counted as an SVPB Pair.

• Run - This will change beat labels 
so that three sequential beats are 
called a run, either SVT or VTAC, 
depending on its present label. If the 
present type is SVPB, a three-beat 
run of SVT will replace the SVPB. 
If the present type is VPB Pair, a 

three-beat run of VTAC will replace 
the pair.

Reviewing Saved Strips
The report includes full-size, 7.5-sec-
ond, 25-mm/sec strips on a background 
grid. Some strips are automatically 
saved based on the settings in the What 
Strips to Auto Save window. You can 
also use the Keep button to manually 
save strips while reviewing the Holter 
recording.

To review the saved strips, click Saved 
Strips in the Holter menu. The Saved 
Strips window displays a miniature 
version of the strips 12 at a time. Each 
is labeled with its strip label and the 
time-of-day at which it occurred. Page 
through them using either the PageUp 
and PageDown keys, clicking on the up 
and down arrows of the scroll bar, or 
using the scroll button on your mouse.

All strips are three-channel unless 
oximetry data was collected for this 
patient; if oximetry data is present, it 
appears in the area where channel 3 
normally appears, and data fields of 
SpO2 data appear to the right of the 
standard data fields.

A Saved Strip
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The strips are initially sorted by strip 
label. To review them ordered by time-
of-day, select Time from the choices in 
the Sort field.

Note: ST event labels include the 
channel in which the ST segment 
change occurred. 

Changing the active strip
At any time, there is only one active 
strip, the strip outlined in blue. Four 
fields above the strips refer specifically 
to the active strip. Those fields include 
time-of-day, a strip number, HR (heart 
rate) and HR2 (the second heart rate, 
that is, the heart rate of a run of VTAC 
or SVT in the strip).

To change the active strip, click on the 
one you want so that the outline sur-
rounds it. You can also change the 
active strip by clicking the List button 
in the toolbar to open the List window. 
The List window lists each strip label 
and corresponding heart rate in order of 
time-of-day. To display a particular 
strip from the list, click on the appro-
priate entry on the list and click OK, or 
double-click on the entry. To exit with-
out changing the active strip, click 
Cancel.

Editing a strip label
To change the label of the active strip, 
click on Edit in the toolbar. The Edit 
window opens; it includes a field with 
the current label of the strip and the 
heart rate of the ECG in the strip, along 
with the second heart rate, the rate of 
either SVT or VTAC if it is present. (A 

second heart rate of 0 indicates that 
there is no run on the strip.)

You can either type over the existing 
strip label in the Description field or 
select an alternate label by clicking on 
the arrow at the right end of the 
Description field and selecting a label 
from the displayed list.

If you type the entry, the auto-fill fea-
ture appears - as you type, the charac-
ters are matched to the preset list and 
will automatically fill in; if the text that 
appears is not what you want, continue 
typing the entry until it displays appro-
priately. If the label you want is not 
already on the preset list, you must 
type the entire entry. Once the correct 
label appears, press Enter.

To change the heart rate on the strip, 
click on the HR field and type over the 
existing entry.

When you have completed your 
changes, click OK to save those 
changes and exit; click Cancel to exit 
without saving any changes.

Deleting strips
If you decide to delete one or more of 
the strips from the final report, you can 
do that in the Saved Strips window. To 

Edit window
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 strips
delete one strip in the Multiple strip 
display, click on it to make that strip 
the active one, then click Delete in the 
toolbar. To delete more than one strip, 
click on the first strip to make it the 
active strip; in addition to the blue 
highlight around the strip, there is 
also a yellow highlight around the 
time-of-day, indicating that the 
strip is selected. Click on any addi-
tional strips you want to delete, then 
click Delete in the toolbar. All of the 
selected strips (as indicated by the yel-
low highlight) are now deleted.

When you delete a strip, its label 
becomes red; strips with red labels are 
not included in the printed report. To 
retrieve a deleted strip, click on it and 
then click Delete in the toolbar again; 
the label text changes back to yellow.

To delete all of the strips displayed, 
click the button labeled Del/Undel All. 
To retrieve all of the strips displayed, 
click the button again.

Deleting channels from a strip
To delete one or more channels of a 
strip, but not the entire strip, click on a 
strip to make it active. Then, click on 
one of the check boxes labeled Channel 
1, 2 and 3. For a particular strip, if a 
check is present, the channel will be 
included; if a box is not checked, the 
channel will be deleted. To delete a 
channel from all strips, delete the chan-
nel from the active strip, then click on 
All.

When the Confirm window appears, 
click Yes to delete the channel(s) from 
all strips. Click No to cancel the All 
command.

Replacing a strip with an 
alternative
Some strips can be replaced by an 
alternative: maximum and minimum 
heart rates, shortest and longest RR 
intervals, and fastest and longest runs 
of VTAC and SVT. The software 
selects sample strips for those types 
automatically. If you would prefer to 
select a different one (perhaps because 
the selected one contains artifact), click 
on the strip to make it active; the Alter-
natives button appears. 

When you click Alternatives, the Alter-
natives window opens, displaying 
other choices for that label. All catego-
ries except the longest runs are sorted 
by heart rate, with the worst case first; 
the longest runs of SVT and VTAC are 
sorted by length, longest first. The cur-
rent selection is the first one, in the 
upper left corner.

To select a different strip, click on the 
strip and then the Select new Alterna-
tive button. The window closes and the 
new strip appears in the Saved Strips 

Confirm window for deleting channel in All
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window. To exit from the Alternatives 
window without changing the strip, 
click the Back to Saved Strips button.

Measuring
The data fields in the center of the tool-
bar - HR (2 RR), Time, and the ST 
indicators for each channel - contain 
data calculated based on the two blue 
calipers in the active strip. As you drag 
the blue calipers, those fields change, 
reflecting the new caliper positions.

To measure a two-beat heart rate, place 
the calipers two RR intervals apart; the 
measurement appears in the HR (2 RR) 
field. To measure ST in any of the 
channels, position the left caliper in the 
isoelectric area of the PR interval and 
the right caliper where you want to 
make the ST measurement; the mea-
surements for each channel appear in 
the appropriate fields.

To move the calipers keeping them the 
same distance apart, click the check 
box next to Both and then drag the cali-
pers. Click again to remove the mark 
and move them separately.

To keep the calipers in the same loca-
tions as you move through different 
screens of ECG, click the check box 
next to Lock; the calipers will stay in 
the indicated locations unless you 
move them again. Click again to turn 
off.

Printing the ECG now
To print a strip of ECG centered on a 
displayed beat, along with a page of 

full disclosure of the surrounding 
rhythm, use the Print button. When the 
Print window opens, click the left-hand 
button to print with the current beat 
centered on the page of full disclosure, 
or click the middle button to print with 
the current beat on the first line of the 
page. Click Cancel to close the window 
without printing.

Expanding the active strip
To view a strip more closely, either 
click Single in the toolbar or double-
click on the strip. It then fills the Saved 
Strips window. Each beat is labeled 
with either the heart rate (BPM) or the 
length (in milliseconds) of the RR 
interval following the beat.

The blue measurement calipers and the 
related data fields work in this window 
exactly as those described in the previ-
ous section, “Measuring.”

All other buttons and fields work in the 
Expanded display just as they do in the 
Multiple strip display. Use PageUp and 
PageDown to display the other 
strips.To return to the Multiple strip 
display, click Multiple in the toolbar.

Note: Saved Strips are re-compiled 
after every Update or Re-analysis, so 
be sure to make changes to the 
automatically saved strips only after 
you have completed all other editing. 
Any editing of automatically saved 
strips that occurs before an update or 
re-analysis will be lost. Manually 
saved strips remain as is.
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Miniat
Reviewing in the Page 
window
The Page window allows you to review 
all of the ECG stored during the 
recording, like an electronic full disclo-
sure. To open it, click on Page in the 
Review toolbar. The window is divided 
into two displays: a miniature, single-
channel presentation and an expanded 
three-channel display with a back-
ground grid. 

You can toggle the window format 
back and forth between (1) only the 
miniaturized ECG and (2) a combina-
tion screen (with a single-channel dis-
play on the top half and an expanded 
strip on the bottom) using the Full 
screen/Expand button.

Single-channel page display
The single-channel page display con-
tains a blue highlight box surrounding 
one of the QRS complexes, the “cur-
rent” beat. The time-of-day at that beat 
is displayed in the time field in the 
upper left corner of the window. The 
displayed ECG can be adjusted in these 
ways:

• To adjust the ECG so that the 
highlighted beat appears in the 
center of the page, click Center.

• To move the highlight box to a 
different beat, click on the beat.

• To change the channel displayed, 
click on the Lead field and select a 
different channel from the list.
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• To change the 
amplitude of the 
displayed signal, 
click on the Gain 
field and select a 
different size from 
the list.

• To change the 
amount of time 
displayed on each page, click on the 
Zoom field and select a different 
amount of time.

• To invert the signal in a channel or 
to hide it from view (because the 
signal in one channel interferes with 
your visual review of another 
channel) go to Review > Invert/Hide 
to open the Invert/Hide window. 
Click on the check box for each 
channel to be inverted; click on it 
again to return the signal to normal. 
Click on the check box for each 
channel to be hidden; click again to 
return it to normal. Click OK to save 
any changes and exit. To close the 
window without saving changes, 
click Cancel.

In the single-channel display, you can 
visually review pages of ECG by using 
the PageUp and PageDown keys, by 
clicking on the down arrow of the 
scroll bar, by using the scroll button on 
your mouse, or by clicking the Scan 

button. Turn the Scan button off by 
clicking it again. Control the speed of 
the scan by pressing + to make it faster 
and - to slow it down.

Expanded ECG display
The Expanded display shows three 
channels of ECG in the bottom of the 
Page window. To display Expanded 
ECG, click the Expand button.

The Expanded ECG in the bottom half 
of the window and the single-channel 
display in the top half of the window 
are linked. The Expanded strip is cen-
tered on the highlight box in the top 
half. If you move the highlight box, the 
ECG displayed in the bottom half 
changes appropriately.

Note: If there is oximetry data for a 
patient, it appears in the Channel 3 
area of the Expanded ECG. The 
color-coded trend (mostly green) 
shows the SpO2 data and the white 
trend shows the pulse waveform.

To change the 
amount of time 
that appears in 
the expanded 
mode, click in 
the Display 
field in the 
toolbar at the 
center of the window and select the 
amount of time to be displayed.

To obtain a single-page printout of the 
ECG on the screen, click Print in the 

Gain choices

Invert/Hide window
Display choices
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toolbar at the top of the Page window. 
The Print window appears. To print the 
ECG with the current beat centered in a 
single-channel, miniaturized format, 
click on the Beat centered button; to 
print with the current beat in the center 
of the top line of the single-channel, 
miniaturized format, click on the Beat 
on top line button; to close the Print 
window without printing, click Cancel. 

Relabeling in the Page display
The type of relabeling performed is 
determined by the setting in the Mode 
field. Choices are:

• Single beat relabels just the current, 
highlighted beat to whatever label 
you choose, removing the beat from 
whatever template and bin it was in 
and installing it in a new template in 
its new morphology.

• All matches 
relabels the 
template to 
whatever 
label you 
choose. It is 
removed from its present bin and 
established as a template in its new 
morphology; all matches to that 
template have the new label.

The relabel buttons include:

• A for artifact

• V for ventricular

• N for normal

• S for supraventricular

• P for paced (appears only when 
Paced mode is on in Scanning 
Criteria window)

• B for aberrant SVPB

• Q for questionable or unknown

• T for T-wave

Note: Although the S and T labels 
are available in Page, only a single 
beat at a time can be relabeled to S or 
T. If Mode is set to All matches and 
you use the S or T relabel button, a 
single-beat edit will be performed.

To relabel in the Page window, click on 
the beat to be relabeled, select the 
appropriate setting for the Mode field, 
and then click the appropriate relabel 
button.

To relabel multiple single beats to the 
same label, click on the first beat, then 
press the Shift key and click on each 
additional beat. A blue highlight box 
surrounds each of the beats to be rela-
beled; click the appropriate relabel but-
ton. This method does single-beat 
relabeling only.

To relabel a string of beats to the same 
label, click on the first beat and then 
drag across to the last beat; the beats 
turn magenta. Then click the appropri-

Print window in Review windows

Relabel Modes
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ate relabel button. This method does 
single-beat relabeling only.

Note: Whenever you use a relabel 
button, a message appears in the 
bottom strip of the window indicating 
what label was given to the beat and 
how many beats were relabeled. In 
addition, error messages appear there 
whenever you try to relabel inappro-
priately.

To undo a relabel, click the Undo but-
ton. The labeling reverts to just before 
the last relabel.

Disabling SVPB count
If a patient is in intermittent atrial 
fibrillation or flutter, you can disable 
the SVPB counts for those periods. To 
do so, select the ECG by dragging 
across it (it turns magenta), then click 
the SVPB Disable button. All the 
selected beats turn green, indicating 
that none of them are called SVPBs. To 
undo the change, select the ECG again 
and click SVPB Enable. 

Inserting a beat
If while you are reviewing the ECG in 
the Page window, you see that a partic-
ular beat is included in the highlight 
box of the preceding beat, it means that 
the beat was missed. This is usually 
because of very low amplitude, but 
sometimes because of low slope. To 
force the system to count the beat, you 

can use the Insert button in the 
Expanded Page toolbar. 

To insert a beat, first click near the beat 
so that it appears in the Expanded Page 
display, then drag or click the left-hand 
caliper to the location of the missed 
QRS complex. Click the Insert button 
in the toolbar in the middle of the win-
dow. The Insert window opens, with 
the time-of-day of the new beat listed 
in the first field and a beat label in the 
Morphology field. Click on the arrow 
in the Morphology field to display the 
list of label choices and make your 
selection. Then click OK to insert that 
type of beat where the left-hand caliper 
is. 

To exit without inserting a beat, click 
Cancel.

Saving sample strips for the 
report
As you review the ECG, you can 
choose to manually save sample strips 
for the report. The 7.5-second sample 
strips are printed as full-sized, 25 mm/
second ECG on a background grid. 

To save a strip, click on the beat you 
want at the center of the strip to move 
the highlight box there, and then click 
the Keep button; the Keep window 
opens. The Description field contains 

Enable/Disable SVPB buttons

Insert window
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the current beat label; to keep that 
label, leave the field as is. To relabel 
the strip, either type the label in the 
Description field or select a label from 
the scrolling list; then click OK to save 
the strip. 

The Keep window also includes two 
heart rate fields: HR, which equals the 
heart rate of the background rhythm of 
the strip, and HR 2, which is the rate of 
the run (VTAC or SVT) on the strip, if 
there is one. HR 2 equal to 0 means 
that there is no run on the strip. Both 
fields can be edited if you choose to. 
Be sure to make any measurements 
before you click Keep because the cali-
pers are not accessible when the Keep 
window is open.

Once the label and the heart rate fields 
contain the information you want, click 
OK.

To save strips of an event longer than 
7.5 seconds, drag the cursor across the 
ECG to be saved (the selected ECG 
turns magenta) and then click Keep. In 
the Keep window, you can enter the 
label of the first strip in the series and 
then click the left button, which indi-
cates how long a time period to be 
saved. Subsequent strips in the series 
will be labeled “Continuous (x/n)” 

(meaning strip number x out of a total 
of n strips in the series).

To save multiple strips, all with the 
same label, click on a beat at the center 
of the ECG to be saved, then hold the 
Shift key down and click on another 
beat. Then click Keep. In the Keep 
window, click the button labeled “n 
strips” to save all the selected exam-
ples; click the button labeled “1 strip” 
to save just the first. All strips will 
have the label in the Description field; 
change it when appropriate. Because 
the strips are likely to have different 
heart rates, no heart rate fields are pre-
sented.

If you decide to close the Keep win-
dow without saving any strips, click 
Cancel.

Keep window with OK button

Keep window with time button

Keep window with multiple strip button
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Measuring in Expanded Page
The two blue vertical calipers that 
appear in the Expanded strip in Page 
can be used to make a variety of mea-
surements. To measure, drag the cali-
pers to specific locations on the ECG; 
or click on the ECG to move the closer 
caliper to that location. To move both 
calipers while keeping them the same 
distance apart, click on the Both check 
box in the center toolbar and then drag 
or click them to a new position; click 
the Both check box again to move each 
caliper separately.

To measure the heart rate on the strip, 
place the calipers two RR intervals 
apart; the heart rate appears in the HR 
(2 RR) field. To measure an RR or a 
PR interval, place the left caliper at the 
start of the interval and the right caliper 
at the end of the interval; the time 
between them appears in the Time 
field. 

To keep the calipers in the same loca-
tions as you move through different 
screens of ECG, click the check box 

next to Lock; the calipers will stay in 
the indicated locations unless you 
move them again. Click again to turn 
off.

To make ST measurements, place the 
left caliper in the isoelectric portion of 
the PR interval, and place the right cal-
iper where you want the ST segment 
measurement to be made; the vertical 
distance between where the left caliper 
intersects the ECG and where the right 
caliper intersects the ECG will appear 
in the ST field for each channel 
(labeled ST 1, 2, 3).

Note: All Review windows are linked 
by time-of-day. In addition, the Page 
window is linked to all other Review 
windows through the right-hand 
button on the mouse. From any other 
Review window, a right-click will 
jump to the Page display, retaining 
the current beat. After that, a right-
click in Page will then take you back 
to where you originally were, 
regardless of whether you change the 
current beat in the Page window.
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Reviewing the Trends window

oxes
Reviewing the Trends 
window
Open the Trends window by clicking 
on Trends in the Review toolbar or by 
selecting Review > Trends in the pri-
mary Holter toolbar. The display 
includes the arrhythmia trend graphs of 
information from the recording; select 
ST level from the Type menu to display 
ST and optional Oximetry trends.

Arrhythmia Trends
The arrhythmia trends present data 
in one-minute increments throughout 
the Holter period, including the RR 
trend showing the range of RR interval 
measurements; the heart rate trend 
showing the average heart rate; total 
VPB and VTAC trends; and total 
SVPB and SVT trends.

On all of the trends, time-of-day 
appears on the horizontal axis. RR 
intervals are plotted so that the range 
within each minute appears as a verti-
cal line; the top end of the line indi-
cates the longest RR interval within 
that minute, and the bottom of the line 
indicates the shortest RR interval 
within it.

ST Trends
The ST trends present the ST segment 
analysis data in 30-second increments 
throughout the Holtered period for all 
three channels of data. The placement 
of the ST calipers is automatic unless 
you re-set them in the Calibration win-
dow. See the section “ST segment anal-
ysis” in the previous chapter for more 
detailed information about ST segment 
analysis.

The ST trends include three compo-
nents for each channel: (1) the patient’s 
baseline ST measurement, that is, the 
patient’s normal ST; (2) the actual mea-
surement made for each 30-second 
increment; and (3) the slope indicator 
for each 30-second indicator. The base-
line measurement is trended as a blue 
line, the actual measurement is green, 
and the slope indicator is a vertical red 
line drawn from the actual measure-
ment to the measured value at the slope 
caliper.

For oximetry patients, the channel 3 
area of the ST trends contains oximetry 
data, including (1) a color-coded trend 
line (colored the same as the beat 
labels) of SpO2 data on a scale from 60 
to 100 percent saturation and (2) a 
white trend showing pulse oximetry 
data.

The blue marker
The blue vertical marker is located at 
the time-of-day of a particular 30-sec-

RR trend with min and max indicated

ST segment and slope measurement data b
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ond segment. Click on either trend to 
move the marker to a different time-of-
day. The time-of-day that appears in 
the large data box indicates the time-
of-day at the marker. The data boxes at 
the top of the display indicate the data 
collected for the minute where the 
marker is located, including heart rate 
(HR), the shortest RR interval (RR 
Min), the longest RR interval (Max), 
the total number of VPBs and SVPBs, 
and the total number of VPBs and 
SVPBs that occurred during runs of 
VTAC and SVT. In addition, the ST 
data boxes include data collected for 
the 30-second interval where the 
marker is located, including the ST 
segment measurement for each channel 
in ST 1, 2 and 3, and the ST slope mea-
surement for each channel in Slope 1, 2 
and 3. 

The oximetry data appear with the 
measured heart rate in the SpO2 HR 
field, the minimum SpO2 measurement 
in the Min field, and the maximum 
SpO2 measurement in the Max field.

Asterisks indicate that there is no data 
for that time period, usually because of 
artifact.

Relabeling to artifact
If entire periods are contaminated by 
artifact or if the electrodes were 
removed early (which generates lots of 
high frequency noise without ECG at 
the end of the Holter data), you can 
relabel continuous periods of data arti-
fact. 

In the Trends window, to relabel a con-
tinuous period as artifact, click at the 
time-of-day you want to start rejecting 
and then drag until the end time. The 
time period turns magenta. Now click 
the Artifact button. A message will 
appear asking whether you mean to 
relabel the period as artifact. Click Yes 
to do so. All of the data within that 
time period is now called artifact, col-
ored light blue, and not included in any 
of the totals.

To cancel the relabel, click No when 
the confirmation window appears.

Oximetry buttons
For patients with oximetry data, the 
Desat(uration) On and Off buttons 
appear. This allows you to manually 
identify desaturation events that were 
not identified automatically. To create a 
new desaturation event, drag across the 
Trend window from the beginning of 
the event to the end. The trend is high-
lighted in magenta. Press Desat On to 
identify that period as a desaturation 
event; the event is automatically 
entered in the Desaturation table in the 
Tables window. 

You can undo the change in the Trends 
window by dragging to select it again 
and then pressing Desat Off.

Desaturation On, Off buttons
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Shorten analysis time
If the Holter period ends prematurely, 
you can either throw out the informa-
tion as artifact, as described in the sec-
tion above or you can shorten the 
analysis time.

To shorten the analysis time, in the 
Trends window, click to move the 
marker to the time-of-day at which you 
would like to end analysis, then select 
Review > Shorten analysis time. When 
the window opens to confirm the com-
mand, click Yes to re-analyze the data, 
stopping at the time indicated. To close 
without re-analyzing, click No.

Disabling SVPB counts
If the patient is in intermittent atrial 
fibrillation and you want to turn off 
SVPB counting for certain periods of 
time, click at the time-of-day at the 
start of a period and drag the marker to 
the end of the period. The time period 
turns magenta. Now click the SVPB 
Disable button. No SVPBs will be 
counted during that time period. You 
can create multiple periods like that, if 
necessary. If you later change your 
mind and want to count SVPBs during 
any of the time periods, repeat the pro-
cess, but click on the Enable button 
instead.

Amount of time displayed
You can expand the trends by decreas-
ing the amount of time displayed 
across a single page. To change the 

amount of time displayed, click on the 
arrow in the Hours field and select the 
number of hours you want displayed 
per page. 

When Hours is set to less than 24 for a 
24-hour recording, there are multiple 
pages of data. To move from one page 
of data to the next, use either the 
PageUp and PageDown keys on your 
keyboard, or the scroll bar.

Reviewing Tables
Tables to be included in the final report 
include interval tables of general, ven-
tricular, supraventricular, ventricular 
runs, supraventricular runs, pacemaker 
data, bigeminy, oximetry, and tachycar-
dia and bradycardia data, along with a 
table listing episodes of significant ST 
segment change. Oximetry tables 
appear for only those patients with 
oximetry data. 

To review the tables compiled for a 
patient, click Tables in the Review 
toolbar. The listing of what tables are 
available appears at the right of the 
screen. The displayed table is high-
lighted in blue. To display a different 
table instead, click on its name in the 
list.

The tables and their fields include:

• General - This is an interval table 
that lists the time-of-day at the start 
of the interval; the low, mean and 
high heart rate calculated during the 
interval (see appendix A for details 
of heart rate calculations); the total 
number of beats identified and 

Enable/Disable SVPB buttons
o Holter LX Pro                             57



Review Methods

58
counted in the interval (this excludes 
periods of artifact); the amount of 
time analyzed (this also excludes 
artifact); the total number of SVPBs; 
the total number of VPBs; the 
number of pauses; and a field for 
manually-entered rhythm comments.

• Supraventricular - This is an 
interval table that lists the time-of-
day at the start of the interval; the 
total number of beats identified and 
counted in the interval (this excludes 
periods of artifact); the amount of 
time analyzed (this also excludes 
artifact); the total number of SVPBs 
counted; the number of single 
SVPBs; the number of SVPB pairs; 
the number of runs of SVT; the 
number of SVPBs that occurred in 
runs; and the number of aberrant 
SVPBs.

• Ventricular - This is an interval 
table that lists the time-of-day at the 
start of the interval; the total number 
of beats identified and counted in the 
interval (this excludes periods of 
artifact); the amount of time 
analyzed (this also excludes 
artifact); the total number of VPBs 
counted; the number of early VPBs, 
that is, single VPBs that occurred at 
least as early as the VPB Pre setting 
in Scanning Criteria; the number of 
single VPBs, that is, those that did 
not qualify as early VPBs; the 
number of VPB pairs; the number of 
runs of VTAC; the number of VPBs 
that occurred in runs; and the 
number of R on Ts (see Appendix A 
for this definition).

• ST event - This table lists the ST 
segment events that were detected 
during the Holter test. Data in this 
table includes the channel in which 
the event was detected; the time-of-
day at the start of the event; the 

time-of-day at the end of the event; 
the duration of  the event; the 
maximum heart rate calculated 
during the event; the time-of-day at 
the event’s maximum deviation from 
the patient’s baseline; the heart rate 
during the event’s maximum 
deviation from the patient’s baseline; 
the ST segment measurement’s 
deviation from the patient’s baseline; 
the ST segment measurement’s 
deviation from iso-electric; the slope 
of the ST segment event at the point 
of maximum deviation; and the 
integral of the event.

Note: Details of ST segment analysis 
and labels are provided in the “ST 
segment analysis” section of the 
previous chapter. 

• Supraventricular runs - This is an 
interval table that lists the time-of-
day at the start of the interval; then 
the number of 3-beat, 4-beat, 5-beat, 
6-to-9-beat, and 10+-beat  SVPB 
runs that occurred at a rate less than 
the SVT heart rate setting in 
Scanning Criteria; then the number 
of 3-beat, 4-beat, 5-beat, 6-to-9-beat, 
and 10+-beat SVPB runs that 
occurred at a rate equal to or more 
than the SVT heart rate setting in 
Scanning Criteria.

• Ventricular runs - This is an 
interval table that lists the time-of-
day at the start of the interval; then 
the number of 3-beat, 4-beat, 5-beat, 
6-to-9-beat, and 10+-beat  VPB runs 
that occurred at a rate less than the 
VTAC heart rate setting in Scanning 
Criteria; then the number of 3-beat, 
4-beat, 5-beat, 6-to-9-beat, and 10+-
beat VPB runs that occurred at a rate 
equal to or more than the VTAC 
heart rate setting in Scanning 
Criteria.
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• Bigeminy - This is an interval table 
that lists the time-of-day at the start 
of the interval; the total number of 
beats identified and counted in the 
interval (this excludes periods of 
artifact); the amount of time 
analyzed (this also excludes 
artifact); the total number of VPBs 
that occurred in bigeminy; the 
number of 3-VPB episodes of 
bigeminy; the number of episodes of 
bigeminy that included 4 through 9 
VPBs; the number of episodes of 
bigeminy that included 10 through 
24 VPBs; and the number of 
episodes of bigeminy that included 
25 or more VPBs.

• Tachy/Brady - This is an interval 
table that lists the time-of-day at the 
start of the interval; the total number 
of beats identified and counted in the 
interval (this excludes periods of 
artifact); the amount of time 
analyzed (this also excludes 
artifact); the number of beats of 
bradycardia that occurred as defined 
by the Bradycardia setting in 
Scanning Criteria; the amount of 
time spent in bradycardia; the 
number of beats of tachycardia that 
occurred as defined by the Tachy-
cardia setting in Scanning Criteria; 
and the amount of time spent in 
tachycardia.

• Paced - This is an interval table that 
lists the time-of-day at the start of 
the interval; the total number of 
beats identified and counted in the 
interval (this excludes periods of 
artifact); the amount of time 
analyzed (this also excludes 
artifact); the total number of beats 
counted as paced; the number that 
were atrial-paced only; the number 
that were ventricular-paced only; the 

number that were paced in both 
chambers; the number of sense 
failures; the number of capture 
failures; the number of occurrences 
of inappropriate inhibition; and the 
percentage of paced beats.

Note: Details of the pacemaker 
analysis and labels are provided  in 
the “Pacemaker analysis” section of 
the previous chapter.

• Oximetry (optional) - Oximetry 
data is reported in four tables:

1. SpO2/HR summary - This includes 
the Minimum, Mean and Maximum 
values of SpO2 and heart rate for the 
patient.

2. SpO2 summary - This provides an 
overview of the amount of time 
(hours, minutes, and seconds; and 
percentage) the patient spent in vari-
ous saturation ranges.

3. Heart Rate summary - This pro-
vides an overview of the amount of 
time (hours, minutes, and seconds; 
and percentage) the patient spent in 
various heart rate ranges.

4. Desaturation - This table lists the 
start and end times and total dura-
tion of any desaturation events iden-
tified by the software (based on 
settings in Settings > Oximetry) or 
manually identified in the Trends 
window.

Editing table entries
To edit information that appears in the 
tables, you can either use the Edit or 
the Zero button. In the interval tables 
(all but the ST event and Oximetry 
tables), the Edit button opens the Inter-
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val Table Edit window that allows you 
to change information within the data 
fields for a particular interval. To use 
the Edit button, first click on a particu-
lar interval in a table to highlight it, 
then click Edit.

Within the Interval Table Edit window, 
you can click in any data field to type 
in your changes. Highlight an existing 
entry and type over it, or click to the 
right of the entry and backspace to 
eliminate it and then type your entry.

Editable fields appear with data against 
a white background. Fields that you 
cannot edit have a blue background. 
Those fields include the time-of-day of 
the start of the interval, the time ana-
lyzed, the total number of beats, total 
paced beats, total VPB count, total 
VTAC runs, total VTAC beats, total 
SVPB count, total SVT runs, total SVT 

beats, and the 
VTAC and SVT 
heart rates. The 
total beat counts 
are not editable 
because they are 
calculated from 
other field data 
present in the 
table; as you 
make changes to 
the other fields, 
the total counts 
change appro-
priately.

To save your 
changes and exit, click OK. To exit 
without saving changes, click Cancel.

Note: Be sure to make any changes to 
the tables carefully. Incorrect infor-
mation entered in this window can 
cause inconsistencies in the printed 
report.

To completely eliminate all informa-
tion within an interval, use the Zero 
button, which opens the Interval Table 
Zero window. In that window, each 
data field has an associated check box 
that determines whether to include or 
exclude the data for that field in the 
tables. To exclude data for a particular 
field, click on the check box so that a 
check mark appears, indicating that the 
field will contain a zero in all interval 
tables. Click again to remove the check 
mark. 

Interval Table Edit window
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Click on as many data fields as you 
want zeroed out in the interval tables, 
then click OK to exit. Click Cancel to 
exit without saving any changes.

Select/deselect all buttons are available 
for each section. Use them to turn on or 
off all data fields within each specified 
section - general information, ventricu-
lar, or supraventricular.

Printing tables
To print a displayed table, click Print to 
open the Print window, then click OK 
to print. Click Cancel to close the win-
dow without printing.

Closing the Tables window
Click the OK button to close the Tables 
window.
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Additional features

Superimposition
Holter LX Pro soft-
ware allows you to 
review the patient’s 
ECG in superimpo-
sition mode. In 
superimposition, 
each beat is 
quickly superim-
posed upon the 
preceding one in a 
continuous stream, 
which allows you 
to easily identify 
rhythm changes. 
Normal beats, 
VPBs and artifact 
are superimposed 
in separate loca-
tions in the Super-
imposition window 
so that you can also 
verify beat identifi-
cation.

To open the Superimposition window, 
select Superimposition from the drop-
down Review menu. Click on Scan to 
start and stop the superimposition dis-
play. 

In the display, channel 1 appears on 
top, channel 2 in the middle, and chan-
nel 3 at the bottom. (The channel 3 area 
is empty if there is oximetry data for 
this patient.) Beats that match normal 
and paced templates are superimposed 
at the left side of the window, while 
beats that match ventricular templates 
appear in the center, and signal that is 

considered artifact appears to the right 
of the window.

Control the speed of the scan by repeat-
edly pressing + to make it faster and - 
to slow it down.

Calibration
Although 
the 
DR180+ 
and 
SD360 
Digital 
Record-
ers save 
the patient’s Holter signal at standard 
calibration, you can display the calibra-
tion signal at the start of the recording 
and adjust the height. 

To open the Calibration window, select 
Calibration from the drop-down 
Review menu. Three channels of cali-
bration signal are displayed. The two 
horizontal lines for each channel 
should be lined up so that one is level 
with the top of the square wave and one 
is level with baseline. Drag the lines to 
move them. 

When finished, click on Done to save 
the new positions. A Confirm window 
will appear, asking you whether you 
really want to re-analyze using the new 

Superimposition 

Calibration signal with markers

Confirm window after changes in Calibration
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marker positions. Click on Yes to con-
tinue, and click on No to retain the pre-
vious marker locations.

Note: Whenever you make changes 
in the Calibration window, the signal 
must be re-analyzed when you exit. If 
you choose to not re-analyze, the 
changes are not saved.

To close the Calibration window with-
out saving new marker locations, click 
Cancel.

In addition, you can use the Calibration 
window to increase the size of a very 
low-voltage ECG signal or decrease 
the size of a very high-voltage signal, if 
the size causes problems during analy-
sis. To increase the size of the signal 
for analysis, set the horizontal gain 
markers close together. To decrease the 
size of the signal for analysis, set the 
horizontal gain markers far apart.

Note: If you use the gain markers in 
this way, the signal is no longer 
calibrated and no ST measurements 
are correct.

ST Markers
The Calibration window is also used to 
access and adjust the ST markers used 
during ST segment analysis.

Details of adjusting the markers and all 
other aspects of  ST segment analysis 
are provided in the “ST segment analy-
sis” section of the previous chapter.

Update
If an Update button appears in your 
Review toolbar, the Automatically 
Update feature is turned off in the Pref-
erences window. That means that after 
some editing changes, you must click 
the Update button to incorporate your 
changes. After you make changes that 
require an update, the Update button 
will blink red as a reminder that you 
must at some point click it.

Updates, which are required whenever 
you change the label of a beat, go back 
through the Holter data incorporating 
all new labels and correcting tables, 
counts, critical events, saved strips, and 
strip labels appropriately. 

You can also choose to update the soft-
ware using the Update item in the 
Review menu.
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5  12-LEAD 
PRESENTATIONS 

The LX Holter Pro software enables you to review and edit 12-lead information recorded on the 
NorthEast Monitoring DR180+ Digital Recorder using one of the 12-lead recording modes. The 
12-lead data and 6-by-2 presentations can then be included in the final Holter report or printed 
separately. (The 12-lead feature is not available on the SD360 Digital Recorder.) 
Guide to H
Recording 12-lead data
To review the 12-lead data collected during a patient’s Holter test, the 
recording mode of the DR180+ must be set to one of the 12-lead settings 
when the patient is hooked up. The settings include:

• “3 ch hi res 12L 1/3 min” means that the recording will be three-chan-
nel Holter in high resolution, with one sample of 12-lead data saved 
every three minutes. 

• “3 ch norm res 12L 1/3 min” means that the recording will be three-
channel Holter in normal resolution, with one sample of 12-lead data 
saved every three minutes.

• “3 ch norm res 12L 1/min” means that the recording will be three-
channel Holter in normal resolution, with one sample of 12-lead data 
saved every minute.

• “3 ch norm 12L 2/min” means that the recording will be three-channel 
Holter in normal resolution, with one sample of 12-lead data saved 
every 30 seconds.

• “3 ch norm 12L 1/18 sec” means that the recording will be three-chan-
nel Holter in normal resolution, with one sample of 12-lead data saved 
every 18 seconds.

• “12L continuous” means that the recording will save continuous 12-
lead data throughout the monitoring period. This setting is for research 
purposes only. See the DR180+ Operator’s Manual for details about 
using continuous 12-lead data.

Note: The DR180+ records 12-lead data with a sampling rate of 720 samples/
second for slightly more than 3 seconds per strip, except when the recorder is 
set to special research modes.
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Rad
Reviewing 12-lead data
If 12-lead data is present on the com-
pact flashcard along with a patient’s 
Holter data, the Holter LX Pro software 
activates the 12 Lead menu item in the 
Review toolbar. If the 12 Lead item is 
dim, it means that the patient’s Holter 
recording did not include 12-lead data.

LX Pro allows you to review the 12-
lead data on-screen in three different 
ways - ST Graphs, Strips, and Trends. 
These three options are listed in the 12 
Lead menu in the Review toolbar.

12-lead strips
The 12-lead data recorded on the 
DR180+ is displayed in 12 strips per 
sample. They are from leads I, II, III, 
aVR, aVL, aVF, and V1 through V6. In 
the Strips window, you can choose to 
display them three leads at a time by 
clicking the Single button or 12 leads at 
a time by clicking the Multiple button. 

Note: In the 12 Lead Strips window, the 
Single button appears only in the 
Multiple display and the Multiple 
button appears only in the three-lead 
display.

In addition to the ECG, the strips 
appear with either P, Q, R, S and T 
markers or ST markers (iso-electric, 
j-point and S), depending on which 
radio button is selected. Click on the 
radio button to the left of your choice 
to change the display.

Sorting of strips
Strips within the 12 Lead Strips win-
dow can be sorted by time-of-day in 
the order they were saved or by the ST 
segment elevation or depression mea-
surement in a particular lead. Make a 
selection from the Sort field to change 
the order of the strips.

Marker (Caliper) locations
For each beat in each lead, the software 
determines the approximate positions 
of the P (onset of p-wave), Q (onset of 
QRS complex), R (maximum ampli-
tude of QRS complex), S (end of QRS 
complex), and T (end of T-wave) cali-
pers, along with the R caliper for the 
following beat. It also determines the 
approximate positions of the iso-elec-
tric, j-point and ST segment calipers. In 
addition, it averages each caliper’s 
location across all 12 leads for each 
individual beat. It is up to you to deter-
mine whether those positions are accu-
rate for each beat, and reposition them, 
if necessary.
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Reviewing 12-lead data
The QRS and ST markers displayed in 
the 12 Lead Strips can be located either 
at the particular location determined for 
that individual lead at that time or at the 
average location across the 12 leads at 
that time. This is determined by 
whether the Actual or Average radio 
button, respectively, is clicked on. 
Click on the button to the left of your 
choice to change the display.

Each lead displayed has data associated 
with it based on the locations of the 
various calipers. With the QRS markers 
displayed, the data include:

• RR interval - from the R marker on 
the current beat to the R marker on 
the next beat,

• QRS duration - from the Q marker 
to the S marker of the current beat, 

• PR interval - from the P marker to 
the Q marker, and

• QT/C (a corrected QT interval) - 
from the Q marker to the T marker 
(at the end of the T-wave).

With the ST calipers displayed, the data 
include:

• J-ST interval - from the J marker to 
the S marker and

• ST segment measurement - the 
vertical distance between where the 
I marker intersects the ECG and 
where the S marker intersects the 
ECG.

The data displayed are dependent on 
the current positions of the calipers; if 
you move the calipers, the data change. 

The “average” data uses all good leads 
combined (there must be at least 5 good 
leads). To determine the combined 
“average” data, the software uses the 
earliest P caliper, the earliest Q caliper, 
an average of all R calipers, the latest S 
caliper, and the latest T caliper. For the 
ST calipers, the average positions of 
the I and J calipers are used, and the S 
caliper is a fixed offset from the aver-
age J.

Moving the calipers
Any of the calipers can be moved to 
alternate locations from within the 
three-channel display. To do so, if you 
have Multiple strips displayed, click 
the Single button. 

Within that display, determine whether 
you want to reset calipers for an indi-
vidual lead or all 12. To move a caliper 
for an individual lead, click on the 
radio button next to Actual and then 
move the calipers appropriately. To 
move a caliper for all leads, click on 
the radio button next to Average and 
then move the calipers appropriately; 
note that the calipers in all three dis-
played channels move accordingly.

In addition, as you move calipers, the 
data fields update using the new posi-
tion of the calipers. When you exit 
from the display or move to another 
strip, a confirmation window appears to 
ensure you mean to keep the change. 

Actual, Average radio buttons
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To keep the new caliper locations, click 
Yes. To close the window without sav-
ing the new positions, click No.

You can also save caliper locations 
using the Keep Cal button. To do so, 
display Multiple strips and page to a 
strip with the calipers located properly 
(or move the markers in the Single dis-
play, then click Multiple to activate the 
Keep Cal button), then click Keep Cal. 
The current locations of the calipers 
will be used.

Changing gain
To change the amplitude of the dis-
played signal, select from the choices 
in the Gain field.

Changing the leads displayed
In the three-channel display, you can 
choose to display leads I, II, and III; 
aVR, aVL, and aVF; V1, V2, and V3; 
or V4, V5, and V6. To switch from one 
group to another, click on the appropri-
ate radio button at the right end of the 
toolbar.

Scanning
To automatically display one strip after 
another, click on Scan. Click again to 
stop the display. You can also move 
through the strips using the PageUp 
and PageDown keys.

Displaying a grid
Click on the check box to the left of 
“Grid” to display a background grid or 
to turn it off.

Adding/Deleting strips for the report
To add a particular strip to the printed 
report in a 6-by-2 presentation, display 
the strip and then click the Add/Del 
button. The Add/Del window opens. 
Click on the Description field, then 
click on the arrow to the right of the 
field to display a list of choices; click 
on a choice to select it. Or select the 
NEW text and type the text you want to 
appear with this 12-lead data in the 
printed report, in the 12 Lead Strips 
modules. Click Done to save the text 
and the strips for the report. Click Can-
cel to close the window without saving 
the strips.

Confirming new caliper locations

Radio buttons to select displayed leads

Add/Del window in 12 Lead Strips window
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Reviewing 12-lead data
Changing a strip’s heart rate
The heart rate associated with a partic-
ular 12-lead strip is based on a single 
RR interval in the strip. If ectopy 
occurs at either end of the RR interval, 
the heart rate displayed may not be rep-
resentative of the underlying heart rate. 
To change the heart rate associated 
with a strip, first use the R and R1 cali-
pers to determine a better heart rate (it 
is shown in the HR field above the 
strip, based on the calipers being one 
RR interval apart), then click the HR 
button. The Edit 12-lead heart rate win-

dow opens. This displays another 
possible heart rate - that based on two 
measured RR intervals. To use that as 
the strip’s heart rate, click the button at 
the left of the window. To use a differ-
ent heart rate, click on the Heart rate 
field and type the new heart rate, then 
click OK. Then click the Add/Del but-
ton to save the strip for the printed 
report (as described in the previous 
section).

To close the Edit 12-lead heart rate 
window without changing the heart 
rate, click Cancel.

Including/Excluding strips
If you determine that you would like to 
exclude a particular strip from the 12-
lead data (perhaps because of artifact), 

first display the strip, then click on the 
Exclude button. The ECG turns 
magenta and the strip is now excluded. 
In addition, the Exclude button 
changes to Include. To retrieve an 
excluded strip, click Include; the ECG 
turns green and the strip is now 
included in measurements, calculations 
and displays.

Comparing to a reference strip
If you would like to compare other 
strips to one particularly clean and typ-
ical strip as a reference, you can. To do 
so, display the strip to be used as a ref-
erence, then click the Reference button. 
As you page through other strips using 
PageDown and PageUp, the reference 
strip appears in red in the background 
of the other strips, which makes 
changes from the reference strip very 
noticeable.

Click Reference again to eliminate the 
red reference strip from the back-
ground.

12-lead ST graphs
LX Pro software generates three-
dimensional graphs of ST segment 
data. On one axis are the 12 leads; on 
another is time-of-day; and on the third 
is ST segment measurement. The data 
is color-coded so that relatively normal 
ST measurements appear in green, ST 
depression appears in blue and ST ele-
vation appears in red.

To display the graphs, select ST Graphs 
from the 12 Lead menu. The graph dis-

Edit 12-lead HR window
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plays with as many hours displayed as 
indicated in the Hours field. To display 
a different amount of time, make a 
selection from the list in the Hours 
field.

To review all 24 hours of data, click on 
the down arrow associated with the 
scroll bar to jump forward in time; 
click on the up arrow to jump back in 
time. The PageUp and PageDown keys 
change the size of the graph, zooming 
in and out, respectively.

To use the graph, click on a particular 
area that looks interesting; the data 
fields to the right of “ST Graph” will 
change to reflect the data for all 12 
leads at that particular time-of-day. 
Then right-click to display the 12-lead 
strips from that time-of-day.

To modify the axes on the graph, click 
on the arrow to the right of Elevation. 
Select Depression to automatically 
reset all three axes - x, y and z. To 
arrange the three axes as you want, 
select Custom and then type in new 
values in the X, Y and Z-axis fields. 
After changing the entries in the fields, 
click the Run button to incorporate 
your changes.

You can rotate the graph, if you choose 
to. To do so, click on the check box 
associated with the x-, y- or z-axis so 
that a check mark appears and then 
type the number of degrees you want 
that axis to rotate; you can rotate on all 
axes if you choose. Once the fields are 
set, click the Rotate button. The graph 
will reappear with each axis rotated as 

you indicated. Click Rotate again to 
repeat the process.

To change to a standard scale on the 
graph, click on the arrow to the right of 
Auto and make your selection, either 
choosing 1x to go to the standard scale, 
.5x to halve the scale, or 2x to double 
the scale. To return to the original 
graph, select Auto.

12-lead trends
The Trends selection from the 12 Lead 
menu includes two types of trends - 
one with beat measurement data and 
one with ST data. Which one is deter-
mined by the setting in the Type field.

Both types of trends have an Hours 
field that allows you to change the 
amount of time displayed across the 
screen. Click on the arrow at the right 
of the field and select your choice from 
the list.

In addition, you can include or exclude 
12-lead strips from either trend win-
dow. Locate the marker on a particular 
minute. If the data from that time-of-
day is included in the trend data, an 
Exclude button appears in the toolbar. 
To exclude the strip from that time-of-
day, click Exclude. If a strip is already 
excluded, the message “Strip automati-
cally excluded” appears, along with an 
Include button. To include the strip, 
click Include.

Rotate button, associated x-, y- and z-axis fields
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Printing 12-lead data and strips
Beat measurements
This window includes the following 
trends of the average data for all 12 
leads for a particular beat:

• HR trend of minute-by-minute heart 
rates; 

• QTC trend indicating the QTC 
associated with the 12-lead strip at 
each sampled time-of-day. QTC 
stands for a corrected QT interval 
using the Bazett formula of QTC = 
QT/sq rt(RR);

• PR trend showing the measured PR 
interval for the 12-lead strip at each 
sampled time-of-day;

• QRS trend indicating the width of 
the QRS complex for the 12-lead 
strip at each sampled time-of-day; 
and

• QTD trend showing the QT disper-
sion for each sampled time-of-day, 
using the formula QTD = (longest 
QT in any lead) - (shortest QT in 
any lead).

Above the trends are data fields that 
display the exact measurements at the 
time-of-day where the blue marker is 
located. Asterisks in a field indicate 
that the data was considered to be arti-
fact and was not used.

To move to the strips from the time-of-
day where the marker is located, right-
click the mouse.

ST level
The ST trends in 12-lead show trends 
from all 12 leads at one time. The 

information plotted is the ST segment 
measurement made on a particular lead 
for each 12-lead strip. Specific data for 
the strip at the time-of-day where the 
marker is located show up for each lead 
to the right of the lead name.

Printing 12-lead data 
and strips
The LX Pro software includes these 
four 12-lead modules that can be 
included in the printed report:

• 12-lead Trend Graphs 
• 12-lead Tables (25 pages)
• 12-lead Strips (25 mm/sec)
• 12-lead Strips (50 mm/sec)

To include a module in the printed 
report, click on the check box next to it. 
A check mark indicates that the module 
will be included in the report. No check 
mark indicates that it will not be 
included in the report. To print the 12-
lead data without a Holter report, leave 
the Holter modules not checked and 

12-lead ST level trend
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check just those 12-lead modules you 
want to include.

12-lead Trend Graphs
This is a group of 24-hour trends called 
“12 Lead Data Graph” that plot:

• QTd, which is the QT dispersion, 
the difference between the longest 
QT interval and the shortest QT 
interval for a particular point in 
time;

• QTc, which is a corrected QT inter-
val using the Bazett formula, where 
QTc=QT/sq rt(RR);

• QT, the QT interval;
• PR, the PR interval;
• QRS, the width of the QRS com-

plex; and
• RR, the RR interval following the 

measured beat.

12-lead Tables (25 pages)
This module prints out 12-lead data for 
all the samples taken during the Holter 
period, which can take up to 25 pages 
depending on how often 12-lead sam-
ples were recorded and how long the 
recording lasted.

The table includes time-of-day, RR 
interval following the beat, QT inter-
val, QTC and QTD (as defined above).

12-lead Strips 25 mm/sec
This module prints a 6-by-2 presenta-
tion of each 12-lead strip added in the 
12 Lead Strip display. See section 

“Adding/Deleting strips for the report” 
earlier in this chapter for details about 
adding strips.

All leads for the strip are printed on a 
single page, along with the actual data 
measured for each separate lead for 
RR, QRS, PR, QT, QTc, and ST in a 
data box to the left of the signal.

The data box at the top of the page 
indicates the “average” measurements 
for all 12 leads combined for that par-
ticular beat, along with QTd and heart 
rate. A minimum of 5 good caliper 
locations are required to come up with 
an “average” position. The average 
measurements include:

• RR - This is the time between the 
average position of one R caliper to 
the average position of the next.

• QRS - This is the time between the 
earliest Q caliper and the latest S 
caliper.

• PR - This is the time between the 
earliest P caliper and the average R 
caliper.

• QT - This is the time between the 
earliest Q caliper and the latest T 
caliper.

• QTc - This is a corrected QT inter-
val from the earliest Q marker to the 
latest T marker.

• QTd - This is the QT dispersion, 
which is the difference between the 
longest QT interval and the shortest 
QT interval.

• Heart Rate - This is either the heart 
rate based on the average RR 
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Printing 12-lead data and strips
described above or a heart rate that 
was manually entered using the HR 
button in 12 Lead > Strips.

12-lead Strips 50 mm/sec
This module prints a 6-by-2 presenta-
tion of each 12-lead strip added in the 
12 Lead Strip display, expanded hori-
zontally, along with ST data for each 
channel. See section “Adding/Deleting 
strips for the report” earlier in this 
chapter for details about adding strips.

The data box above each presentation 
indicates the “average” measurements 
described in the previous section, “12-
lead Strips 25 mm/sec.”
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6  HRV ANALYSIS 
Heart Rate Variability (HRV) software allows you to review information about a patient’s normal-
to-normal RR interval data in a wide variety of ways, including Lorenz, 3-dimensional, circadian 
and time-domain plots. In addition, HRV information is reported in tabular formats of both time 
and frequency domain. Tables include calculations standard for HRV analysis, including SDNN, 
SDSD, RMSSD, NN50 count, pNN50, and a variety of indices - HRV triangular, differential and 
logarithmic.
Guide to Holter
HRV Analysis
To perform HRV analysis, the software considers only normal-to-
normal RR intervals and performs the analysis based on the settings 
available in Settings > Spectral Analysis.

Spectral Analysis settings
The following settings are available in the Spectral Analysis win-
dow:

• Run spectral analysis after analysis completes. This setting 
determines 
whether HRV 
analysis will be 
done automati-
cally at the end 
of Holter analy-
sis. A check 
mark in the 
check box indi-
cates that the 
HRV program 
will run auto-
matically upon 
completion of 
Holter analysis. 
No check mark 
indicates that 

Spectral Analysis window
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HRV analysis will not be performed 
automatically. If the HRV analysis 
has not been done and you ask to 
review HRV data, the software will 
ask whether you want to run it at 
that time.

• Window type. This field indicates 
what type of sliding window is used 
for HRV analysis and what type of 
window to use. The choices are 
None (simple sliding window), 
Hamming 1, Hamming 2, and Trian-
gle. Click on the arrow in the field to 
list the choices and click on your 
selection.

• Size (secs.). This setting determines 
whether the sliding window is 100 
or 300 seconds long. Click on the 
arrow in the field to list the choices 
and click on your selection. A set-
ting of 100 limits the minimum fre-
quency to 0.01 Hz., while 300 limits 
the minimum frequency to 0.0033.

• Take average of logs. As HRV 
analysis is done, you can choose to 
have the magnitude of spectral val-
ues first converted to a log form 
before averaging. A check mark in 
the check box indicates that the data 
will be converted; no check mark 
indicates that the average is per-
formed on the magnitude of the 
spectral values directly and the log, 
if any, is taken after the average.

• Number of seconds over which the 
spectral average is made. The 
average of the spectrum is a two-

dimensional calculation made using 
a sliding window. The window is the 
“Size” described above; it moves 
“Spacing between averages” 
described below between each spec-
trum calculation. This setting is the 
total number of seconds the window 
must move to calculate one point in 
the result. The range allowed is from 
0 to 3600. Click on the field and 
type your entry to change the set-
ting.

• Frequency range used for aver-
age. The average is made over this 
range of frequencies. Click on the 
field and type your entry to change 
the setting.

• Spacing (secs.) between spectrums 
for average calculations.  The 
number of seconds the window is 
moved for each spectrum calcula-
tion used to calculate the average 
spectrum. When this is set to the 
typical value of 10 seconds and the 
average is set to 300 seconds, then 
30 spectrums are calculated for each 
value in the resulting average spec-
trum. Click on the arrow in the field 
to list the choices.

• Minimum percentage of an inter-
val that is valid. At least this per-
centage of beats within an interval 
must be used for the interval to be 
included. Too much artifact or 
ectopy within an interval will pre-
vent it from being included. Click 
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enu bar
on the field and type your entry to 
change the setting.

• Lower/upper limits for differen-
tial index measurements. The dif-
ferential index measurement is 
defined as the difference between 
the widths of the histogram of dif-
ferences between adjacent RR inter-
vals measured as selected heights. 
the upper and lower limits are the 
selected heights for this measure-
ment. Click on each field and type 
your entry to change the settings.

• Extrapolate. This field determines 
what happens to the calculations 
when an ectopic beat occurs. The 
Restart setting indicates that the cal-
culation ends there and starts again 
on the next normal-to-normal RR 
interval. The Interpolation setting 
indicates that the RR intervals on 
either side of the ectopic will be 
merged and the location of a normal 
beat interpolated from the surround-
ing RR intervals.

• Beginning/End of frequency 
ranges. Each of the frequency 
ranges indicated are used to calcu-
late the total energy in the indicated 
portion of the spectrum. This is used 
for all spectrum calculations. The 
calculated energy in each range is 
calculated every 5 minutes. The 
results appear in the Circadian Plots. 
Note that some columns such as the 
ULF may have no valid spectral val-
ues for a 5-minute spectrum if the 
default values are used. If alternate 
values are supplied, the resulting 
trend could be valid. These values 
are also used in the same manner to 

calculate the range values in the 
spectrum summary.

The frequency ranges are abbreviated:

• ULF USR1 stands for ultra low fre-
quency, with the range defined by 
the user;

• VLF USR2 stands for very low fre-
quency, with the range defined by 
the user;

• VLF stands for very low frequency;
• LF stands for low frequency;
• HF stands for high frequency;
• Total stands for the total; and
• Total USR3 stands for the total, 

with the range defined by the user.

Reviewing HRV data
Review the HRV data by selecting one 
of the following items from the HRV 
drop-down menu in the main Holter 
menu bar.

Lorenz Plot
These are scatter 
diagrams comparing 
the RR interval fol-
lowing the current 
beat to the RR inter-
val prior to the cur-
rent beat. You can 
choose to display all 
RR intervals, only normal-to-normal 
RR intervals, only RR intervals on 
either side of a ventricular ectopic, or 
only RR intervals on either side of a 
supraventricular ectopic. Make your 
selection in the Morph field by clicking 

HRV menu in Holter m
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Lo
on the arrow and then clicking on your 
choice.

You can change the range on the two 
axes by making a different selection in 
the Scale (ms) field. Your choices are 
1000, 2000, 3000, 4000, or 5000. Click 
on the arrow in the field and then click 
on your choice to change the setting.

In addition, the number of beats plotted 
on a particular Lorenz scatter diagram 
is indicated in the Matches field.

3D Plot
This plot presents the data from the 
eight different frequency ranges (as 
defined in the Spectral Analysis set-
tings window) on three axes: (1) Fre-
quency, (2) Spectral Power Density and 
(3) Time.

To change the amount of time dis-
played on the graph, type an entry in 

the Hours field and then click the Go 
button.

To change the settings for Mesh X, 
Mesh Y, Shaded, Contour, Hidden 
Lines or Zones, click on the check box 
to the left of the label, then click the Go 
button. A check mark in the check box 
indicates that the setting is on; no 
check mark indicates that the setting is 
off. After you click Go, the graph will 
redraw using the new settings.

To customize the axes, select Custom 
from the field above 
the Go button. This 
activates the X, Y, 
and Z fields to the 
right of it. Type the 
new orientation for 
whichever axis you 
choose and then click 
the Go button. To 
return the graph to its 
original settings, 
click on the arrow 
and select Default 
from the list of 
choices, then click 
Go.

Circadian Plots
This shows the power level of each fre-
quency over time, in both absolute 
terms (seconds squared) and normal-
ized as a percentage. The color key for 
each frequency is indicated at the top 
of the plot, underneath the data field of 
the frequency the color represents.

renz Plot
                                                                                            Guide to Holter LX Pro



Guide t

Reviewing HRV data
A check mark to the left of the fre-
quency indicates that that frequency is 
plotted. No check mark indicates that 
the frequency is not plotted. To change 
the setting for a frequency, click on the 
check box.

To read specific data from the plot, 
click on the time-of-day of interest and 
a blue marker appears. The data fields 
at the top of the plot now indicate the 
specific reading for each plotted fre-
quency at the time-of-day of the blue 
marker.

To change the number of hours dis-
played, make your selection from the 
list of choices in the Hours field. To 
display the choices, click on the arrow 
to the right of the field. Click on your 
choice to select it.

Time Domain Plots
This displays separate trends of these 
different measurements and calcula-
tions over time for each interval:

• SDNN - the standard deviation of 
the normal-to-normal RR intervals;

• RMS - the root mean square of the 
differences between sequential RR 
intervals;

• SDSD - the standard deviation of 
the differences between sequential 
RR intervals; 

• NN50 - the number of normal-to-
normal RR intervals that were more 
than 50 milliseconds different from 
the preceding RR interval;

• PNN50 - the percentage of normal-
to-normal RR intervals that were 
more than 50 milliseconds different 
from the preceding RR interval;

• MeanRR - the average RR interval 
within the specified time period; and

• ProcTime - the amount of time (in 
seconds) processed within the inter-
val.

To read specific data from the trends, 
click on the time-of-day of interest and 
a blue marker appears. The data fields 
at the top of the window indicate the 
specific reading for each calculation at 
the time-of-day of the blue marker.

To change the number of hours dis-
played, make your selection from the 
list of choices in the Hours field. To 
display the choices, click on the arrow 
to the right of the field. Click on your 
choice to select it.

Tables
Three different tables are available for 
review. Please note that these are 
accessible using the HRV menu, not 
the Holter Tables window.

Summary of Time Domain
This tabulates this information for the 
entire Holter period:

• SDNN - the standard deviation of 
the normal-to-normal RR intervals;

• SDANN -the standard deviation of 
the normal-to-normal RR intervals 
for each 5-minute period of the 24-
hour recording;
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• RMSSD - the root mean square of 
the differences between sequential 
RR intervals;

• SDNN index - the mean of the stan-
dard deviation of all normal-to-nor-
mal RR intervals for all 5-minute 
segments of a 24-hour recording;

• SDSD - the standard deviation of 
the differences between sequential 
RR intervals; 

• NN50 count - the number of nor-
mal-to-normal RR intervals that 
were more than 50 milliseconds dif-
ferent from the preceding RR inter-
val;

• pNN50 - the percentage of normal-
to-normal RR intervals that were 
more than 50 milliseconds different 
from the preceding RR interval;

• HRV triangular index - an index 
calculated by first determining the 
density of beats vs. RR intervals 
(scaled to a sampling rate of 128 per 
second), then dividing the total 
number of beats by the peak density.

• TINN - a variation of the triangular 
index described above.

• Differential index - an index 
describing the differences between 
the widths of the histogram of dif-
ferences between adjacent RR inter-
vals measured at the levels of 1,000 
and 10,000 beats.

• Logarithmic index - coefficient φ 
of the negative exponential Ke-φt 
that is the best approximation of the 

histogram of absolute differences 
between adjacent RR intervals.

• Spectrum slope on log-log plot - 
slope of the linear interpolation of 
the long-term (24-hour) spectrum in 
a log-log scale. This is the value β 
of the function (log(f)-α)/β that 
gives the best estimation of the 
function log(P(f)) where P(f) is the 
power density of the spectrum.

• Ranges values of entire 24 hours - 
the values defining each frequency 
range for this patient.

• Interval length - the amount of 
time (in seconds) included in each 
interval.

• Number of intervals - the number 
of intervals included in the 24-hour 
recording;

• Values per interval - the RR 
tachogram is sampled every (inter-
val length)/(values per interval) sec-
onds to calculate the long-term (24-
hour or procedure length) spectrum.

• Frequency resolution of short-
term spectrums - this is the size of 
the step in frequency used to make 
all calculations for each interval 
(100 or 300 seconds).

• Frequency resolution of 24-hour 
spectrum - this is the size of the 
step in frequency used to make all 
calculations for the long-term spec-
trum (24-hour or procedure length).
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Time Domain
This reports the time domain informa-
tion for the included data. The table 
includes:

• # - the data number;
• Time - the time-of-day of the data;
• SDNN - the standard deviation of 

the normal-to-normal RR intervals;
• RMS - the root mean square of the 

differences between sequential RR 
intervals;

• SDSD - the standard deviation of 
the differences between sequential 
RR intervals; 

• NN50 - the number of normal-to-
normal RR intervals that were more 
than 50 milliseconds different from 
the preceding RR interval;

• pNN50 - the percentage of normal-
to-normal RR intervals that were 
more than 50 milliseconds different 
from the preceding RR interval;

• Mean RR - the average RR interval;
• Proc. Time - the amount of time 

included;
• # Beats - the total number of beats 

used for the calculations.

Frequency Domain
This reports the frequency domain 
information for the included data. The 
table includes:

• # - the data number;
• Time - the time-of-day of the data;
• Regular VLF (very low frequency), 

LF (low frequency), HF (high fre-

quency) and Total - the actual calcu-
lations made for the data indicated;

• Normalized LF (low frequency) 
and HF (high frequency) - the rela-
tive amount of high versus low fre-
quency data expressed as a 
percentage of the total.

24 Hour Plot
This plots power (milliseconds 
squared) versus frequency (Hz), show-
ing the delineation of each frequency 
range. It can be presented on either a 
linear or a log scale.

Printing HRV data

Report modules
• Frequency Domain Table. This 

lists the very low, low, and high fre-
quency data for each interval. Each 
frequency is reported as a percent-
age, for a total of 1.0 for each type 
of frequency.

• Normalized Frequency Domain. 
This lists the low (LF) and high fre-
quency (HF) data normalized by 
dividing each by the total for that 
frequency.

• Time Domain Table. For each 
interval, this lists the total number of 
normal beats along with heart rate 
variability calculations, including 
the standard deviation of normal-
normal intervals (SDNN), the root 
mean square of the standard devia-
tion (RMSSD), the standard devia-
tion of the standard deviations 
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(SDSD), the number of normal-nor-
mal intervals that were greater than 
50 milliseconds different from the 
preceding normal-normal interval 
(NN50), the percentage of normal-
normal intervals that were greater 
than 50 milliseconds different from 
the preceding normal-normal inter-
val (PNN50), the average normal-
normal interval (RR Mean), and the 
time included in the interval.

• HRV Time Summary. This prints a 
summary of the time domain calcu-
lations, as described for the “Time 
Domain Table” above, plus the max-
imum standard deviation of normal-
normal intervals (Max SDNN), the 
SDANN, the SDNN index, the HRV 
triangular index, the Differential 
index and the Logarithmic index. In 
addition, the time domain data is 
plotted across the Holter period, 
along with two histograms, one 
showing the RR interval distribution 
of normal beats and the other show-
ing the RR interval distribution of 
all beats.

To include a module in the report, the 
check box next to the module name in 
the Reports window must contain a 
check mark. Click on an empty box to 
add a check mark, and click on a check 
mark to remove it. To turn all of the 
modules on or off, click on the All On/
Off check box under the report module 
list; to change them all again, click on 
the All On/Off check box again.
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7  PRINTING 
The Holter LX Pro software generates printed reports composed of a variety of report modules 
that can be included or excluded. Each module can be selected individually, depending on your 
facility’s documentation requirements. Modules range from those with clerical information and 
Scanning Criteria settings to those with tables of ventricular runs and detailed trends. Sample 
strips documenting events can be printed in either standard 25 mm/second format or half that size. 
Full disclosure of any interval can also be included. Some report modules are not appropriate for 
particular patients and are not included in the list of selectable modules when you go to print the 
report.
Guide to Holter

eports window
Final Report

Choosing report modules
To access the report modules that can be included in the final 
printed report, select Reports from the Review toolbar to open the 
Reports window. The modules that are available for the current 
patient are listed in the right half of the Reports 
window. They include:

• Patient Information. This has a standard 
front-page format, with the report heading, 
the information entered in the Patient Infor-
mation window, and the Report Summary.

• Comments Page. This also contains some 
clerical information about the patient, along 
with a large area for comments that were 
typed in the Comment window of the Report 
Summary.

• List of Diary Events. This lists the time-of-
day and symptom for each entry in the Diary 
Symptoms window accessible from the 
Patient Information window.

• Hourly Rhythm Page. This lists the rhythm 
type manually entered in the General table in 
Tables window, using the Edit window.

Report modules in R
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• Settings Page. This includes all 
fields in the Scanning Criteria win-
dow and their settings for this 
patient.

• General Profile and Trends. This 
gives an overview of the patient’s 
Holter data. The table includes inter-
val data: the time-of-day at the start 
of the interval; the low, mean and 
high heart rates within the interval; 
the total number of beats; the total 
number of VPBs, VPB pairs, runs of 
VTAC, SVPBs, SVPB pairs, runs of 
SVT, and pauses; and the amount of 
time analyzed in the interval. The 
trends include minute-by-minute 
heart rate, VPBs, VTAC beats, 
SVPBs, and SVT beats.

• Supraventricular Summary. This 
tabulates the patient’s supraventric-
ular ectopy, including SVPB totals, 
singles, pairs, and runs for each 
interval. In addition, it displays a 
detailed summary of supraventricu-
lar run information, described by 
run length and by the heart rate dur-
ing the run.

• Ventricular Summary. This tabu-
lates the patient’s ventricular ectopy, 
including VPB totals, singles, pairs, 
R on Ts, and runs for each interval. 
In addition, it displays a detailed 
summary of ventricular run infor-
mation, described by run length and 
by the heart rate during the run.

• Bigeminy. This interval table lists 
the number of runs of bigeminy by 
length (in beats).

• ST Episodes. This is a list describ-
ing the detected ST segment events 
during the Holter test, along with a 
trend of the ST segment measure-
ments for each of the three channels 
and the marker locations that were 
used for ST segment analysis. Each 
description includes: 

1. Ch - the channel in which the event 
occurred;

2. Onset - the time-of-day the event 
started;

3. End - the time-of-day the event 
ended;

4. Duration - the duration of the event 
in HH:MM:SS;

5. Max HR - the maximum heart rate 
during the event;

6. Time - the time-of-day of the maxi-
mum ST change during the event;

7. HR - the heart rate at the time-of-
day of the maximum ST change dur-
ing the event;

8. mm from baseline - the maximum 
change (in millimeters) from base-
line during the event;

9. mm from iso-electric - the maxi-
mum change (in millimeters) from 
iso-electric during the event; 

10. Slope - the slope of the ST segment 
during the event; and

11. Integral - the integral (considered 
to be the area between the curves) 
between the ST segment trend and 
the patient’s baseline trend during 
the event.
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• Expanded Heart rate + ST trend. 
This presents 8 hours of minute 
heart rates and 30-second ST data 
(for each channel) per page.

• Critical Events. These bar graphs 
show interval data and a representa-
tive example for each of these sig-
nificant types of event: VPBs, VPB 
pairs, VTAC, SVPBs, SVPB pairs, 
SVT and pauses.

• Brady/Tachy Table. This interval 
table lists the number of beats of 
bradycardia that occurred and the 
time spent in bradycardia, along 
with the number of beats of tachy-
cardia that occurred and the time 
spent in tachycardia. Below the 
table is a 48-hour heart-rate trend.

• List of Saved Strips. This lists the 
strips that are in the printed report, 
including the time-of-day, strip 
label, heart rate and heart rate of an 
event of VTAC or SVT, if appropri-
ate, for each strip.

• Half-Sized Strips. This presents the 
sample strips in a 50 mm/second 
format that allows 14 strips per 
page.

• Full-Sized Strips. This presents the 
sample strips in a 25 mm/second 
format, with three strips per page.

• 12-lead Trend Graphs. This con-
sists of 6 trends, called 12-lead data 
graphs, for 12-lead data, which 
includes QTd, QTc, QT, PR, QRS, 
and RR intervals. The intervals 
between 12-lead data samples is 
based on the DR180+ Digital 
Recorder setting when the Holter 
test was performed.

Note: See Chapter 5: 12-Lead Presenta-
tions for more detailed information about 
the 12-lead report modules. 12-lead data 
is available on DR180+ only.

• 12-lead Tables (25 pages). This is a 
table that reports the numeric data 
for each 12-lead sample throughout 
the monitored period. Reported data 
includes RR, cal RR, QT, cal QT, 
QTc and QTd.

• 12-lead Strips 25 mm/sec. This 
prints a 25 mm/second 6-by-2 12-
lead presentation, along with the 12-
lead data, for all manually saved 12-
lead strips.

• 12-lead Strips 50 mm/sec. This 
prints a 50 mm/second 12-lead pre-
sentation, along with the 12-lead 
data, for all manually saved 12-lead 
strips.

• Ventricular Bins. This includes a 
bar histogram of the distribution of 
each ventricular template across the 
Holter period, along with the first 
example of each template.

• Normal Bins. This includes a bar 
histogram of the distribution of each 
normal template across the Holter 
period, along with the first example 
of each template.

• Paced Bins. This includes a bar his-
togram of the distribution of each 
paced template across the Holter 
period, along with the first example 
of each template.

• Paced Data Information. This 
interval table describes the pace-
maker activity during the Holter 
period. This includes the total num-
ber of paced beats, the percentage of 
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paced beats, the number of beats 
that were atrial-paced only, the 
number that were ventricular-paced 
only, and the number that were 
paced in both the atrium and the 
ventricle, along with capture fail-
ures, sense failures, and inappropri-
ate inhibition.

• Paced Interval Histogram. This 
includes four histograms plotting 
the number of beats versus the RR 
interval following the current beat. 
The four include total paced beats, 
sense failures, capture failures, and 
inappropriate inhibition. This mod-
ule also includes a heart rate trend 
for the Holter period, and the defini-
tions of the LX software’s pace-
maker labels.

• Paced Summary Information. 
This interval table details the num-
ber of paced beats and percentages 
for all paced beats, atrial-paced 
only, ventricular-paced only and 
dual-chambered paced beats. The 
information also includes the pace-
maker settings used during analy-
sis, as defined in the Scanning 
Criteria window.

• Frequency Domain Table. This 
lists the very low, low, and high fre-
quency data for each interval. Each 
frequency is reported as a percent-
age, for a total of 1.0 for each type 
of frequency.

• Normalized Frequency Domain. 
This lists the low (LF) and high fre-
quency (HF) data normalized by 
dividing each by the total for that 
frequency.

• Time Domain Table. For each 
interval, this lists the total number 
of normal beats along with heart rate 
variability calculations, including 
the standard deviation of normal-
normal intervals (SDNN), the root 
mean square of the standard devia-
tion (RMSSD), the standard devia-
tion of the standard deviations 
(SDSD), the number of normal-nor-
mal intervals that were greater than 
50 milliseconds different from the 
preceding normal-normal interval 
(NN50), the percentage of normal-
normal intervals that were greater 
than 50 milliseconds different from 
the preceding normal-normal inter-
val (PNN50), the average normal-
normal interval (RR Mean), and the 
time included in the interval.

• HRV Time Summary. This prints a 
summary of the time domain calcu-
lations, as described for the “Time 
Domain Table” above, plus the max-
imum standard deviation of normal-
normal intervals (Max SDNN), the 
SDANN, the SDNN index, the HRV 
triangular index, the Differential 
index and the Logarithmic index. In 
addition, the time domain data is 
plotted across the Holter period, 
along with two histograms, one 
showing the RR interval distribution 
of normal beats and the other show-
ing the RR interval distribution of 
all beats.

• SpO2 trend 24 hours (optional, 
DR180+ only). This prints a com-
pressed trend of oximetry and heart 
                                                                                            Guide to Holter LX Pro
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rate data, with 24 hours across one 
page.

• SpO2 trend 2 hours (optional, 
DR180+ only). This prints an 
expanded trend of oximetry and 
heart rate data, with 2 hours across 
each page.

• SpO2 and heart rate summary 
(optional, DR180+ only). This 
table presents the minimum, maxi-
mum and mean SpO2 and heart rate 
values for the monitored period.

• SpO2 values and Full Disclosure 
(optional, DR180+ only). This 
prints two-channel full disclosure of 
the ECG annotated with SpO2 val-
ues.

• SpO2 trend and Full Disclosure 
(optional, DR180+ only). This 
prints full disclosure of the ECG, 
along with a trend of the SpO2 data 
at that time.

To include a module in the report, the 
check box next to the module name in 
the Reports window must contain a 
check mark. Click on an empty box to 
add a check mark, and click on a check 
mark to remove it. To turn all of the 
modules on or off, click on the All On/
Off check box under the report module 
list; to change them all again, click on 
the All On/Off check box again.

Including a heading on the front 
page of the report
The Patient Information module of the 
report includes a report heading so that 
you can customize the report for your 
facility. The heading consists of five 

lines of freeform text, with up to 34 
characters per line. To enter text in a 
line, click on the field and type your 
entry. Click on each field in turn and 
type. You can leave any line blank.

If your address comes up automati-
cally, but you would like to change it 
for a particular patient, you can either 
make your selection from the addresses 
you have associated with different 
report configurations (see Chapter 10: 
Configurations for details) or you can 
use the Delete/Backspace keys to clear 
what is there, and then type your entry.

To select an address from a different 
configuration, click the List button. 
That opens the Report Headings win-
dow listing your options. Click your 
choice to highlight it, then click Copy 
to close the window and replace the 
address.

Selecting which strips print in 
the report
Although both manually saved (those 
saved using the Keep button in the 
Review windows) and automatically 
saved strips appear in the Saved Strips 
window, they do not all need to be 
included in the final report. To include 
just the automatically saved strips, 

Report heading in Reports window
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open the Reports window and select 
Automatic in the Saved strips field. To 
include just the manually saved strips, 
select Manual for that field. To include 
both types, select Both.

If the final report is printed including 
either the half-sized or the full-sized 
strip module, it will include only those 
strips designated in the Saved strips 
field of the Reports window.

Strip annotation
Strips printed in the report can include 
a beat-by-beat annotation of the ECG. 
In the Reports window, set the Strip 
annotation field to indicate how you 
would like the beats annotated. Your 
choices are Labels, which are beat 
labels; Heart Rate, which is a beat-by-
beat heart rate calculation based on the 
current-beat-to-following-beat RR 
interval; and RR, which reports the RR 
interval (in milliseconds) from the cur-
rent beat to the following one.

To not include any beat annotation, 
select None in the Strip annotation 
field.

The beat labels consist of:

• N for normal
• S for SVPB
• V for VPB
• A for artifact
• P for paced (A, V, or AV)
• E for aberrant SVPB
• D for event marker
• ? for questionable/unknown

Report summary
The summary that prints on the front 
page of the report can take one of five 
formats. In the Reports window, select 
Numeric, Verbal, Concise, Narrative, 
or Oximetry (Oximetry appears only 
for those patients with oximetry data) 
in the Report summary field to indicate 
which summary style should appear in 
the printed report for this patient.

The Numeric summary provides a list-
ing of Holter data for the patient. The 
Concise summary abridges the patient 
results into a short table and includes 
sample ECG. The Verbal summary pre-
sents the same information using sen-
tences. The Narrative summary 
provides the information in a more 
descriptive summary. 

To view and/or edit the summary on-
screen before printing the report, make 

Choices for Saved strips

Choices for Strip annotation

Report summary choices, without oximetry
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Sum
your selection in the Report summary 
field and then click the View summary 
button in the bottom of the Reports 
window; this opens the appropriate 
Report Summary window.

Editing the Report summary
The Report Summary window displays 
the information exactly as it will 
appear on the front page of the report. 

Every character 
can be edited, if 
you choose to do 
so. You can select 
the text and then 
delete it or type 
over it, or you can 
simply add to the 
information that is 
already there.

To add comments to the end of the 
summary, click after Comments: and 
then either type the comment or select 
a line from the Phrases window in the 
left portion of 
the window; 
after selecting 
the phrase, click 
Add to copy it 
over into the 
Comments area. 
The Phrases list 
appears only if 
you entered at 
least one sen-
tence in Patient 
> Preferences > 
Summary 
phrases.

Note: Because the printed report 
includes the information from the Report 
summary exactly as it appears here in the 
Report Summary window, be sure to 
make changes carefully.

To access the additional Comment win-
dow, click the Comment button, then 
type the information you would like to 
appear on the Comments page of the 
report (typically page 2). Click Front 
page to return to the previous Report 
Summary window, the one that appears 
on the front page.

If you start making changes to the text 
in the Report Summary window, but 
then decide you would like to revert to 
the original information, click the Redo 
button; your changes to the Report 
Summary window will be deleted and 
the text will return to the original.

To print the Report summary before 
inclusion in the final report, click Print.

mary phrases
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When the information in the window 
appears as you want it in the final 
report, click OK to save your changes 
and exit. Click Cancel to exit without 
saving your changes.

Note: The Report summary is newly 
compiled after any Update or Re-
analysis, so do not make changes here 
until all other editing is complete. If you 
make changes here and then make a 
change that requires an update or re-
analysis, you will have to re-enter the 
changes.

Note: The contents of the Report 
summary will vary depending on a couple 
of factors: if the patient has a pacemaker, 
paced data replaces ST data; if SVPB 
counts were disabled, the Report 
summary states that and excludes 
supraventricular counts.

Status indicators
Note that the Status indicators from the 
Patient Information window also 
appear here in the Reports window. 
Use them to keep track of whether a 
patient’s Holter has been edited, 
printed, and/or verified already. Click 
the check box to add or remove a check 
mark.

Full disclosure
Full disclosure is a printout of all the 
ECG recorded during the Holter moni-
toring period, in a miniaturized format. 
Each page is annotated with time-of-
day along the left margin.

You can print full disclosure in a vari-
ety of formats based on the channels 
printed and the amount of time printed 
on each page. Full disclosure can be 
printed for a single channel (channel 1 
or 2 or 3) or for two channels together 
on a page (channels 1 and 2, or chan-
nels 1 and 3, or channels 2 and 3). It 
can be printed with 30 minutes of ECG 
per page or 60 minutes.

Determining what to print in full 
disclosure
To request a full disclosure printout, 
select Reports from the Review tool-
bar. In the Reports window, there is a 
section with settings that control full 
disclosure. It includes three fields:

• Time per page check boxes. At the 
top of the section are two check 
boxes labeled 30 min/page and 60 
min/page. To print full disclosure, 
there must be a check mark in one of 

Full disclosure area of Reports window
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these check boxes. Click on the 
check box to make a check mark 
appear in it; click on the other check 
box to put the check mark there and 
remove it from the first check box. 
To eliminate a check mark, click 
again on the check box.

• Channel(s) field. To indicate what 
channel(s) to print in full disclosure, 
select an entry from the Channel 
field. Click on the arrow to display 
your choices, and then click on your 
selection.

• Intervals to include. Full disclosure 
can be printed for each hourly inter-
val, all of the hourly intervals, or 
whatever combination you select. 
For each Holter test, the Intervals 
field lists all hourly intervals in the 
recording. To include an interval in 
the full disclosure printout, click on 
the check box next to the time-of-
day at the beginning of the interval. 
Click on as many intervals as you 
would like to print. To eliminate an 
interval from the printout, click on 
the check box to get rid of the check 
mark. To check all intervals on or 
off, click on the All On/Off check 
box below the interval list.

Note: The time per page check boxes 
control how much total ECG is printed 
per page. If you choose to print two 
channels of ECG, the 30 min/page setting 
will print both channels during a 15-
minute time period, and the 60 min/page 
setting will print both channels of a 30-
minute time period.

Reviewing the report
To review the report on screen before 
printing it, click the Review button at 
the bottom of the Reports window. This 
launches the Adobe Acrobat program 
that generates a pdf file for you to 
review on-screen. 

Note: Although you can choose to print 
the report from the Acrobat file displayed 
using the Review button, you must ensure 
that the Adobe Acrobat settings are 
appropriate for the Holter report. In File 
> Print, (1) Print as Image must be 
turned on and (2) Expand small pages to 
paper size (version 5) or Fit on page 
(version 6) must be turned off. Printing 
the report without the proper settings will 
result in a non-diagnostic-quality 
printout.

When you click the Review button, the 
report compiles and then is displayed 
on the screen, starting with page 1. The 
on-screen report appears as a continu-
ous document that can be scrolled 
through. You see it on the screen in 
Acrobat Reader. Refer to Acrobat 
Reader documentation for user instruc-
tions.

The report cannot be edited or changed 
in any way in this display mode, but 
you can go back to the Review meth-
ods (Bins, Critical Events, Saved 
Strips, Page, and Trends windows), or 
to the Report Summary or the Patient 
Information window to make changes 
before printing the final report.
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Compiling the report using Adobe 
Acrobat software is also helpful if you 
want to send an electronic version of 
the report to a different site that has no 
Holter LX software. You can send the 
pdf file created, and the other site can 
use Acrobat Reader software to print 
the report.

Printing
When the fields within the Reports 
window are set properly for a patient, 
click the green Print button at the bot-
tom of the window to compile and 
print the report. If you turned on some 
of the report modules, those print first, 
followed by any full disclosure you 
have selected.

To cancel printing after clicking the 
Print button, click Cancel. Whatever 
portion of the report that has been com-
piled prints, and then the rest of the 
report is canceled.

Note: Sometimes when you click the 
Print or Review buttons in the bottom of 
the Reports window, a confirmation 
window appears asking, “OK to use the 
previously compiled report?” That means 
that a report has already been compiled 
for this patient’s Holter test. If you are 
sure that no changes have been made to 
any Holter setting or any information in 
the report, click Yes to print a report 
identical to the previously compiled one. 
If you are unsure whether any changes 
have been made, click No; a new report 
will compile and then print.

At any point after printing the report, 
you can still edit the information and 
retrieve additional strips, and then print 
out the report again.

Closing the Reports 
window
At any time, you can save changes to 
the Reports window settings, but exit 
without printing the report, by clicking 
OK. Or, to exit without saving any 
changes to the settings, click Cancel.
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You can customize certain parts of the Holter LX Pro software to better suit the needs of your 
facility. The customization options range from entering the names of physicians who order Holter 
tests - so that you don’t have to type them in each time - to which Review window you want to 
come up automatically at the end of analysis.
Guide to Holter

dow
Preferences window
To open the Preferences win-
dow, select Patient > Prefer-
ences. These customization 
options are available:

Draw grid
You can choose whether or not 
there is a background grid 
behind the Expanded strip dis-
played in the Page window. 
Click on the Draw grid check 
box to change the setting. A 
check mark indicates that a 
light grid will appear. No 
check mark means that the grid 
will not appear.

Automatically update 
tables
A check mark should appear in 
the check box so that the soft-
ware automatically updates 
counts, tables and strip labels 
after you relabel a beat, tem-
plate or bin in any of the 
Review windows. If it does not 

Preferences win
 LX Pro     93



Preferences

94
automatically update, you must manu-
ally run an update after making 
changes.

Note: If this setting is off and you make 
a change that requires an update, a 
blinking red Update button will appear in 
the Review toolbar. To manually run an 
update after making changes, click on the 
blinking red button or select Review > 
Update.

Confirm T-wave/Supraventricular 
“Single Beat” relabel

Relabeling a beat to a T-wave or SVPB 
can only be performed at the Single 
beat level, regardless of the Relabeling 
Mode setting in the Page window. 
When you relabel a beat to one of 
these, the software can remind you that 
only a single beat is being relabeled. If 
a check mark appears in this check 
box, a Confirm window appears.

Click on Yes to do a single beat relabel 
of the highlighted beat. Click No to 
close the Confirm window without 
relabeling the highlighted beat.

Read flashcard information on 
Patient/New
When you create a new patient entry 
by selecting Patient > New from the 
main menu and the Patient Information 
window opens, the flashcard/SD card 
in the card reader can be read immedi-
ately, if this setting is on. If this setting 
is off, the data on the flashcard is not 
read until you click the Copy flashcard 
button in the Patient Information win-
dow.

Note: If this setting is on, you must 
insert the flashcard/SD card into your 
computer’s card reader before a new 
patient record can be opened. If you 
select Patient > New without first 
inserting the card, you will not be able to 
continue for this patient until the card is 
inserted.

Display toolbar
The LX Pro software has three levels 
of toolbars. The first contains the but-
tons Patient, Review, HRV, 12-Lead, 
Settings, and Help. The second level, 
which we call the Review toolbar, con-
tains buttons to open the different 
Review windows and the Reports win-
dow. The third level includes the vari-
ous toolbars that appear with buttons 
and fields appropriate to whatever 
Review window is open.

All of the choices in the Review tool-
bar are also available in the drop-down 
menu of Review in the first-level tool-

Confirm window
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Preferences window
bar. If you prefer to eliminate the 
Review toolbar and make your selec-
tions from the drop-down Review 
menu, turn this setting off. A check 
mark means the toolbar is displayed; no 
check mark indicates that the toolbar is 
not displayed.

“Print Screen” in color
If you have a color printer and want to 
print out screen displays in color, turn 
this setting on. Then when you select 
Patient > Print Screen, the printout is in 
color. A check mark means the ouptut 
to the printer is in color; no check mark 
means the output is in black and white.

Save new Physician or 
Interpreting physician
This field allows the software to ask 
you whether to add a new physician or 
interpreting physician name to the 
appropriate list when you close the 
Patient Information window after typ-
ing a new name in either field.

Use Control Panel vs. dd-mmm-
yyyy date format
To use the date format used throughout 
your computer system instead of the 
format provided by Northeast Monitor-
ing, put a check in this check box.

To change the date and time format 
used throughout your computer system, 

select either: (1) Start > Settings > Con-
trol Panel > Regional and Language 
Options or (2) My Computer > Control 
Panel > Regional and Language 
Options. Use the Customize button and 
the Time and Date tabs to display your 
options for each field.

Assign date and time to Scan #
This indicates whether a Scan # is auto-
matically assigned to a patient record. 
When this feature is turned on, a date-
and-time stamp is entered in the Scan # 
field whenever a New patient is cre-
ated. 

This setting also allows an auto 
sequencing feature that includes a com-
bination of the date/time stamp plus an 
assigned number (starting at 00001) in 
the Scan # field. To implement the auto 
sequencing feature, you must change 
the entry in the Scan # field in the Con-
figuration program. See Chapter 10: 
Configurations for details.

Use large fonts
This determines the size of the font 
used throughout the software. A check 
mark indicates that a large font is used 
for all menu items, selections and text.

Use large fonts in toolbar
This determines the size of the font 
used in the Holter Review toolbar. A 
check mark indicates that a large font is 
used for the Review items.

NorthEast date format
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Show additional fields in Patient 
Information
The two fields Interpreting physician 
and Analyst in the Patient Information 
window are optional. If you want them 
to appear in the Patient Information 
window and on the front page of the 
final report, this setting should be on. If 
you do not want them, this setting 
should be off.

Annotation
Indicate here whether the beats in any 
on-screen, expanded strip should be 
labeled with a beat-by-beat heart rate 
calculation or RR interval length. The 
annotation refers to the RR interval 
starting at the R-wave under the label.

Click on the arrow in the field to dis-
play your choices. Click on your 
choice to select it.

ST measurement
ST segment analysis can be performed 
with the ST segment measurement 

made at the position of either of the 
two right-most ST markers. The mid-
dle marker identifies the J-point and 
the one at the far right is the ST seg-
ment marker. Indicate in this field 
which marker should be used for ST 
segment analysis. 

Click the arrow in the field to display 
your choices, then click your choice.

After analysis show
This field 
allows you to 
determine 
which window 
is displayed 
upon the com-
pletion of anal-
ysis. Your 
choices include 
any of the 
Review win-
dows and the Reports window. To 
change the setting, click on the arrow 
in the field to display the list of 
choices, then click on your selection.

Print countdown
If the “After analysis show” field is set 
to Reports, upon completion of analy-
sis, the software will display the 
Reports window for this amount of 

Beats with RR interval annotation

Positions of ST markers

Choices for display
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Physi
time (in seconds), after which the 
report will print. During the print 
countdown, press any key to prevent 
the report from printing.

Recorder types in use
This should be set based on whether 
you use DR180+ or SD360 recorders, 
or both. Select one of the following: 
DR180+ and SD360, DR180+ only, or 
SD360 only. This setting determines 
what your choices are when you go to 
format a flashcard/SD card before 
recording a new patient.

Access advanced recorder 
settings
This should be on (with a check mark) 
so that you can make changes to how 
the SD cards are formatted for use in 
the SD360 recorder. If you want to not 
allow changes to the format used, turn 
this setting off (no check mark).

Edit fields
You are able to customize the entries 
for two fields in the Patient Informa-
tion window that appear in the patient 
information area of the printed report: 
Physician and Interpreting physician. 
Entries in those fields can be preset so 
that you can make a selection from a 
list instead of typing the physician 
name in for each Holter test. In addi-

tion, using the Save new Physician or 
Interpreting physician setting described 
earlier in this chapter, as you add new 
names in the Patient Information win-
dow, the system can ask whether to add 
each new name to the appropriate list.

Physician names
To add a name to the list in the Physi-
cian field of the Patient window, go to 
Patient > Preferences > Physicians. In 
the Edit physician name window, click 
on the first line and type the name as 
you want it to appear in the report. To 
enter another name, click on the line 
below the first and type that name. Use 
the scroll bar to access additional lines. 
When you have entered as many names 
as you need, click OK to close the Edit 
Physician Names window.

To exit without saving changes, click 
Cancel. To delete an entry, click on the 
line so that the field is outlined and 
then click Delete.

Interpreting physician names
To add a name to the list in the Inter-
preting physician field of the Patient 
Information window, go to Patient > 
Preferences > Interpreting physicians. 
In the Edit Interpreting physician 
names window, click on the first line 
and type a physician’s name. To enter 
another name, click on the line below 
the first and type the name. Use the 
scroll bar to access additional lines. 
When you have entered as many names 
as you need, click OK to close the Edit 
Interpreting physician names window.
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To exit without saving changes, click 
Cancel. To delete an entry, click on the 
line so that the field is outlined and 
then click Delete.

Summary phrases
You are able to customize entries for 
the Comments area of the Report Sum-
mary section of the printed report using 
this button. 

To add a sentence, select Patient > 
Preferences > Summary phrases. Click 
on a field and type a sentence as you 
want it to appear in the Report Sum-
mary. When all sentences are complete, 
click Done. To delete a line, highlight it 
and then click Delete. 

The sentences will be available for you 
to select when you display Reports > 
View Summary, so that you don’t need 
to re-type common phrases.

Configurations
Click this button to launch the Config-
uration program that allows further 
customization of the Holter LX Pro 
software. Details appear in Chapter 10: 
Configurations.

Edit summary phrases window
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Making room for new patients
When the software has saved the maximum number of patients 
allowed by your system, you must delete old patient reports to 
make room for new ones. If you want to archive an electronic 
version of each report, make sure you back up a patient report 
before you delete it.

To delete a patient report from the patient list, go to Patient > 
Open to display the list of patient records currently in the Holter 
LX software. In the Open Patient window, click on a patient 
name to highlight it and click the Delete button. When the Con-
firmation window appears, click Yes. That slot in the list will 
now be available the next time you select Patient > New. 

To delete multiple sequential patient reports in the Open Patient 
window, click on the first report to be deleted, then drag down 
to the last one you want deleted. With multiple patient names 
highlighted, click the Delete button. When the Confirmation 
window appears, click Yes.

To close the Confirmation window without deleting any patient 
reports, click No.
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Backing up patient 
reports
To back up patient reports in the direc-
tory before deleting them to make 
room for new patient reports, go to 
Patient > Open and click the Backup 
button to open the Backup window, 
which displays the Backup tab.

From the list of patients in the top half 
of the Backup window, click on the 
patient report you want to back up; if 
your patient list is longer than the win-
dow display, use the scroll bar to dis-
play additional patient reports. To back 
up multiple sequential patient reports, 
click on the first report to be backed 
up, then drag down to the last one you 
want backed up. With the appropriate 
patient(s) selected (that is, high-
lighted), click Backup again. A con-
densed version of the report is created 
and saved.

What gets saved
To determine how much of the patient 
data is saved in the backed up report, 
the program refers to the entry in the 
Save field of  Backup > File > Settings. 

The Save field in the Backup Settings 
window contains two choices: (1) “All 
files” will compress all patient data, 
including the entire Holter recording; 
and (2) “Reports only” will save an 
electronic version of the patient’s 
printed Holter report, including ECG 
strips, but not the entire recording. By 
doing an “All files” (full) backup, the 

patient’s Holter data can be re-ana-
lyzed at a later date.

To change the entry, click on the arrow 
to the right of the field and then click 
on your choice. Click OK to close the 
Settings window. The type of backup 
report to be saved appears in the Save 
field of the Backup tab.

Once a patient report has been backed 
up, the type of backup is indicated in 
both the Open Patient window and in 
the Status window within the Patient 
Information window. In the Open 
Patient window, a full backup is indi-
cated as “Full” in the Type column; a 
backed up report is indicated as 
“Report.” In the patient’s Status win-
dow, the Backup field displays either 
“Full” or “Report.”
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Automatic file name
The file name of the backed up report 
is automatically assigned as a number 
followed by the “zip” extension. The 
assigned number is the one following 
the entry in the Last patient saved field 
of the Backup Settings window. The 
software automatically keeps track of 
the numbers it assigns and updates this 
field, but you can override it by enter-
ing a different number and clicking 
OK. 

Note: Make changes here carefully. 
If you enter a new number that is 
smaller than the number listed, the 
backup process with reuse a file name 
and over-write the previously saved 
patient report. Unless you have 
backed up that patient report 
elsewhere, it will be permanently lost.

Assigning a backup file name
The Settings window in the Backup 
program allows you to include a prefix 
or suffix on the numeric file name 
given to a backup report. If you assign 
a prefix or suffix to a particular patient 
group (for example, all the patients of a 
particular physician) this feature means 
that later you can easily identify which 
reports are in that group.

To include a prefix or suffix to the 
backup file name, enter up to four char-
acters in the appropriate field of the 
Settings window before saving the 
patient report. If no prefix or suffix is 

specified in the Settings window, the 
backup file name will be the next 
sequential number in the backup series, 
with the extension “zip.”

The size of a backup file
The Compression level field of the Set-
tings window in Backup allows you to 
control the amount of compression per-
formed when saving the backup file. 
The range is from 1 to 9, with 1 being 
the least compressed and 9 the most 
compressed. That makes 1 the quickest 
backup process, and 9 the longest.

Customizing the Backup 
directory
The Backup patient directory (on the 
Backup tab of the Backup program) 
can be customized to include only 
those fields you need to track your 
patients’ backed up records. Use the 
fields and buttons in the bottom half of 
the Backup > File > Settings window 
to establish which fields appear as col-
umn headings in the Backup directory. 
Those variables (headings) in the left-
hand column will not be included; 
those in the right-hand column will be 
included. Use the buttons in the center 
- Add, Add all, Remove, and Remove 
all - to move variables (headings) from 
one column to the other. Rearrange 
those in the right-hand column using 
the other buttons in the center - Top, 
Up, and Down.
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Note: We recommend that if you 
customize the Backup directory, you 
do so only before backing up any 
patient records. Inconsistencies will 
result if you back up some reports 
using one set of headings and other 
reports with a different set of 
headings.

Where the backup file is saved
In the Backup window, the Archive 
destination directory field indicates 
what device and directory will store the 
backup file. The setting defaults to 
\nm\backup on your hard drive. To 
save the backed up report elsewhere, 

select a device from the list associated 
with the Archive destination directory 
field and type in the appropriate direc-
tory name before clicking on the 
Backup button.

See the sections about archiving 
reports on CD using Roxio Easy CD 
Creator later in this chapter for details 
about moving the files in the backup 
directory to permanent storage.

Retrieving a backed up 
patient report
To retrieve a patient report that has 
been backed up, go to Patient > Open, 
                                                                                             Guide to Holter LX Pro
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Using Roxio software to archive records on CD
then click on the Backup button. The 
Backup window opens, with two tabs 
at the top. Click on the Restore tab to 
open the Restore window. 

In the Archive source field, select the 
drive on which the patient reports are 
backed up. Any reports the software 
finds on that drive will be listed in the 
bottom portion of the window. In that 
bottom portion, click on the patient 
report you want to retrieve; in the top 
portion, click on the patient slot where 
you want the retrieved report to go. 
The patient report in that slot will be 
over-written, so be sure to select the 
slot carefully. Then click Restore. 
When the Confirmation window 
appears, click Yes to retrieve the 
backed up report. Click No to close the 
Confirmation window without retriev-
ing the report.

Click on the X in the red button at the 
top right of the Backup window to 
close it.

Note: You can retrieve only the same type 
of report you backed up. If you backed up 
a Full report, all the Holter data is there 
for you to re-analyze, if necessary. If you 
backed up a Report, only an electronic 
version of the printed report is available, 
and re-analysis is not possible.

Additional features in the 
Backup window
The Backup and the Restore tabs of the 
Backup window also include these but-
tons, which function as indicated:

Refresh: Redisplays patient report 
lists, reflecting any changes.

View: Allows you to select a backed 
up report and view it on-screen 
without restoring it onto the current 
Patient List. Once it’s displayed, 
you can also print the report.
Copy to clipboard: Allows you to 
export a patient’s backed up report 
to a spreadsheet. For details, see the 
section “Using a spreadsheet to keep 
track of archived data,” later in this 
chapter.

Using Roxio software to 
archive records on CD
 The Backup program built into the 
Holter LX software can be used to 
archive patient reports onto a compact 
disk using Roxio Easy CD Creator 
software. During the procedure, the 
patient files are copied from the sys-
tem’s hard disk, compressed, and saved 
to CD. There are two requirements: (1) 
the Roxio software must be installed on 
your system’s hard disk and (2) your 
system must have CD drive that can 
write to CD.

As a general rule, each 700-MB CD 
can hold about 10 to 15 full patient 
reports (called “Full” in the Backup 
Settings), including 24 hours of edit-
able ECG, or between 200 and 300 par-
tial records (called “Reports” in the 
Backup Settings) that include the entire 
Holter report, but not the full editable 
ECG.

You have two options for backing up:

• copying a group of zipped patient 
files at a single session onto a CD, 
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using a format that is more likely to 
be accessible by any computer sys-
tem; or

• copying zipped patient files at mul-
tiple sessions to a CD that is consid-
ered a direct device, using a format 
that perhaps will not be supported in 
the future.

Note: We recommend that the former 
approach be used when backing up 
patient reports for permanent archival. 
That approach is described first in the 
following documentation.

Backing up a report on 
CD - single session
The procedure consists of three steps:

1. using the Holter LX Backup soft-
ware to compress patient files and 
save them in a temporary location 
(this step was already covered in a 
previous section, but is also 
included in the following instruc-
tions), 

2. using Roxio software to copy the 
compressed files to CD, and

3. deleting the compressed patient 
files from the temporary location.

Compressing Holter data for 
backup
To start the backup procedure:

1. Launch the Holter LX software.
2. Select Patient >Open.

3. Click Backup to open the Backup 
window, which displays the Backup 
tab.

4. In the Destination field, enter the 
device and directory in which 
backed-up files will be stored tem-
porarily. Use c:\nm\backup.

5. In the list of patients, click on the 
patient report you want to back up; 
if your patient list is longer than the 
window display, use the scroll bar to 
display additional patient reports. To 
back up multiple sequential patient 
reports, click on the first report to be 
backed up, then drag down to the 
last one you want backed up. 

6. With the appropriate patient(s) 
selected (that is, highlighted), click 
Backup again. A small Backup sta-
tus window opens, displaying the 
current compression step.

7. When compression is complete and 
the files have been transferred to the 
\nm\backup directory, the status 
window closes. You can continue 
with formatting the CD.

Note: For details about what files get 
compressed and assigned file names, 
refer to the “Backing Up Patient 
Reports” section earlier in this manual.

Archive destination field in Backup window

Backup window displayed during compressio
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Copying to CD
To copy the zipped files produced by 
the backup program onto CD:

1. Insert a blank, writable CD-R (not 
CD-RW) into the drive. Explorer 
opens a CD Drive window asking 
how to proceed.

Note: Although it is possible to use a CD-
RW for backup, it requires a prolonged 
formatting period and is more expensive. 
Because the backup procedure is 
intended to be permanent storage of 
patient records, there is no advantage to 
using CD-RWs.

2. If an Explorer window opens ask-
ing how to proceed, select the 
choice “Create a CD using Roxio 
Easy CD Creator” to launch the 
Roxio Easy CD Creator software. 
If an Explorer window does not 
open, launch the Roxio Easy CD 
Creator from your Start > Pro-
grams menu.

3. The Roxio main 
menu appears. 
Place the cursor 
over the button 
labeled “make a 
data CD” so that 
additional menu 
choices appear as 
shown to the right.

4. The middle menu 
choice is “data CD 
project.” Click 
that. The Data CD 
Project window 
opens.

Main menu of Roxio Easy CD Creator

Data CD Project window

Explorer’s CD Drive window
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5. Select File > CD Project Properties 
to open the properties window as 
shown below. Type the label you 
want for the CD in the Volume 
Label field.

6. Make sure that “Joliet” is listed in 
the File System field. If it is not, 
select it from the list of choices.

7. Click the radio button labeled 
“Mode 1: CDROM.”

8. Press OK to close the 
window.

9. Within the Data CD 
Project window, the 
“Select source files” 
field should read “Local 
Disk (C:)” and should 
list directories/folders 
below it. One of the 
directories is named 
“nm” - for NorthEast 
Monitoring. Double-
click that folder so that 

“nm” appears in the Select source 
files field and additional directories 
are listed below it. In that list of 
directories, double-click on 
“backup” to select it; “backup” 
appears in the Select source files 
field, and the compressed files 
(named *.zip) are listed below that. 

10.  From the list, select the patient 
records to be backed up, which will 
typically be all the files listed. Click 
on a file name to select it; to select 
multiple sequential files, click on 
the file name, press the Shift key 
and drag to the last file name. To 
select all files, hold down the Ctrl 
key and press A.

11.  With the files you want highlighted, 
click the Add arrow near the center 
of the window. The selected file 
names appear below the Add arrow. 
You can also choose to drag the 
highlighted file names from the top 
of the window to the space below 
the Add arrow. Files can also be 

CD Project Properties window
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selected individually and added to 
the Add list one at a time.

12.  When all of the files you want cop-
ied to the CD appear in the Add list, 
press the red record button. The 
Record CD Setup window opens.

Note: If the record button is dim, you 
have not yet moved files to the Add list. 
You must have selected at least one file 
and moved it to the Add list for the 
record button to turn red.

13.  When the Record CD Setup win-
dow opens, if the Options button 
appears, click it to include the 
record options at the bottom of the 
window, as shown in the figure 
above. If the Hide Options button 
appears when the Record CD Setup 
window opens, the options are 
already displayed.

14.  In the Record Options area, 
“Record CD” should be selected. In 
the Record Method area, click on 
“Disc-At-Once.” This will allow 
you to copy files to the CD and then 
close the session to future additions.

15.  Click the Start Recording button.
16.  The Record CD Progress window 

shown below appears as the files are 
copied to CD.

17.  When copying is complete, a query 
about launching CD Label Creator 
opens. To Close the current CD ses-
sion, click Close.

18.  In the Record CD Progress window, 
click OK.

19.  If a query window appears asking 
you whether you should save the 
project, click Yes.

20.  The Explorer window for the CD 
drive appears with the compressed 
files listed as “Files Currently on the 
CD.” Close the window. 

21.  Eject the CD from the drive and 
label it appropriately, with a unique 
name that will distinguish this CD 
from other backup CD.

Note: Do not remove the CD from the 
drive while it is still being written to. Wait 
for the spinning sound to stop before 
removing the CD.

Record CD Setup window

Record CD Progress w
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Deleting compressed files
22. To delete the compressed files from 

their temporary location, go to My 
Computer and double-click Local 
Disk.

23.  Double-click the nm folder to open 
it.

24.  Double-click the backup folder to 
open it, displaying the compressed 
files (*.zip) currently in the folder.

25.  To delete the files one-by-one, 
right-click on each file you have 
backed up and select Delete. To 
delete all files, select one of them, 
then hold down the Ctrl key and 
press A to select all, then press 
Delete.

Note: If you do not delete files from the 
\nm\backup directory, they will 
accumulate and you will have to keep 
track of which ones have been copied to 
CD and which ones have not. Instead, we 
recommend that you routinely delete all 
files after copying to CD so that when you 
are backing up, you know that any files 
in the \nm\backup directory have not yet 
been copied to CD.

Backing up a Holter test 
on “direct” CD

The procedure consists of three steps: 

1. properly formatting the CD, 
2. using the Holter LX Backup soft-

ware, and
3. closing the CD session.

Formatting the CD
To format the CD to accept the zipped 
files produced by the backup program:

1. Insert a blank, writable CD-R (not 
CD-RW) into the drive. 

Note: Although it is possible to use a 
CD-RW for backup, it requires a 
prolonged formatting period and is more 
expensive. Because this procedure allows 
you to periodically copy patient records to 
the same CD until it is full and because 
the backup procedure is intended to be 
permanent storage of patient records, 
there is no advantage to using CD-RWs.

2. If an Explorer window opens asking 
how to proceed, select the choice 
“Create a CD using Roxio Easy CD 
Creator” to launch the Roxio Easy 
CD Creator software. If an Explorer 

window does not open, launch the 
Roxio Easy CD Creator from your 
Start > Programs menu.

CD Drive window with Roxio selection 
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3. The Roxio main menu appears.
4. Place the cursor over the button 

labeled “make a data CD” so that 
additional menu choices appear as 
shown at right.

5. The top menu choice is “direct 
CD.” Click that. The Roxio format 
utility opens.

6. Make sure the correct drive name is 
listed in the select CD field as 
shown in the figure above. Then 
click the Format CD button in the 
center of the display. The Format 
window opens.

7. Type a label name for the CD 
(choose a unique name that will dis-

tinguish this CD from other backup 
CDs) in the field indicated in the 
Format window. If you have 
inserted a new blank CD-R, the 
Quick Format and Full Format 
selections will be dim; the Quick 
Format will be done.

Note: If the Quick Format selection is 
dim and the Full Format selected, and 
you cannot click the Quick Format radio 
button on, you probably have a CD-RW 
in the drive. We recommend that you use 
a CD-R instead.

8. Click the Start Format button. Sev-
eral windows open in sequence. 
When formatting is complete, 
Explorer opens an empty window 
for the indicated drive. 

9. Close the Explorer window to reveal 
a CD Ready window; click OK to 
close that; and then close the Roxio 
format utility display.

10. Launch the Holter LX software and 
continue with the steps in the next 
section.

Direct CD Format window

Roxio main menu with “make a data CD” c

oxio format utility
o Holter LX Pro                                          109



Managing Patient Reports

110
Using the Holter LX Backup 
software
11.  After launching the Holter LX pro-

gram, go to Patient > Open, then 
click the Backup button. 

12.  In the Backup window, the Backup 
tab should be displayed. From the 
list of patients in the Backup win-
dow, click on the patient report you 
want to back up. To back up multi-
ple sequential patient reports at one 
time, click on the first one to be 
backed up, then drag down to the 
last one you want backed up. Or 
click on the patient report you want 
to back up and then press the Shift 
key and click on additional patients.

13.  In the Archive destination field 
under the patient list, select the 
appropriate drive name for your sys-
tem’s CD drive. Click on the arrow 

at the right of the field to display the 
drive choices; click on your choice 
to change the setting.

14.  With the appropriate patient(s) 
selected (that is, highlighted), click 
Backup again. The report for each 
patient is compressed into a zip file 
and transferred to the CD. 

15. When the procedure is complete, the 
Backup window reappears, with the 
list of backed up patients in the bot-
tom half of it. 

Archive destination field in Backup window

Backup window displayed during compression
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16.  Click the red close button in the 
upper right corner to exit the 
Backup window and return to the 
Open patient window.

17.  To remove the CD from the drive, 
follow the directions in the next sec-
tion.

Note: Details of what gets saved for each 
patient report and how to retrieve a 
patient report from archived files are 
covered in the early sections of this 
chapter.

Closing the CD session
18.  Once you have backed up patient 

files on CD, to remove the CD, you 
must first indicate how to save the 
CD. To do so, select the Roxio soft-
ware so that the format utility is dis-
played.

19.  Click the Eject button in the center 
of the display. The Eject Options 
window opens with the following 
choices:

• Leave As Is - This leaves the CD in 
a state so that you can continue to 
add patient reports to it. In this state 
it is only readable by a system run-
ning Roxio Easy CD Creator Soft-
ware.

• Close to UDF v.1.5 - This saves the 
information on CD, but will not 
allow additional patients to be 
added. It can only be read by a sys-
tem running UDF v.1.5.

• Close to Read on Any Computer - 
This saves the information on CD, 
but will not allow additional patients 
to be added. It can be read on most 
standard CD-ROM drives, without 
Roxio software.

20.  To save to the CD, but allow addi-
tional patients to be added in the 
future (up to the storage limit of the 
CD), click “Leave As Is” to select it, 
then click OK. The CD drive opens 
and the following window appears.

21.  Click OK.
22.  Remove the CD and label it appro-

priately.
23.  If the Roxio format utility is still 

displayed, click the close button in 
the upper right corner to close it.

Eject Options window

Ejected CD window
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Adding patient reports to CD
To copy additional patient reports onto 
a directCD that already contains some:

1. Insert the CD into the drive. If a 
window opens displaying what is on 
the CD, close it.

2. Launch the Holter LX software and 
follow steps 10 through 19 listed 
above.

3. If the CD is not yet full, you can 
proceed with steps 20 and 21, and 
then remove the CD from the drive. 
If the CD is full, (1) select the 
“Close to Read on Any Computer” 
choice in the Eject Options window 
in step 20 so that the information is 
permanently archived in a format 
that is accessible by most CD-ROM 
drives without Roxio software and 
(2) click to turn on “Protect CD so it 
cannot be written to again;” then 
click OK and remove the CD from 
the drive.

Keeping track of 
archived data
Once you have backed up patient 
reports (either Full reports including all 
the recorded ECG or Reports including 
just the information in the printed 
report) onto CD, you need to keep 
track of which CD holds which patient 
reports. You can do this using either (1) 
the Backup Log in the Holter LX soft-
ware or (2) a spreadsheet program like 
Microsoft Works Spreadsheet.

Using the Backup log
To view a list of the patient reports you 
have backed up using the Holter LX 
software:

1. Select Patient > Open.
2. Click the Backup button.
3. Select File > Backup log.

The Backup log lists the archived 
names of the backed up files, then any 
column headings (variables) you 
selected in the Backup Settings win-
dow. 

Note: Be sure to customize what column 
headings you want in the log before 
backing up any patients because incon-
sistencies will result if you customize 
after some of the patients have been 
entered into the log. 

To add the name you gave to the CD on 
which reports were backed up:

1. Click on the individual patients you 
backed up. To select multiple 
sequential patients, hold down the 
Shift key as you click.

2. Click the Set volume name button.
3. Type the unique name you gave to 

the CD holding the backed-up 
reports. Then click OK.

The Backup log now contains the name 
of the CD on which the backup file is 
saved. It appears in the Backup Date/
I.D. field.

To print the Backup log, select the rows 
to be printed, then click the Copy to 
clipboard button. Using a spreadsheet 
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program, paste the information into a 
new spreadsheet and print as instructed 
by the spreadsheet program. For details 
about using the MicroSoft Works 
Spreadsheet to track patient data, see 
the instructions in the following sec-
tion.

Using a simple spreadsheet list
The simplest way to use a spreadsheet 
program is to create a spreadsheet that 
lists all the patients on a particular CD 
and print that list to archive with the 
CD. Alternatively, you can create one 
large spreadsheet listing all archived 
patients and the CD label on which 
they are saved; this spreadsheet can 
later be used to locate a patient name 
and then obtain the CD label.

To create a printout listing the patient 
reports on a particular CD:

1. Launch the Holter LX program.
2. Select Patient > Open.
3. In the Open Patient window, click 

Backup.
4. In the Backup window, in the bot-

tom half of the window, select the 
Archive destination where the 
patient records were stored. If you 
backed up using the dataCD method 
described earlier, the Archive desti-
nation was c:\nm\backup\. If you 
used the directCD method, the 
Archive destination was originally 
your CD drive (often d:); make sure 
you have the CD in the drive when 
you select the drive. The patient 
records you just backed up will 

appear in the bottom half of the 
Backup window.

5. Press the Copy to clipboard button.
6. Launch the Microsoft Works 

Spreadsheet. An empty spreadsheet 
opens.

7. Select Edit > Paste. The data 
selected in the Backup program is 
entered in the data fields of the 
spreadsheet.

8. Select File > Save As. Select an 
appropriate folder/directory in 
which to save the document and 
type an appropriate name (for exam-
ple, the Volume Label you assigned 
the CD).

9.  To print the spreadsheet to keep 
with the CD or to file, use File > 
Print.

10.  Use File > Exit to close the spread-
sheet program.

Creating a spreadsheet listing all 
archived patient names
If you create a single spreadsheet list-
ing all archived patient names, you can 
more easily locate the particular CD on 
which a patient record is archived. To 
create the spreadsheet:

1. Follow steps 1 through 8 above.
2. Create a new column by clicking in 

the spreadsheet in the field to the 
right of “Volume” and selecting 
Insert > Insert column.

3. Type a label for the column; call it 
“CD Label.”
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4. Click on the first field below CD 
Label and type the label of the CD 
on which the patients were archived.

5. Drag across the label you have 
typed to select it and select Edit > 
Copy to make a copy of the text. 
Paste the copy into each of the CD 
Label fields of the other patients 
backed up on that CD.

6. Follow steps 9 through 11 above.
7. Whenever you want to add patients 

to the spreadsheet, launch the Holter 
Backup program, select the appro-
priate archive destination and click 
Copy to clipboard. Then open the 
spreadsheet file, click on the row 
below the last used row and select 
Edit > Paste.

8. To eliminate the extra row of labels 
at the top of the new list, use Insert 
> Delete row.

9. Add the appropriate CD label in the 
CD Label column.

10.  Select File > Save, then File > Exit.

Locating a patient record in the 
spreadsheet
 To find a particular patient in the 
spreadsheet, sort (using Tools > Sort...) 
by the name or scan number column, 
locate the match, then refer to the CD 
Label field to see which backup CD 
holds that patient record.
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10 CONFIGURATIONS 
The Configuration program (also called the Configurator) allows you to customize certain aspects 
of the screen displays, analysis and reports. With careful attention to detail, you can establish 
report formats that are specific to a physician or automatically change dozens of analysis settings 
for a particular patient type (e.g., patients with pacemakers). Each separate customized format is 
called a configuration.
Guide to
ration window
Running the Configuration program
You can access the Configurator either with the Holter LX Pro program 
running or when the Holter program is not running. Note that all features 
are not available (they will appear dim) if you run the Configurator while 
the Holter program is running.

Within the Holter 
program
With the Holter program 
running, select Patient > 
Preferences. At the bot-
tom of the Preferences 
window, click the Config-
urations button. The main 
Configurations window 
opens.

From the Start menu
With the Holter program 
not running, select Start > 
Programs. From the Pro-
grams menu, select Holter 
5. From the Holter 5 
menu, select Configure. 
The main Configuration 
window opens.

Main Configu
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Confi
Configuration window
The main Configuration window opens 
with a listing of all current configura-
tions of your software. Each should 
have a unique name. To make changes, 
you can either edit an existing configu-
ration or create a new one. You can also 
delete a configuration if you no longer 
need it.

To edit an existing configuration, click 
on the name associated with the config-
uration you want to change, and then 
click the Edit button.

To create a new configuration, click on 
the name associated with a configura-
tion similar to the one you want to cre-
ate, and then click the Copy button.

To delete a configuration, click on the 
name associated with the configuration 
you want to eliminate, and then click 
the Delete button.

Configuration folders
The window for a specific configura-
tion consists of a pile of folders with 
tabs. Each folder contains the controls 
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Configuration folders
for a particular window or portion of 
the Holter LX Pro software. Within the 
folders for a configuration, any entry in 
any of the fields automatically appears 
whenever you create a new patient 
using that configuration.

Note: The configurations appear as 
choices in the Type of analysis/report 
field when you select Patient > New. 
In addition, they appear when you are 
initializing a flashcard/SD card.

To display the fields in a particular 
folder, click on the tab for that folder.

The folders contain the controls indi-
cated:

• Main - This includes fields indicat-
ing the name (description) of the 
configuration, which appears in the 
list whenever you start a new 
patient; the physician’s and inter-
preting physician’s names associ-
ated with the configuration; the scan 
number; hookup technician; and 
analyst. 

Note: When you create a new config-
uration by using the Copy button, the 
Description field in the Main folder 
reads ***New***. Be sure to type a 
new name for the configuration in the 
Description field to differentiate it 
from others you create.

Note: The Main folder contains the 
Scan # field which controls the auto-
sequencing of the Scan number in the 
Patient Information window. To have 
the system automatically increment 
the scan number for each patient, 
enter $seq in the Scan # field; to 
include the date and/or time-of-day in 
the Scan # field, enter $date or $time, 
respectively. Use whatever order you 
want the scan number to follow. Also, 
be sure to turn on the “Assign date 
and time to Scan #” feature in the 
Preferences window.

• Colors - This controls the colors 
used throughout the system. 
Because the Holter analysis is color-
coded, changes should be made very 
carefully here.

• Diary - Different diary entries can 
be added, and diary entries can be 
replaced with other text or deleted 
singly or all together. The diary 
entries appear in the drop-down list 
of choices in the Symptom field in 
Patient > Patient Information > 
Diary.

• How Often Strips Auto Save - This 
controls the settings that come up 
automatically in this window in Set-
tings > How Often Strips Auto Save.

• Indication - Different indications 
can be added, and current indica-
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tions can be replaced with other text 
or deleted. The Indication choices 
appear in the Indication area of the 
Patient Information window.

• Label - Strip labels can be changed 
from their present text to whatever 
text you use to replace them. Strip 
labels appear in the Saved Strips 
window, the Keep window, and in 
the final report. 

Note: Changes in labels must be 
made carefully because the meaning 
of the label MUST NOT change. For 
example, when the system calls a beat 
ventricular, it uses the VPB label 
when saving strips for the report; you 
can change the text to read VE 
instead, but not SVPB or BBB, or 
your report will be incorrect.

• Medication - Different medications 
can be added, and current medica-
tions can be replaced with other text 
or deleted. The Medication choices 
appear in the Medication area of the 
Patient Information window.

• Miscellaneous - This controls the 
beat-by-beat annotation, the ST seg-
ment analysis location in the Prefer-
ences window, and some advanced 
file naming fields.

• Oximetry - This controls the set-
tings that come up automatically in 
the window accessed by selecting 
Settings > Oximetry.

• Report - This allows you to have a 
configuration with a different report 
heading, a different selection of 
report modules, along with different 
settings for the strip annotation, full 
disclosure, report summary, and 

saved strips fields in the Reports 
window. You can also change the 
registration name and address.

• Research (optional) - This controls 
the automatic settings that appear in 
the Research window, if it is avail-
able to you. Open the window by 
selecting Settings > Research.

• Rhythm - Different rhythm types 
can be added, and rhythm types can 
be replaced with other text or 
deleted. Rhythm types appear in the 
Comment field in Tables > Edit. 
They do not appear in the printed 
report.

• Scanning Criteria - This controls 
the automatic settings that appear in 
the Scanning Criteria window. The 
window is accessible from the 
Patient Information window by 
clicking Settings > Scanning Crite-
ria or from the main Holter menu 
under Settings > Scanning Criteria.

• Spectral Settings - This controls 
the automatic settings that appear in 
the Spectral Analysis window. The 
window appears when you select 
Settings > Spectral Analysis.

• Spectral HRV - This controls the 
colors used in the heart rate variabil-
ity plots in the HRV menu.

• What Strips to Auto Save - This 
controls the settings that come up 
automatically in this window in Set-
tings > What Strips to Auto Save.

• Page/Saved Strips/Critical Events/
Superimposition/Calibration - 
This controls the appearance of 
some of the Review windows, 
including some colors, the settings 
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in some fields, and whether the win-
dow initially appears in Expanded 
mode.

• Trend/Lorenz Plot - This controls 
the colors in these plots and the 
Type that is initially displayed.

• 12 Lead - This includes controls for 
12-lead displays, including colors 
and what settings appear in the 
fields.

• 12 Lead List - This shows the text 
that appears in the list of choices 
when you add a 12-lead strip to the 
printed report. To see the list in 12 
Lead Strips, click on Add/Del to 
open the Add/Del window, click on 
the Description text field, and then 
click on arrow at the right end of the 
field.

Saving a configuration
For each configuration you create or 
edit, make changes in as many folders 
as you need to. When all folders reflect 
what you want to associate with that 
configuration, click the OK button at 
the bottom of the window. Your new 
configuration will be saved and the 
window closed; the main Configurator 
window then appears.

Canceling a configuration
To exit without saving the new config-
uration, click Cancel. The window 
closes and the main Configurator win-
dow appears.

To create or edit another configuration, 
use the Copy or Edit button again. 

Copying to a current patient
The Copy this tab to current patient 
button allows you to make changes to 
the displayed fields within the record 
of the current patient. If this button is 
dim, those changes cannot be made 
because they might cause inconsisten-
cies.

Copying changes to all 
configurations
To copy any changes associated with a 
tab/folder to all other configurations, 
instead of having to make them to 
every configuration separately, use the 
Copy to all configs button. That applies 
the settings of the displayed fields to all 
other configurations.

Exiting from the 
Configuration program
To exit from the Configuration pro-
gram, click on the red Close button in 
the upper right corner of the window.

Using a configuration
The configurations created or edited 
using the Configurator appear when 
you start a new Holter test and when 
you initialize an SD card. When you 
select Patient > New to open the 
Patient Information window for a new 
Holter test, a list of the Configuration 
descriptions appears in the Type of 
analysis/report field; select your choice 
from that list. When you initialize an 
SD card before a recording, the list of 
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Configurations appears in the SD360 
settings field of the Setup SD360 set-
tings window; select your choice from 
that list.

For example, a configuration called 
“DDD Paced” can be set up so that (1) 
the pacemaker settings in the Scanning 
Criteria window are appropriate for a 
patient with a DDD pacemaker and (2) 
the Reports window opens with the 
pacemaker modules already checked. 
When you start the Holter test for a 
patient with a DDD pacemaker, you 
could select Patient > New, then select 
the DDD Paced configuration. That 
would mean that you would not have to 
(1) go into the Scanning Criteria win-
dow to turn the pacemaker mode on 
and set each pacemaker setting appro-
priately and (2) check off each report 
module you want in the report.

Of course, if you use an inappropriate 
configuration for a patient, after analy-
sis, you can always go to the appropri-
ate Settings windows and make 
necessary changes; the system will 
automatically update or re-analyze as 
needed.
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11 UTILITIES 
The LX Utilities allow you additional control over some of the technical aspects of your software, 
including the restructuring of your system to hold more patient Holter tests within the program, 
updating your software, and accessing additional directories on your hard drive.
Guide to Holter
Running the Utilities program
You should access the Utili-
ties when the Holter LX pro-
gram is not running. To run 
Utilities, select Start > Pro-
grams > Holter 5 > Utilities. 
The Utilities window 
appears. The buttons in the 
Utilities window allow you 
access to the Setup window 
you saw during the software 
installation process, to add 
and remove patient directo-
ries and patient data, and to 
update the LX Pro software 
to the latest release. 

Click the buttons to open the following windows:

Setup window
The Setup window contains information specific to your facility 
and Holter LX software. This includes the names of both your facil-
ity and the primary user of your Holter software, along with five 
lines for the name and address that appear in the Reports window 
when you go to print a Holter report. To change the entries in those 
fields, select the characters to be replaced and type the text you 
want in the appropriate locations.

Utilities window
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To change the 
language used 
throughout the 
Holter LX soft-
ware, make your 
selection from 
the drop-down 
menu associated 
with the Lan-
guage field.

To change the 
number of patient 
reports stored on 
the hard disk of 
your computer, 
you can either 
enter a different 
number in the Number of patients field 
in this window or use the Add/remove 
directories accessible from the Utilities 
menu. If you choose to change the 
number here in the Setup window, all 
patient directory slots will be overwrit-
ten with empty new patient slots, so be 
sure any patients whose reports will be 
overwritten are already backed up 
before you proceed.

The Registration number is one 
assigned specifi-
cally to your sys-
tem based on the 
software key (a.k.a. 
dongle) attached to 
either the parallel 
port or the USB 
port of your com-
puter. It controls 
the features of your 
Holter LX system. 
You should not 

change this number unless 
you upgrade your soft-
ware to include additional 
features. This field works 
in conjunction with the 
“Digital recorder with a 
software key” radio but-
ton in the Options area; 
that must be selected to 
enable the registration 
number.

The radio buttons in the 
Options area control 
whether the system can 
read new information off 
of a compact flashcard/SD 
card from a DR180+ or 

SD360 recorder and, if it can, what fea-
tures are available. These should not be 
changed.

Batch print/view
Use this utility to list all the patient 
reports currently on your computer’s 
hard disk and then choose to either 
print the report or review it on-screen. 
To select a particular patient report, 
click on the appropriate line to high-

Setup window
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light it. To review the patient report on-
screen, click View. To print the report, 
click Print. To exit from the window, 
click Cancel.

Delete patient data
This window displays a listing of the 
patient records currently included in 
the Holter LX software. To eliminate 
patients from the listing, select the 
one(s) to be deleted and click the 
Delete button. To close the window 
without delet-
ing any patient 
records, click 
Cancel.

Be sure that you 
have performed 
any required 
backing up of 
patient records 
before you 
delete them 
here.

Add/remove patient directories
This button opens the Modify patient 
data window that allows you to add a 
specific directory to the list of patients 

accessible 
through the 
LX software 
without cre-
ating the slot 
as an empty 
new patient, 
or to remove 
a specific 
directory 
from the list 
of patients 
without actu-
ally deleting 

the patient from the hard drive. It 
allows you to access additional patient 
records that were not previously acces-
sible and allows you to ignore other 
records.

Click the Add/remove button to open 
the Modify patient data window; it dis-
plays all the patient directories cur-
rently on your hard drive. To allow 

Modify patient data wi

elete patient data window
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access to additional patient record(s), 
select the patient record(s) to be added, 
then click the Add button. To delete 
patient record(s), select the patient 
record(s) to be deleted, then click the 
Delete button.

Update software
To update your LX software to a newer 
version, click the Update button to 
open the Update window. The Source 
file should contain the directory and 
file name of the NorthEast Monitoring 
software update you received. If the 
Source file is not correct, use the 
browse button to access other folders to 
locate the file, or type the correct com-
plete file name including all directo-
ries.

To run the NorthEast Monitoring LX 
software as designed, the destination 

directory should read “C:\nm\bin”. If it 
does not, type that now.

To view information about the update 
file without installing it, click Preview.

To install the update file specified in 
the Source file field into the Destina-
tion directory, click Update and follow 
the instructions.

To exit the Update window without 
installing new software, click Cancel.

pdate software window
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   APPENDIX A
Calculation of Heart Rate
Guide to Holter
Types of heart rates
A variety of heart rate calculations are made by NorthEast Monitoring Holter LX 
software. They include:

• Current heart rate 

• Minute-by-minute heart rate

• Beat-by-beat heart rate

• Mean heart rate in intervals

• Mean heart rate for Holtered period

• Second heart rate

• Heart rate strips

Current heart rate
This is a complex function that takes the current beat and the beats preceding it 
into account. This weighted average follows these rules:

1. If the differences between the adjacent beats of the preceding four RR inter-
vals are no more than 12 percent of the average RR interval for the previous 
beat and the beats are all normal, then the new average RR interval is the sim-
ple average of the previous four RR intervals. 

2. If the previous four RR intervals were NOT bigeminy, VTAC or SVT AND 
the current RR interval is within 25 percent of the previous average AND the 
previous two beats were not ventricular AND the previous 10 beats were not 
supraventricular, then the new average RR interval is 1/8 of the current RR 
interval plus 7/8 of the previous average.

3. If the previous four RR intervals were NOT bigeminy, VTAC or SVT AND 
the current RR interval is not within 25 percent of the previous average OR 
any of the previous two beats were ventricular OR any of the previous 10 
 LX Pro     125



Appendix A

126
beats were supraventricular, then the new 
average is 1/32 of the current RR interval 
plus 31/32 of the previous average.

4. If the previous four RR intervals were big-
eminy, VTAC or SVT, then the average RR 
interval is changed by 0.000087 seconds. It 
is increased if the current interval is longer 
than the previous interval, otherwise it is 
decreased.

Once the current average RR interval is deter-
mined, the current heart rate is calculated as 60 
divided by the current average RR interval, that 
is, current HR = 60/(current RR interval).

The current heart rate is used as the heart rate 
that appears in the heart rate data field for any 
displayed strip. This includes the heart rate 
associated with any strip in the Selected Strips 
window and in the printed report.

The current heart rate is also used to detect 
tachycardia and bradycardia. The onset of 
either is determined to be when the current 
heart rate reaches the tachycardia or bradycar-
dia settings in the Scanning Criteria window.

The low and high heart rates reported in the 
Tables window and in the tables of the printed 
report refer to the lowest and highest current 
heart rate calculated during the interval.

Minute-by-minute heart rate
The heart rate plotted in the Trends window is 
a minute-by-minute heart rate. It is calculated 
as 60 times the number of beats processed in 
the minute divided by the sum of all RR inter-
vals of beats processed in the minute (in sec-
onds).

Beat-by-beat heart rate
The heart rate associated with each beat in 
expanded displays whenever the Annotation 
field in the Preferences window is set to Heart 
Rate is the beat-by-beat heart rate. It is calcu-
lated based on the RR interval following the 
labeled beat. Beat-by-beat heart rate equals 60 
divided by RR interval, that is, HR = 60/(RR).

Mean heart rate in intervals
In the tables (in Tables window and printed 
report), the mean heart rate within each interval 
is calculated by dividing the number of beats in 
that interval by the amount of time processed 
within the interval.

Mean heart rate for Holtered 
period
In the Report Summary (in the Report Sum-
mary window and printed report), the mean 
heart rate during the Holter test is the number 
of beats counted divided by the amount of time 
processed.

Second heart rate
The second heart rate is the heart rate associ-
ated with a run of VTAC or SVT. It is calcu-
lated as 120 divided by the sum of the current 
RR interval and the previous RR interval. The 
second heart rate appears in strips with VTAC 
or SVT in Selected Strips, the printed report, 
and the strip list, labeled HR2.

The second heart rate is used to determine 
where in the ventricular and supraventricular 
run tables a run of VTAC or SVT appears. The 
heart rate separating fast from slow runs is 
determined by the VTAC and SVT settings in 
Scanning Criteria, but the rate of each event is 
considered to be the second heart rate.

The second heart rate is also used to determine 
which run is identified as the fastest run of 
VTAC and SVT.

Heart rate strips
In the Critical Events window, there is a choice 
in the Type field called “HR strips.” This dis-
plays all ECG from the Holter test divided into 
7.5-second strips. Each strip includes a time-
of-day and a Strip HR. That Strip heart rate is 
the total number of RR intervals (including 
partial ones, but excluding artifact) within the 
strip divided by the sum of the RR intervals.
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Defining dead-time and RonTs
Dead-time is the amount of time (in seconds) 
after a detected QRS complex during which the 
software will not look for another QRS com-
plex. Generally, this helps to prevent the mis-
identification of tall T-waves as QRS com-
plexes.

 The operator can add more time to the tail end 
of the dead-time using the Extra dead-time set-
ting in the Scanning Criteria window. An 
increase in the Extra dead-time should be done 
judiciously so that very early VPBs do not fall 
within it. 

Because the recovery time (i.e., the width of 
the T-wave) varies with heart rate, the dead-
time built into the software adjusts based on the 
current heart rate. At higher rates, the dead-
time decreases, and at lower rates, the dead-
time increases.

Likewise, the definition of an R on T, which is 
a VPB falling on the T-wave of the preceding 
beat, varies with heart rate. Since the software 
does not identify T-waves, it cannot determine 
whether a VPB is actually falling on the T-
wave of the preceding beat. But the software 
can calculate where the T-wave for a beat 
should be and then alert the operator regarding 
any VPBs that fall within that hypothetical 
area.

The heart rate determines the dead-time and R 
on T period definitions as shown in the follow-
ing table:

TABLE 1.  How heart rate determines 
dead-time and R on T

Heart 
rate

Dead-
time R on T

30 0.50000 0.600

35 0.50000 0.542

40 0.50000 0.500

45 0.50000 0.466

50 0.43500 0.440

55 0.38727 0.418

60 0.34750 0.400

65 0.31384 0.384

70 0.28500 0.371

75 0.26000 0.360

80 0.23812 0.350

85 0.22000 0.341

90 0.22000 0.333

95 0.22000 0.326

100 0.22000 0.320

105 0.22000 0.314

110 0.22000 0.309

115 0.22000 0.304

120 0.22000 0.300

125 0.22000 0.296

130 0.22000 0.292

135 0.22000 0.288

140 0.21428 0.285

145 0.20689 0.282

150 0.20000 0.280

155 0.19354 0.270

160 0.18750 0.265

165 0.18181 0.261

170 0.17647 0.257

175 0.17142 0.253

TABLE 1.  How heart rate determines 
dead-time and R on T

Heart 
rate

Dead-
time R on T
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   APPENDIX B
Using MagicVORTEX
Guide to Holter
To use NorthEast Monitoring software to send a patient’s Holter 
data to another site for analysis, you must be a MagicVortex cus-
tomer. To sign up for MagicVortex, visit their web site at 
www.MagicVortex.com and select Sign up from the menu on the 
home page. Once you are a MagicVortex customer, you can follow 
these instructions both (1) to send out the patient data to a receiving 
site that has agreed to analyze it and (2) to receive a completed 
report back.

Sending patient data
1. From the Start menu, select Programs > Holter 5 > Remote Setup 

to open the Patient menu item in the remote reporting software.
2. Select Patient > New to open a patient slot for the patient to be 

sent. If no empty slot is available, the Open Patient window 
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Magic
opens and you must delete one of 
the patients on the list; then close the 
Open Patient window and select 
New again.

3. When the New Patient window 
opens, select an appropriate Type of 
analysis/report, then click OK. The 
Patient Information window opens.

4. Insert the compact flashcard from 
the recorder into the compact flash-
card reader.

5. Click the Copy flashcard button in 
the Patient window. This copies the 
Holter data from the flashcard onto 
your computer’s hard drive. Some of 
that data appears in the Patient win-
dow; verify that the data from the 
flashcard is for the correct patient.

6. Enter as much additional patient 
information as you want included in 
the final Holter report, including any 
written diary entries, indications and 
medications. See Chapter 2: Patient 
Information, for details about enter-
ing patient information.

7. When data entry is complete, click 
the MagicVortex button in the 
Patient Information window. This 
opens the MagicVortex Setup win-

dow. The Enable MagicVORTEX 
field should have a check mark. The 
MagicVortex icon on your desktop 
should contain a blue center indicat-
ing that you are currently connected 
to the MagicVortex.

Note: If the center of the 
MagicVortex icon is gray, you are not 
currently connected to MagicVortex 
via the Internet and you will not be 
able to send patient data until the 
connection is established.
 

8.  The FTP directory field should read 
c:\nm\ftp; if it does not, click on that 
field and type that now.

9. Click on the Destination email field 
and type the e-mail address where 
you are sending the Holter data for 
analysis.

10. Leaving the Options field blank, 
click on the Location field. This 
entry will be used to rename the 
patient files you send so that there is 
a unique filename at the receiving 
site. If you have been assigned a 
location name by the receiving site, 
type that. If not, type something to 
identify your location.

11. Click on the Initials field. Type 
your initials.

12. When you have completed the 
fields, click Send. The two 
files for this patient will be 
sent to the receiving site. To 
exit without sending the data 
now, but saving your entries, 
click OK. To exit without 
sending or saving, click Can-
cel.

VORTEX Setup window
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Receiving a patient report
To receive a Holter report via Mag-
icVortex, you do not have to be a Mag-
icVortex customer. If you are a 
MagicVortex customer, the report 
returned will be automatically down-
loaded to your computer when the 
analysis site sends it; if you are not, 
you must retrieve the Holter report via 
e-mail.

As a MagicVortex customer
After the analysis site has sent you a 
Holter report via MagicVortex, the 
report automatically downloads to your 
computer. To retrieve the report, open 
the MagicVortex window (using the 
icon that looks like the eye of a storm) 
and it displays the file and its status. 
Once the download is complete, the 
status reads “Ready to save.” To save 
the file, select File > Save from the 
toolbar, and use the Browser to indicate 
what folder you’d like to save the 
report in and what filename to use; then 
click Save.

To print the report, open the file in the 
folder where you saved it, and use File 
> Print to print the report.

Without being a MagicVortex customer
After the analysis site has sent you a 
Holter report via MagicVortex, you 
will receive a notice via e-mail that 
there is a file for you. The e-mail notice 
will include a link to the site. To 
retrieve the report:

1. Click on the link and you will be 
connected to the MagicVortex site, 
which will request that you log in. 

2. Enter the password for your e-mail 
address and click the Login button. 
MagicVortex displays your account 
folder, which contains information 
about the file that was sent to you, 
including its name at the top.

3. To retrieve the file, click the Down-
load File button. The File Download 
window opens.

4. In the File Download window, indi-
cate what you would like to do with 
the file. We recommend that you 
Save it using the Save button and 
using the Browser to indicate the 
folder where you’d like it saved. 
The report is now downloaded to 
your computer.

5. When the download is complete, 
you can choose to immediately print 
the report by selecting Open to dis-
play the report, and then using File > 
Print. The Holter report prints, and 
you have a saved electronic copy of 
it on your computer in the folder 
you indicated in Step 4.
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